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CHAPTER

1 ABOUT THIS GUIDE

This guide describes how to use Quick Builder to configure system

items, such as controllers (other than Process Controllers), points,
Flex Stations, and printers.

Revision history

Revision

Description

A August 2020 Initial release of document.
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2 GETTING STARTED WITH QUICK BUILDER

In Configuration Studio, you use Quick Builder to create and maintain
a configuration database that defines system items such as
controllers, points and Flex Stations. (For details about configuring
Console Stations, see the Server and Client Configuration Guide.)

When you are satisfied with your configuration, you download it, or
selected parts of it, to the Quick Builder (online) database on the
Experion server.

To modify any part of your configuration, you need to upload (or
backbuild) items from the server (online) database into Quick Builder,
make the required changes, and then download the changes to your
server database.

You can also create an offline Quick Builder database (a database
connected to an SQL server rather than an Experion server) to
configure your entire system and then download that configuration to
the Quick Builder database on the Experion server at a later time. This
offline database is also referred to as a Quick Builder project.

TIP: Offline databases are vulnerable from a security
perspective. Ensure that you save any offline databases in a
secured path.

Quick Builder support for multiple users

Multiple users can open a Quick Builder project in different nodes
simultaneously and perform configuration activities.

Rules have been established within Quick Builder to handle conflicts
between user actions, which means that occasionally you could be
stopped from completing an update to the database if another user is
performing a similar action, or if the item has been modified in some
way since you started your update.

For example, if you modify, add, or delete an item and then try to
download those changes to the Experion server while another user is
also attempting a download, an error message is displayed and you
will need to wait to download your changes until the other user’s
download is complete.

13
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Starting Quick Builder

When starting Quick Builder, you can connect to either an online
Quick Builder database on an Experion Server, or to an offline
database on an SQL (non-Experion) server. When working offline, you
can create Quick Builder projects, that can later be downloaded to the
Quick Builder database on an Experion server.

Prerequisites

To create a Quick Builder project you must have a minimum of SQL
Server Express installed.

To start Quick Builder

1. Start Configuration Studio.
The Connect dialog box appears.

2. Depending on the environment you want to work in, use one of the
following connection options:

Option ‘ Description

To work in the Quick On the Local Targets tab, select the
Builder database on system or server you would like to
your local Experion connect to.

Server.

To work in the Quick 1. On the Other Targets tab, select

Builder database on a either Experion PKS System or
remote Experion Experion PKS Server from the
Server. Target type list.

2. Select the system or server you

would like to connect to from
the Target name list.

To work in an offline 1.  On the Other Targets tab, select
Quick Builder database Quick Builder Database from the
on an SQL Server. Target type list.

2. Select the SQL server you would
like to connect to from the
Target name list.

15
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Option ‘ Description

3. To open an existing project:

a. Select the Open Existing
Project option

b. Click Search Location to list
the databases existing on that
server.

C. Select the database you
would like to connect to from
the list provided.

4, To create a new project:

a. Select the Create Project
option

b. Type a name for the new
project in the Project Name
field.

\ J

3. Click Connect.

If you chose to connect to a Quick Builder database on an
Experion server, the Login to Server dialog box appears. Enter your
credentials and click OK, then skip to step 6.

If you chose to connect to, or create, a Quick Builder project on an
SQL server, the Enable Components dialog box appears.

4. |In the Enable Components tab, the check boxes indicate the
components that are enabled by default for your system licence,
and the number of each item that has been created for each
component. Use the check boxes to enable and disable
components as required, then click OK.

5. In the SCADA Control list, click any of the available options, such as
Build Channels.

Quick Builder appears. Your Quick Builder access privileges are
the same as for Configuration Studio.

16
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Layout of the main window

The following figure shows the layout of the Quick Builder window,
regardless of whether you are working in an online or an offline

database.

Figure 2-1: Quick Builder window layout
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Navigation pane

A navigation pane on the left-hand side of the Quick Builder window
contains items that can be created and configured in Quick Builder.

The following table lists the views that you can choose in the
navigation pane, and the contents of those views.

Category ‘ Items and descriptions

All items

Displays a tree containing all item types supported by Quick Builder:

Channels (interfaces that enable servers to communicate with
controllers)

Controllers (field devices such as PLCs, loop controllers, and so
on)

Points

Stations (the Operator interfaces)

Quick Builder configures only Flex Stations, the standard type of
Station. (For details about configuring Console Stations, see the
topic titled "Configuring a Console Station" in the Server and Client
Configuration Guide.)

Printers
Meters
Servers
Equipment

Recycle bin, which is a holding area for items that have been
deleted from their parent category but have not yet been
permanently deleted and therefore can be recovered if needed.

Unassigned items

SCADA Lists channels and controllers defined for this server. Selecting a

Controllers | controller displays a list of the points assigned to that controller in the
List view.

Assets Lists assets that have been downloaded from the server. Selecting an

asset displays a list of the items associated with that asset in the List

view.

Adding, editing, duplicating, and renaming operations are not permitted

in the Asset view.
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Category ‘ Items and descriptions

Electronic | Lists Electronic Flow Meters that have been defined for this server.
Flow Selecting a meter displays a list of the items associated with that meter
Meters in the List view.

Controller | Launches the configuration forms through which points can be
Integration | generated for those controllers where the Integration check box has
been enabled.

Managing deleted items

The Recycle Bin is a holding area within the Navigation pane, where
items you have deleted from other groups are 'marked for deletion’,
rather than being actually deleted.

To undelete an item and return it to its original group, right-click the
item and choose Undelete from the shortcut menu.

Note the following points:

m Deleted items will be permanently deleted if you select the
Automatically Download Deletions option when you download a
project (and the download is successful).

m You should not permanently delete items that you have previously
downloaded to the server—if you attempt to do this a warning
message appears. (If you choose to delete items that have been
downloaded, the project and the server database will lose
synchronization—although the item will no longer exist in the
project, it will still be defined in the server database.)

m Quick Builder allocates an item number to each item. Items in the
Recycle Bin retain their numbers until you permanently delete
them. This has no significance unless you reach an item number
limit for your license. For example, if your license allows 40
Stations, and you have already created 40 Stations (including
deleted ones), you cannot add any more until you
delete/download those that have been deleted and are still being
held in the Recycle Bin.

List View

When you select a group of items in the Navigation pane, such as
Printers, Stations, or Points, a list of the items that have been created
within that group is displayed in List View. If no items appear in the
List View, it means that none have yet been created.

19
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You can use List View to edit, delete, and sort items.

TIP: As Quick Builder projects can be modified by more than
one user at a time, you may find that changes made by other
users sometimes appear in the List View when you move from
one item to the next, or when you change focus in the
Navigation pane. Refreshing the view will also display changes
made by other users.

[tem type ‘ Description

Points Standard points.

Servers Servers, which use the databases created by Quick Builder.

Controllers Controllers, the field devices such as PLCs, loop controllers, and so
on.

Channels Channels, the interfaces that enable servers to communicate with
controllers.

Stations Stations, the operator interfaces
Quick Builder configures only Flex Stations, the standard type of
Station. (For details about configuring Console Stations, see the
topic titled "Configuring a Console Station" in the Server and Client
Configuration Guide.)

Printers Printers.

Recycle Bin A holding area for deleted items, which works in the same manner
as the Windows' Recycle Bin.

Trends/Groups | Station displays to which you can add points.

Networks The interface that enables servers and point servers to

communicate with channels and controllers.

Customizing the List View

By default, the List View contains columns displaying an item’s major
properties, such as its name and description. You can, however,
customize the List View to show other properties by adding, removing,
or reordering columns. You can also sort columns to be either
ascending or descending, and the view will reorder accordingly.
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To customize the List View

1. Choose ViewColumns.
The Columns dialog box appears.

2. Select the names of the columns you wish to display from the
Details list.

You can use the options in the Select fields from list to filter the
columns shown in the list.

3. Use the Move Up and Move Down buttons to change the order of
how the columns will appear.

4. Click OK to close the dialog and refresh the List View.

Properties pane

You use the Property Pane to view and edit the properties of the item(s)
selected in the List View.

Because an item has so many properties, they are grouped by tab. For
example, if you wanted to see the display-related properties of a
selected point, you would click the Display tab.

The Property Pane is modeless, which means that the selected item(s)
change as soon as you select another item, or perform an action such
as downloading.

The Property Pane also changes as follows when you select several
items:

m Any property whose value is not identical for all selected items is
grayed out. For example, if you select two status points, Point ID
will be grayed out because every point has a unique ID.

m |f the items are of different types, such accumulator and status
points, the Property Pane only displays tabs and properties that are
shared by all selected items.

If you edit a property when several items are selected, you make that
same change to every selected item. For example, if you select a
number of accumulator and status points, you can change the PV
Source Address or the PV Scan Period because both properties are
common to both point types.

History pane

Every time a display is modified, those versions are saved and can be
viewed in the History Pane at the bottom of the Display Repository.

21
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From the History Pane you can perform several actions on a display
version. You can:

m Approve or Reject a version read for publication to the Experion
server

m Publish a display version to the Experion server
m Update a version of a display in your working folder to match the
latest version on the Experion server

The display versions are listed in a table, containing the following
information:

Item ‘ Description

User The ID of the user who saved that version of the display in this
database.

Date The date that the version was saved.

Version The version number of the display.

Action The system action that was performed to that version of the display.

Comment Comments added by the user when they saved that version of the
display.

Ready to The display is ready for testing and validation prior to being published

Validate to the Experion server.

Library pane

The Library pane on the right hand side of the Quick Builder window
contains templates that can be used to create instances of items in
Quick Builder. The templates are organized into categories to identify
their types:

m Channels
m Controllers
m Points

m Servers

m Printers

m Stations

m and so on
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When creating and importing templates, you can create custom
categories that will then appear in the Library pane. These might
include industry areas, such as QOil and Gas, or Coal Seam Gas.

Toolbar

The toolbar provides speedy access to commonly used commands.

Description

Search. Searches the Quick Builder database for items such as points.

£

Change configuration target. Allows you to change to another server, system,
or Quick Builder database.

] Save. Saves the project.

E Add. Adds one or more items to the project.

b4 Delete. Moves the selected items to the Recycle Bin.
- Undo. Undoes the previous action.

Copy. Copies the selected items to the clipboard.

Paste. Pastes the clipboard's contents into the display.

=l | @

Custom Filter. Opens the Custom Filter dialog box, which you use to filter out
(hide) items that are of no immediate interest.

k)

Import. Opens the Select file to Import... dialog box, which you use to locate
and select the file you want to import.

@_‘

Export. Opens the Export dialog box, which you use to export files from the
current Quick Builder database.

[+

Download. Downloads all or some of the project to the server database.

[+

Upload. Uploads configuration data from the server into a project.

Compare. Compare items in the current project to those in the Quick Builder
database on the server.

23
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The Jumpbar

You use the Jumpbar to quickly select an item in the List View. (Note
that you will not be able to locate and select an item if it has been
filtered out.)

To find items:

1. Click anywhere in the Jumpbar.

2. Type the name of the item you are searching for and press Enter.
Quick Builder finds the first matching item.

You can use one or more wildcards (*) to find items whose full
names you do not know, for example *ana*, which will return items
containing the text ana in its name.

To select an item:

1. Click the Jumpbar.
2. Type the item's name and press Enter.

To move between items, select the item from the Jumpbar list and
press Enter. The Jumpbar remembers the last 20 items you specified.

Status Bar

The Status Bar displays a short description of the selected property (or
its valid values if the current value is incorrect). The right hand side of
the Status bar also displays the name of the connected server, the
name of the current user, and the current security level.

Shortcut menus

If you right-click an item type icon (in List View), a shortcut menu
appears that provides speedy access to commonly used commands.

In the List View, you can highlight multiple items before opening the
shortcut menu.

Figure 2-2: List View Shortcut menu
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Copy
Paste

Duplicate...

Delete

Rename

Select All

Inwert Selection

Basic Quick Builder tasks

This section outlines the basic tasks you can perform with Quick
Builder.

In this section:

25
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Enabling project components

When you first start a new Quick Builder project, or when you add new
component types (such as devices, points, and servers) to a project,
you first need to specify them in the component manager so that you
can configure them.

TIP: When working on the Project Component Manager to
enable or disable components for a project, any other users of
the project will be asked to log off and they will not be able to
log back into the project until you have finished. For this
reason, it is recommended that you perform this action when
there is minimal user activity in the project.

To specify the components to configure

1.

From the Quick Builder menu, choose Tools > Project Component
Manager.

The Project Component Manager dialog appears.

The dialog contains a list of components, such as devices, points,
and servers. It also contains a list of non-Experion components.
Scroll through list of components and select the check box next to
the items in your project you want to enable or disable.

Click OK.

A summary appears of the components being added (or removed).

Click OK.
Quick Builder adds the components to the project.

Capturing changes to a project in the audit log

You can capture all changes made to a Quick Builder project,

including details of the user who made the changes, in an audit log.

Audit logs are, by default, stored on the server on which they have
been enabled. You can use a combination of Robocopy scripts and
Windows Task Scheduler to automatically copy audit logs to a
network share regularly.
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To enable the audit log for capturing changes to a

project

1.

Start Quick Builder.

For more information, see "Starting Quick Builder" on page 15.
From the Quick Builder menu, select Servers and click the All items
tab.

A list of the servers for this project appears.

Select the server on which you want to capture changes, then click
the Server Specific Options tab.

Select the Enable audit log checkbox

All Quick Builder changes made to the project and to items on that
server will be recorded in the audit log.

Server Logger is used to store the log files, and Honeywell Log
Viewer (HLV) can be used to view the log files. You can access the
log files through a shortcut in the Start menu on the Experion
Server.

Note the following rules for the audit log:
« The maximum size for a single log file is SMB
e The maximum number of log files is 100

o After the maximum storage is reached (800MB), the log files
will be overwritten

e Itis recommended that audit log files are stored in a secure
location, and backed up periodically.

To copy an audit log and schedule regular saves to a
network share

1.

From a Windows Command Prompt on the server, type robocopy
<source> <destination> [<File>[...] [<options>], where:

a. source is the path to the source directory

b. destination is the path for the destination directory
c. file is the audit log file or files to be copied
d

. options is a list of the options to be included in the command.
For more information about Robocopy command options, see
https://technet.microsoft.com/en-us/library/cc733145.aspx.
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2. Press Enter.
The files are copied to the specified location

3. Copy your Robocopy command syntax to a Notepad file, and save
as a .BAT file so it can be re-run.

4. From the Windows Control Panel, click System and Security, and
then Administrative Tools.

Right-click on Task Scheduler and choose Run as Administrator.
Choose Action, and then Create Basic Task....
Enter a name for the task and a short description, then click Next.

© N o 0

Select the option that best meets your scheduling requirements,
then click Next and enter any additional scheduling information as
required.

9. Select Start a program, then click Next.
10. Navigate to and select your Robocopy script, then click Next.
11. Review the summary details, and click Finish.

Comparing online and offline configurations

You can compare items in a standalone (offline) project with those in
an online Quick Builder database either while you are configuring the
items, or before you download a project containing those items to the
database on an Experion server.

Depending on the number of items being compared, one of the
following actions will occur:

m For up to 5000 items, the comparison will occur within the Quick
Builder Compare Report, as documented below.

m For between 5000 and 100,000 items, the comparison data is
exported to a .TSV file, which can be viewed in Microsoft Excel,
Honeywell Log Viewer, or Notepad.

m For more than 100,000 items, a message is displayed stating that
the comparison could take in excess of 4 hours to complete.

A comparison report highlights any item that has changed or been
added since the most recent download of this project.

After adding and configuring items, you download all or part of your
project to the server database. Before committing to the download of
any items, you can compare them with what already exists on the
Experion server.
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Comparing items while configuring a project

1. At any time while working on a Quick Builder item, click in the
tool bar.

The Compare Report appears, highlighting any difference that exists
between the item in your project and on the Experion server.

2. Click Close icon to return to Quick Builder.

Comparing items before downloading a project to the
server
1. Asfor any download, choose the Scope of the download and

check that the Summary contains the list of items you want to
download to the server.

2. Click Compare.

The Compare Report appears, highlighting any new or changed
items. You can use the tool bar icons to perform actions such as

o Jumping backwards and forwards between changed items in
your project or on the server

o Show all items, or only the ones that are different between your
project and the server

Click the close icon to close the compare report.

3. After reviewing the Compare Report, you can choose to either
Download the items to the Experion server, accepting the changes
as they have been highlighted in the report, or Cancel the
download to return to Quick Builder.

Adding items

To create new items

1. Use one of the following options to create a new item:

o Click EE}

e From the menu bar, click Edit > Add item.

o Right-click on an item in the All items view and click Add item.
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T.

e From the relevant section within the Library, drag and drop the
template for the required item into the List View.

The Add Items dialog box appears.

Type the number if items you want to create in the Number of items
field. If you choose to create more than one item, extra fields
appear where you can define the suffix applied to each item name.
The variable used can be numbers of letters.

From the Item Family list, select the applicable family. If you used a
template or a right-click menu option to invoke this dialog, this
field will default to the template type or the item you had selected
at the time.

From the Item Type list, select the item type.

In the Name text box, type in the name for this item, or you can
accept the default provided. A summary of the details you have
provided is displayed.

Click OK to add the item(s) to the list.

The new items appear in the List View.

As more than one user can work in a Quick Builder project at the
same time, you may notice changes occurring in the List view
other than those that you have made. These changes appear
whenever you refresh the List view.

If an item you are adding has the same name as an item added by
another user, an error message appears. If you are adding multiple
items, those that do not have conflicting names will be added
successfully, but you will need to add any conflicting items again
using a different item name.

Use the properties tabs to configure the item.

Deleting and restoring deleted items

Deleting an item moves it to the Recycle Bin, which means that you can
restore it, or undelete it, if needed.

To delete one or more items

1.

Select the item(s) you want to delete in either the Navigation pane
or the List view.

Click X (or press Delete).
You can also delete items by:
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o Clicking FileDelete on the menu bar

« Right-clicking on an item and then clicking Delete.

The deleted items are moved to the Recycle Bin.

If you attempt to delete an item at the same time as it is being
modified by another user, a message is displayed and the item is
not deleted. If you attempt to delete multiple items, any items
being modified will be specified in the message and not deleted,
while any items not currently being modified are deleted
successfully.

3. To permanently delete items from the system, select the item in
the Recycle Bin and repeat any of the previously listed delete
options.

To restore one or more items

1. From the Recycle Bin, select the item(s) you want to restore.

2. Click FileRestore from the menu bar, or right-click on an item and
then click Restore
The restored items return to their original locations.

If you attempt to restore an item at the same time as it is being
permanently deleted by another user, a message is displayed and
the item is not restored. If you attempt to restore multiple items,
any items being permanently deleted will be specified in the
message and not restored, while any items not currently being
permanently deleted are restored successfully.

Modifying items
There are two ways to modify items in Quick Builder:

m Modify one or more properties of one item

m Modify common properties of multiple items

TIP: If you attempt to download a modified item (or items) to
the Experion server at the same time as another user is
modifying this item or the Quick Builder project, a message is
displayed and you will need to attempt the download again
later.
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To modify properties of one item

1. From the Navigation Pane or the List View, select the item you
would like to modify.

The properties pages for the selected item are displayed.

2. Modify the properties as required.
3. Download the modified item to the server.

To modify common properties of multiple items

1. From the List View, select the items you want to modify.

To select multiple items, hold down the Shift key and click the
mouse button to select sequential items, or the Control key and
the mouse button to select non-sequential items.

The Properties pages are selected for the selected items. The
common properties, that can be changed for all items, are shown
with editable fields. Non-common properties are not editable.

2. Modify the properties as required.
3. Download the modified items to the server.

Filtering items

It is often easier to manage items if you filter the List View to contain
only the items you want to work with.

You can filter items according to item sub-type, such as analog
points, or rotary Stations. For example, if the List View shows all points
but you only want to see analog points, select Analog Point from the
Filter Selector.

Figure 2-3: Filter Selector

i ) .
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[Custom Filter...)
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Container Point
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Status Point
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To filter items in the List View

1. From the Navigation Pane, select an item, such as an asset, an

equipment, or a channel, for which you would like to view items.

2. Click the Filter button to display the filter options. Options are:

o All Items

o Custom filter — opens the Custom Filter dialog where you can
build custom filters based on a combination of conditions
including property names, conditions, and values.

o Alist of options relevant to the item you have selected in the
Navigation Pane. For example, if you selected Points, the
configured point types would be listed (Analog Point,
Accumulator Point, Container Point, and so on).

3. Select the filter you want to use.

The text in the List View header changes to show the filter that has
been applied, for example, Points (Status), and the List View
contents update to show only items that match the filter criteria.

To create a custom filter

1.

From the Navigation Pane, select an item, such as an asset, an
equipment, or a channel, for which you would like to view items.

Click the Filter button and click Custom Filter.
The Custom Filter dialog appears.

Select the item types that should be part of this filter.

Use the controls provided to build your filter conditions. The
available variables are:

o Property name, for example, Scripts, Item Name, Tag.
o Condition, for example, Begins with, Contains, Equals

o Value

The list to the left of each condition statement enables you to
specify AND or OR when creating multiple conditions.

Click Save Filter to save a custom filter for future use, or click Load
Filter to load a previously saved custom filter.

Click OK to run the filter.
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The text in the List View header changes to show the filter that has
been applied, for example, Points (Status), and the List View
contents update to show only items that match the filter criteria.

Searching for items

You can use the Search function to search for a keyword included in
the name of those items in the List view.

To search for an item using the keyword search

1.

In Quick Builder type a keyword, or some characters, you would
like to search for within the items listed in the List View.

The Search function also supports wild card searching, such as ?
and *. For example, a search string of SVR?CHO1 will return items
with the fourth character in the item’s name being any
alphanumeric, while a search string of SVR2CH* will return all
items with names starting with SVR2CH.

Selecting items

You have the option of selecting items in List View to edit or delete
properties. Selected items are shown in reverse color.

ATTENTION: If you select more than one item, the Property
Pane only displays tabs and properties that are shared by every
selected item. If the selected items have different values for a
particular property, that property is grayed-out without any
value. If you edit a shared property, you make that change to all
selected items.

To select ‘ Do this
One item Click it (or the selection box to its left).
All items of a particular 1. Select one item of the required type.

and so on)

type (points, controllers

Choose EditSelect All

items

A contiguous group of

=

Click the first item you want to select.

2. Press and hold down the SHIFT key, and then click
the last item you want to select.

Alternatively, you can drag across the items to select
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To select ‘ Do this

them. (You need to start dragging to the right of the
Source Address column.)

If you want to clear one or more selected items, press
and hold down the CTRL key and then click each item
you want to clear.

Several non-contiguous | 1. Click the first item that you want to select.

items
2. Press and hold down the CTRL key, and then click
each remaining item you want to select.

If you want to clear one or more selected items, press
and hold down the CTRL key and then click each item
you want to clear.

An item by name Use the Jumpbar.

Renaming items

You can change an item's name—point ID in the case of a point—
provided you have not downloaded it to the server.

Note the following considerations:

m The item name of an entity is automatically generated based on
the renamed point ID (tag name).

m An item has been downloaded if there is a date in the Last
Downloaded property on the Main tab.

m If you need to rename items that have been downloaded, see the
procedure below titled "To rename downloaded item(s)." The
procedure involves deleting the items from both the project and
server database, and then recreating them with their new names.

TIP: If you attempt to download a renamed item (or items) to
the Experion server at the same time as another user is
modifying this item, or the name you are using has already
been used, a message is displayed and you will need to either
use a different name or attempt the download again later.
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To rename one or more items

1.

Highlight the items you want to rename.

2. Right-click and choose Rename from the shortcut menu.

The Rename dialog box opens.
If you selected:
o One item, type the new name in the text box.

o Several items, use the Format options to rename them in a
systematic manner.

To rename downloaded item(s)

1.

Copy the items you want to rename to Excel.

2. In Quick Builder, delete the items you want to rename so that they

are moved to the Recycle Bin.

Download the project. (Make sure that the Automatically Download
Deletions option is selected.)

If the download is successful, the items are deleted from the
server database as well as from the project.

In Excel:

a. Clear the entries in the DateDownloaded column.

b. Change the ItemName entries to the new names.

Copy the modified Excel contents and paste it into the Quick
Builder project.

This re-adds the items, with their new names, to the project.

Save the project.
Download the project.

If the download is successful, the items are re-added to the server
database.

Renaming example

This example shows how to rename 10 accumulator
points, giving them the prefix PLC7ACC, and a

numeric suffix between 01 and 10.
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1. Type PLC7ACC in Prefix.

2. Click numeric with a and type 2 in character field width.

3. Type 1in Start and 1 in Step.

Duplicating items

An item can be duplicated from either the Navigation Pane or the List
View.

To duplicate an item

1.

From the Navigation Pane or the List View, select the item you want
to duplicate.

Click the Duplicate icon in the toolbar, or choose EditDuplicate
ltems from the menu.

The Duplicate dialog box opens.

Type the number of duplicates in Number of duplicates.

If you are creating only one duplicate, specify the name for the
duplicate in the Name field.

If you choose to create more than one duplicate, provide a name
for the duplicates in the Prefix field and define a Suffix variable in
the fields provided. You can use with numbers or letters for the
suffix of each duplicate.

The Summary section details the changes about to be made by the
Duplicate process.

Click OK to create the duplicates.
The new items are added to the Navigation Pane or List View.

If, for some reason, the duplication cannot be performed at this
time, an error message appears stating the reason that the
duplication cannot proceed. These reasons could include that the
name you have chosen for the duplicate already exists, or another
user is currently modifying the item you are trying to duplicate.

Copying and pasting items

You can cut or copy selected items to the clipboard, where their
details are stored in tab-delimited text format. You then paste the
details back into the project or into another program, such as
Microsoft Excel.
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You can also paste item details from another program into a project,
providing the data has the correct format.

To copy one or more items to the clipboard

1. Select the items in either the Navigation Pane or the List View.
2. Use one of these options to copy the items:

=
o Click in the toolbar

o On the Edit menu, click Copy
o Press Ctrl+C

» Right-click the selected items, and then click Copy
The selected items are copied to the clipboard.

If the item you are trying to copy has been locked by another user
performing an update to that item, an error message appears and
you will need to try the action again later.

To paste one or more items from the clipboard

1. Use one of these options to paste the items into another Quick
Builder project, or into an Excel spreadsheet:

o Click E in the toolbar
¢ On the Edit menu, click Paste

o Press Ctrl+V

« Right-click the target position for the copied items, and then
click Paste

If a pasted item already exists in the project, Quick Builder updates
that item.

While attempting to paste an item, several situations can cause an
error message to display, including:

« The item being pasted having an invalid type

o An existing item of the same name failing to be updated

« The list of items failing to be updated

« An attachment to the pasted item failing to also be pasted

o An attachment intended to be detached failing to be detached
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« Anitem being read-only, and therefore not able to be
overwritten with a paste action

Pasting items from a spreadsheet

You can paste items from a Microsoft Excel spreadsheet, providing
the data has the correct format.

TIP: When you paste an equipment item from Excel, it and any
other equipment based on the same equipment template will
have the template reapplied using the most recent values
stored in the equipment’s custom parameters.

To determine the correct format, copy a single item from the project
and paste it into a spreadsheet—the following figure shows the result
for a typical point.

The first row is a heading row, which contains the property names
(ItemName, Class and so on). Each of the following rows contains the
definition for a single item.

If (as in the case of the following figure), you paste a point that has
user-defined parameters, the spreadsheet will contain a second part.
This also has a heading row, and each of the following rows contains
the definition for a single parameter for one of the points listed in the
first part of the spreadsheet.

Figure 2-4: Point with user-defined parameters

A | B | B e e
| 1 |ltemMame Class DownloadedMa Tag Datetodifi DateDownl TagDele
| 2 |POIANAT AnalogPaint FALSE | #HRHRHRG FALSE

&
| 4 |ParentltemMame Class ParamMame |LinkType HistoryFasHistorySta HistoryE
5 |POIAMAT FlexibleParameters UserDefined1 “ariable FALZE = FALZE | FALSt

These rules apply when pasting items from another application:
m The heading row(s) are required.

m [f the spreadsheet contains two parts, there must be a blank row
between the two parts.

m You must define (at least) the ItemName and Class properties for
each item. For user-defined parameters, you must define (at least)
the ParentltemName and Class properties. (You can define any
remaining properties after you have pasted the items into Quick
Builder.)
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To paste items from a spreadsheet

1. Use any one of these options to paste the items into a Quick
Builder project:

Click E in the toolbar

o Select EditPaste from the menu bar
« While holding down the Ctrl key, press the V key

o Right-click on the target position for the copied items and click
Copy
The items are pasted from the clipboard into the project.

Dragging and dropping items

You can select one or more items from the list view and drag them to
another location in the tree view.

Before using the drag and drop feature, consider the following:

m [fyou drag and drop from one location to another, all items and
assigned points below the selected item will be moved and all
associated location and full name properties updated.

m All references and scope of responsibility (SOR) assignments will
be updated to reflect the changes.

m If you drag and drop points within an Alarm Group, selected points
will be moved (not copied).

m |f you drag and drop points from the System Components tree to
a location in an Alarm Group, selected points will be assigned (not
moved) to the selected location or group.

To drag and drop an item

1. In Quick Builder, highlight one or more items to be moved (or
copied).
2. Drag and drop highlighted items to desired location.

Importing items from a definition file
You can import the following items:

m Points from either a point definition file (which has a .pnt
extension) or another project file.
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Controllers, channels, Flex Stations, and printers from a hardware
definition file (which has a .hdw extension).

Quick Builder Equipment Template files (which have an .eqt.xml or
a .typxml extension).

Electronic Flow Measurement (EFM) configurations from a EFM
download formats (which have an .efmsvrxml extension).

These files are the files created during an upload or download
between the server and Quick Builder.

Electronic Flow Measurement (EFM) configurations from a EFM
export formats (which have an .efmdb.xml extension).

These files are the files created during an export of EFM data from
Quick Builder.

Note the following points:

m The import function ignores any points built with Control Builder.

m If an item already exists, it is overwritten with the new values.

m [f the point definition file contains specialized point

configurations, some data may be lost or hidden.

s When importing EFM meter templates:

o Experion will first create a backup copy of the meter template
before it is overwritten. The name used for the backed up item
will be
<OrignalltemName>_bk<n>
where <n> is the index number used when there are multiple
backups of the same item. If the backup name exceeds the
character length limit of an item name, the <OrignalltemName>
portion of the name will be truncated.

o After import, any meters that were using the original meter
template will use the newly imported meter template.

To import items from a definition file

1.

Choose ToolsImport.
The Import dialog box appears.

Select the file that you want to import.
Click OK to import the selected file data into the current project.
You can cancel the import by clicking Cancel on the progress bar.
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The Results dialog box appears, listing the items that were
imported.

If, while importing templates from a definition file, some of the
items were being modified by another user, a message appears
advising of the conflict and listing the templates that could not be
imported.

Uploading an item's definition from the server

If you need to make changes to items that have already been
downloaded to the Experion server, you can upload (or backbuild)
their definitions from the server into the current project. You can then
make the necessary changes to the items and download the new
definitions to the server.

Note the following points:

m [f you upload any specialized point configurations, some data may
be lost or hidden in Quick Builder.

m For user-defined parameters, the state of the Never download initial
value to the server control resides in the user-defined parameters
on the point, and will be included in the upload.

m When you upload an equipment item, that and any other
equipment based on the same template will have the template re-
applied using the most recent values stored in the equipment’s
custom parameters.

To upload item definitions from the server database

1. Click &,
The Upload dialog box opens.

2. Check that Server Details are correct. If they aren't, close the dialog
box and change them on the Server Details tab for the server.

3. Select the appropriate Scope option.

The following options are available for uploading data from a
specified server to Quick Builder.

Option Description

Allitems | Uploads all items from the server, including
in Project | hardware and point configuration data, as well as
the history collection rates and offsets.
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Option ‘ Description

Selected | Uploads only the history collection rates and offsets
Items configured on the server. This upload populates the
Only History Options tab on the Servers properties page.
All Uploads only hardware configuration data. This
Hardware | option includes EFM configurations.

on Server

All Points | Uploads only point configuration data.

on Server

4. (Optional. Not applicable for EFM.) If you want to use any
specialized bckbld or hdwbckbld command-line parameters, click
Show Options and type them in Other Flags. (For details about the
parameters, see the topics on hdwbld and hdwbckbld in the
Hardware and Point Build Reference.)

5. Check your selections in the Summary list, and then click OK.

If another user is modifying, uploading, or downloading any items

you are attempting to upload, a message appears and the upload

only succeeds for any items not currently being worked on by the

other user.

You can terminate the upload by pressing the ESC key.

Managing and using add-ins

An add-in is an optional software component, such as a wizard, that
performs a specialized task.

Quick Builder is supplied with several add-ins. However, you can add
other add-ins at any time by simply copying them to Quick Builder's
Addins folder. The next time you start Quick Builder, the new add-ins
are automatically activated so that you can use them as required.

Note the following points:

m To use an add-in, choose it from the Tools menu. (If it is grayed-
out, activate it.)

m You can speed up Quick Builder by deactivating any add-ins that
you don't require during the current session.

43



Chapter 2 - Getting started with Quick Builder

4y

To activate or deactivate add-ins

1. Choose ToolsAdd-In Manager.

The Add-In Manager dialog box opens.

2. Select or clear the add-ins as required.

Following is a table of the supplied add-ins. Deactivated add-ins
appear grayed-out in the Tools menu.

Add-in ‘ Description

QB Import | Imports a *.pnt or *.hdw file and deletes items from
Del Lines | the project’s database where there is a DEL

AddIn [itemname] within the file.

QB Migrates old Quick Builder projects to the current
Migration | format.

Wizard
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Building a system printer

1. Use one of the following options to create a new system printer:

Option ‘ Result
From the Printers section The new printer appears in the
within the Library, drag and List View.
drop the Printer item into the
List View.
Click E}_ The Add Item(s) dialog box
appears.
1. From the Item Family list,
select the applicable
family.

2. From the Item Type list,
select Printer.

3. In the Name text box, type
in the name for this
printer, or you can accept
the default provided.

4, Click OK to add the
printer to the list.

2. Use the Main tab to configure the printer.

Main properties for a system printer

The Main tab defines the Experion system printer's basic properties.

Property ‘ Description

Name The printer's name, as defined and configured under Windows.

If the Windows printer name is more than 30 characters long,
or includes a space, you must install a print driver with a
suitable name. See the Software Installation User's Guide for
more information.

Description A description of the printer.

Associated asset The asset that an operator must have access to in order to see
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Property

‘ Description

system alarms from this system interface. If you leave the
associated asset field empty, the system alarms for this system
interface will be seen by anyone who has access to the system
alarms for the server on which this system interface is
configured.

Alarm/Event Printer
Language

Only applicable if this is an alarm/event printer. The character
set used for printing alarms and events. (But not reports, which
are always printed in the Latin character set.)

If you select:

. Cyrillic, you must use an Epson LQ-1070 (or later) printer
and set its DIP switches to Bulgaria.

. German, you must use an Epson LQ-1070 (or later)
printer and set its DIP switches to Multilingual.

Item type

Shows the printer type.

Last Modified

The date/time on which the printer's details were last modified.

Item Number

The printer's ID.

Last Downloaded

The date on which the item was last downloaded to the server.

Working with projects

A project is a Quick Builder database that has been created and
configured on a standalone SQL server, as opposed to an Experion
server.

In this section:
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Setting Quick Builder project options

When you use a project to configure your system in a standalone
database, rather than in the Quick Builder database on the Experion
server, you can specify various Quick Builder options, both general
and project-specific.

If you are working in a Quick Builder project or you have migrated
databases, it is a good idea to verify that your options are correct.
Your options include the server and the enabled components.

To verify your server

1. In Quick Builder click the server icon in the Navigation pane.

2. On the Main tab, check that the server type matches the version of
Experion that you have installed.

To verify your enabled components

1. Choose ToolsComponent Manager.

The list shows which components are enabled, as well as the
number of items that have been created for each component.

2. Select or clear the check box opposite each component you want
to enable/disable.

If other users are working in this project when you make changes
to the enabled components, those users will be locked out of the
project until your changes are complete. A message appears
asking you to confirm this action.

Likewise, if another user chooses to change the enabled
components for a project you are working in, you will be locked
out and will need to log in again after the changes have been
made.

3. Click OK.

Creating a new project

When you create a new project you should specify which components
are needed in the project. (Components include item types, such as
points and controllers, as well as algorithms.) See "Setting Quick
Builder project options" for more information.
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TIP: You can substantially improve Quick Builder's performance
by only enabling the components you want to use in the
project. (You can enable more components later if necessary.)

Projects are created in an offline Quick Builder database while
connected to a standalone SQL server and can be downloaded to an
Experion server at a later time.

When creating a project, you have the choice of creating:

m An online project, in the Quick Builder database on an Experion
server; or,

m An offline, or standalone, project in the Quick Builder database on
either a local or remote SQL server, with the intention of
downloading the project to the Quick Builder database on an
Experion server at a later time.

Prerequisites

m You must be logged on with a Windows account that belongs to
the Honeywell Station Users Windows group.

m To be able to create a project, you must have a version of SQL
Server installed. A minimum of SQL Server Express is required.

To create a new project

1. From Configuration Studio, click Connect to open the Connect
dialog.

2. Depending on whether you are creating an online or an offline
project, use one of the following connection options:

Option ‘ Description

To create a project in the 1.  Onthe Local Targets tab,
Quick Builder database on select the system or server
your local Experion Server you would like to connect
(online project). to.

2. Click Connect.

To create a project in the 1. On the Other Targets tab,
Quick Builder database on a select either Experion PKS
remote Experion Server System or Experion PKS
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Option ‘ Description
(online project). Server from the Target type
list.
2. Select the system or server

you would like to connect
to from the Target name list.

3. Click Connect.

To create a project in Quick |1, On the Other Targets tab,

Builder database on an SQL select Quick Builder
Server (offline project). Database from the Target
type list.

2. Select the SQL server you
would like to connect to
from the Location list.

3. To open an existing project:

a. Click the Open Existing
Project option

b. Click Search Location to
list the databases
existing on that server.

C. Select the database you
would like to connect to
from the list provided.

4. To create a new project:

a. Select the Create Project
option

b. Type a name for the new
project in the Project
Name field.

5. Click Connect.

3. When the Enable Components dialog box opens, enter the System
Number and Authorization Code details for this server, then click
Apply to enable the components contained in this license.
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4. Alternatively, use the Enable Components tab to enable:
« Specific components; or
o All components already installed on your computer
5. Click OK to create the project.

a. While working on a project, click Save at any time to save the
project.

b. As soon as you move from one item (such as a field or a tab) to
another item in Quick Builder, any changes made on the
previous item are automatically saved.

c. When closing a project, Quick Builder saves information about
the project's setup, including the current views and filters. The
next time you open the project, this setup is restored.

d. If you attempt to create and save a new online, or default,
project at the same time as another user, an error message
appears as there can only be one online (default) project.
Multiple offline, or standalone, projects can coexist, however,
with information from those projects downloaded to the online
project as appropriate.

Migrating old Quick Builder projects

The Quick Builder Project Migration wizard, which is supplied with
Quick Builder, guides you through migrating old Quick Builder
projects to the current format. When you start Quick Builder, the
system will prompt you to perform a migration if:

m The target server contains a Microsoft Access Quick Builder
database and no instance of an equivalent initialized SQL Quick
Builder database

m The target server contains an initialized Quick Builder SQL
database, but it has not been matched with the current client

Note that if you try to open a project that was created with

components that are not installed on your current system, you will
receive a message that will tell you which components are missing
and ask you to either cancel the procedure or convert the project.

If you click Convert, the information contained in the missing
component will be deleted.

Before migrating a R3xx/R4xx project you need to minimize the
project because all components are enabled in old Quick Builder
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projects, and migrating them in this state may impact performance.
To minimize the a project before migrating:

1. Open the old version of Quick Builder

2. Select Tools > Component Manager > Minimize Project.
You are now ready to migrate your Quick Builder project.

To migrate an old project

1. When prompted, click Next to start the migration wizard.
2. Select the project you want to migrate, and click Next.

If another user is attempting to migrate the project from another
client at the same time, you will be locked out of the project until
the other migration is complete.

3. Select to either overwrite the current project or create a new
project.

4. Review the table supplied which lists items in the old database that
will be migrated, then click Next.

Where any items cannot be mapped to the same item in the new
database, they are listed in the Unresolved properties page.
5. Map any unresolved properties, and then click Next.

Any unresolved properties that are not mapped to a new property
are not migrated.

When the migration is complete, the Migration Results page is
displayed, listing all the migrated items.
6. Click Finish to close the migration wizard.

The first time Quick Builder is opened after the SQL restore it must
be opened with Product Administrator access to complete the
project migration.

Opening an existing project

You can open projects on the current server to which you are
connected, or projects on another server.

ATTENTION: You can only work with one project at a time. If
you open another project or create a new one, Quick Builder
closes the currently open project.
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To open an existing project

akrwnE

o

From Quick Builder, click Connect to open the Connect dialog.
Click the Other Targets tab.

Select QuickBuilder Database from the Target type list.

Select the SQL server from the Location list.

Select the Open Existing Project option and click Search Location to
display a list of projects on that server.

Select the project you want to open, and click Connect.
Quick Builder opens, with the selected project loaded.

A maximum of 4 users can connect to an online Quick Builder
project at the same time. If you try to open a project that already
has 4 users connected, you will receive an error message
suggesting that you try to connect again later.

Exporting project data

You can export project data to external files. The export files contain
point, hardware, or model definition information in a format that the
server database can use. You can export:

Point definitions to a point definition file (with a .pnt extension).
This includes any user-defined parameters you have created.

Hardware definitions to a hardware definition file (with a .hdw
extension).

Electronic Flow Measurement (EFM) definitions to an EFM export
format file (with an .efmdb.xml extension).

To export project data

1.

Choose FileExport.

The Export dialog box opens.

Specify the folder in which the exported file(s) are to be created in the
Folder for File(s) field.

Type the base name for the exported files in the Base Name for File(s)
field.

Select the file type from the Export File Type list.

Specify what you want to export by selecting the appropriate Scope
option. Options are:
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o All items relevant to file type
« Selected items only

6. Click Show Options to display the available options and select the
options you wish to use for this export.

Option ‘ Description

Export All Fields Exports every property of an
exported item.

Ignore Deleted Items Prevents items in the Recycle Bin
being exported.

Ignore Attachments Prevents point attachments being
exported. Attachments include
algorithms.

Skip Items in Error Skips an item if its definition

contains any errors.

Abort if format not found Abort the export if the export file
format specified is not found.

Overwrite format extensions | Creates an export file without the
file format extension.

For example, to export a point
with a base file name of QBDB
without this option enabled, the
exported file name would be
QBDB.pnt. However, if the option
was enabled, the exported file
name would be QBDB and would
not have the file format extension
of .pnt.

Don't overwrite existing files | Prevents you from overwriting an
existing export file with the same
name.

Create Single File Only Creates a single file, instead of
multiple files.
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7. Check your selections in the Summary list, and then click Export.
The Results dialog box opens, listing the download and log files

If another user is currently modifying this project, a message
appears stating that the project is locked and the Exportis not
possible at this time.

You can terminate the export at any time by clicking Cancel on the
progress bar.

About exporting results of Floating Point data to CSV
files

When exporting Floating Point data types to CSV files, values are
rounded to the following significant digits:

Data type Number of significant digits
Single/Real/Float 6
Double 15

For example for a Real type calculation, 1.236589563251 * 60 =
74.19537379506 will be exported to CSV as 74.1954.

The rounding occurs because Experion stores values in binary format,
whereas CSV files store values as text strings. The export to CSV
process converts the binary format to text strings and rounds values
to either 6 or 15 digits, depending on the data type.

Examples

The following table shows how Single/Real/Float and
Double values are rounded when exported to CVS

files.
Value ‘ Single/Real/Float ‘ Double
12.345678901234567890 | 12.3457 12.3456789012346
1234.5678901234567890 | 1234.57 1234.56789012346
123456.78901234567890 | 123457 123456.789012346
1234567890.1234567890 | 1.23457e+09 1234567890.12346
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Downloading a project

After adding and configuring items, you download all or part of your
project to the server database.

Note that if Electronic Signature Compliance Restriction is enabled,
you must be logged on with an integrated account with a security
level of engr or mngr. (An integrated account is a Windows account
that has also been defined as an operator ID on the server. For more
details about integrated accounts, see the Server and Client
Configuration Guide.)

To download all or part of a project

1. If you want to download:

« The whole project, or items you have modified since the last
download, go to step 2

o Specific items, select those items.

2. Click ¥, to display the Download dialog box.

3. Check that Server Details are correct. If they aren't, click Edit to
change the server details as required.

4. Specify what you want to download by selecting the appropriate
Scope option. Options are:

o All items in selected server
« Selected items (default)
o Items changed since last download

5. If you want to select any specialized options, click Show Options
and select the options as required. Details of each option are
provided in the following table.

Option ‘ Description

Automatically | If selected, items in the Recycle Bin are deleted from the server
download database when you download to the server.

deletions

TIP: Normally, deleted items are kept in the Recycle Bin to
enable users to undo an item's deletion from Quick Builder.

If the download is successful, the Recycle Bin is emptied.
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Option

Rebuild scan
tables

‘ Description

Select this if you want the server to rebuild the scan packets. (Note
that the scan packets will only be rebuilt if no error occurs during the
point configuration phase of the download operation.)

If you are making many changes, you can save time when
downloading by clearing the check box. You only need to select the
check box when you perform the final download.

(Scan tables must be rebuilt when adding new controllers or points,
or when changing the scan periods of existing points. The server
does not scan at the configured rate until the scan tables are rebuilt.)

ATTENTION:

For SCADA systems, downloading items from Quick Builder to
the server (orwhen using the pntbld command) may cause
temporary bad values on any controllers that are configured to
report by exception. This is because the scanning system loads
the new scanning strategy. If this occurs, values will return to
normal after 1-2 seconds.

If you want to prevent the rebuilding of the new scan strategy,
clear the Rebuild Scan Tables check box when downloading
from Quick Builder, or use the -ns switch in pntbld. Be
aware that scanning of any new or changed points will not
occur until the new scanning strategy is loaded.

Download all
Fields

Downloads all parameter values, including default values, associated
with the downloaded items.

Select this option to synchronize the runtime values with Quick
Builder.

NOTE: Typically this synchronization is achieved by uploading
the Quick Builder database.

Skip ltems in
Error

Prevents an item definition being downloaded if it contains any
errors.

TIP: Select this option if you have partially defined a number of
items in Quick Builder and you would like the bulk download
to complete building as many items as possible.
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Option ‘ Description

Check points | Sets each point's Scanning Enabled property to Off Scan, regardless of

off scan its setting in your project. This is useful when you are developing
points, and don't want them to be scanned immediately after
download.

Force Forces downloading of Flex Stations, channels and controllers even if

Hardware there are errors.

Building

Note that if this is used for a:

« Station, it will be rebuilt even if it is currently connected

« Channel, the controllers and points attached to the channel may
lose their reference to the channel

« Controller, the points attached to the controller may lose their
reference to the controller

Don't Prevents existing download-related files being overwritten. (Each
overwrite time you perform a download, various files are created as part of the
existing files | download process.)

This option would typically be enabled when requested by Honeywell
Support to help collect additional information which may assist to
diagnose an issue.

Deletions Deletes the selected point(s) in the server database. (They remain in
only the project.)

This option can be used to temporarily remove items from the
runtime server but keep the configuration in Quick Builder. This
would be helpful if there were configuration changes that required
related items to be removed from the server to complete a task. For
example, moving a controller to a different channel (requires points
to be deleted).

Other flags Allows you to specify specialized pntbld and hdwbld command-line
parameters. (For details, see the Hardware and Point Build
Reference.)

This option would typically only be used if instructed to do so by
Honeywell Support.

6. Click OK to close the Download Options dialog box.
7. Check your selections in the Summary list, then click OK.
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8.

If Electronic Signature Compliance Restriction is enabled and you are
not logged on with an integrated

account, the QB User Sign-On dialog box opens. Type a User Name,
Password, and Domain, then click OK.

Downloading starts and, when finished, the Results dialog box
opens, listing the resultant download and log files.

You can terminate the download by clicking Cancel on the
progress bar.

TIP: If another user is also trying to download this project at
the same time, the download fails and an error message
appears suggesting that you try again later.

Locking a project

Projects can be locked, or placed into maintenance mode by a
Product Administrator for a period of time during which no changes
can be made to the project.

When a project is locked, a lock icon and the text LOCKED appear in
the bottom right area of the Status Bar. Only users with sufficient
authority can lock or unlock projects. Attempting to modify items
within a project while it is locked results in an error message
appearing.

To lock a project

1. From the Tools menu in Quick Builder, choose Lock Project for

Maintenance.

The project is locked, and the lock icon and text LOCKED appear in
the Status Bar. All current users of the project receive a message
stating that The Quick Builder project has been locked for maintenance.

To unlock a project

1. From the Tools menu in Quick Builder, choose Release Maintenance

Lock.

The project is unlocked, and the lock icon and text LOCKED
disappear from the Status Bar. All current users of the project
receive a message stating that The maintenance lock has been
removed from the Quick Builder project.
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Opening files listed in the Results dialog box

The Results dialog box lists every file created by Quick Builder when
importing, downloading, or exporting project details. In addition to

the point and hardware definition files (*.pnt and *.hdw), the list
includes the following log files (*.log).

Log file ‘ Description

Event Lists events incurred for all tools within Configuration Studio.

Upload List errors that occur when connecting to the server.

Download

Import List any errors that occur when import/export items contain invalid
configurations.

Export

Migration | List any errors that occur when migrating database into Quick Builder.

You can view any file by double-clicking it.

Improving Quick Builder's performance

You can substantially improve the performance of Quick Builder by
disabling any components that are not required in the project (You
can enable more components later if necessary.)

To disable unused components

1. Choose ToolsComponent Manager.

The Component Manager dialog box appears, listing which
components are enabled, as well as the number of items that have
been created for each component.

2. Disable any components that are not required in the project, and
click OK.
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CHAPTER

3 BUILDING CONTROLLERS OR CHANNELS

This section outlines how to use Quick Builder to build and configure
controllers and channels.

TIP: When building controllers and channels for use with
equipment, or to be referenced by Equipment Templates, do
not include underscores or hyphens in the names specified for
the controller or channel, and avoid channel names ending in x.

In this section:

Building controllers and channels ... ... ... .. ... 62
About generic and user scan task controllers ............................ 64
Creating a generic controller ... . . .. 64
Creating a user scan task controller ... .. ... ... ... ... 66
Generic and user scan task controller and channel properties ...... 68
Modifying a controller or channel after download ...................... ’5
ADOUT SCANNING ..o 79
Building Controller Integration Mappings ..........ccouoeueeeeeeeai.. 82
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Building controllers and channels

Option

From the
Controllers
section within
the Library, drag
and drop the
Controller item
into the List
View.

To build a new controller, do one of the following:

‘ Result

The new controller(s) appears in the List View, and the properties

tabs enable you to complete the configuration of the new
controller.

Click E}

The Add ltem(s) dialog box appears.

1.

5.

In the Number of items to Add text box, type the number of
controllers you want to add.

From the Item Family list, select the applicable family.
From the Item Type list, select Controller.

In the Name text box, type in the name for this controller, or
you can accept the default provided. If you have chosen to
create multiple controllers, the Multi - Items section is
enabled, and you can provide a prefix for all the controllers,
or you can accept the default provided. You can also indicate
whether to use a sequential number or letter to differentiate
between the controllers.

TIP: When building controllers and channels for use with
equipment, or to be referenced by Equipment Templates,
do not include underscores or hyphens in the names
specified for the controller or channel.

Click OK to add the channel(s) to the list.

Use the properties tabs to configure each controller by first
highlighting it in the List View.

Each type of controller supported by Experion has its own help file
that includes detailed installation and configuration instructions
specific to that controller type.




Option

From the
Channels
section within
the Library,
drag and drop
the Channel
item into the
List View.
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To access the help file for a specific controller, either:

m Press F1 when you are currently editing the properties of the
controller or its associated channel; or,

m From Configuration Studio, choose HelpController Help[Controller],
where [Controller] is the name of the controller for which you want
help.

To build a new channel, do one of the following:

‘ Result

The new channel(s) appears in the List View, and the properties tabs
enable you to complete the configuration of the new channel.

Click E}

The Add Item(s) dialog box appears.

1. In the Number of items to Add text box, type the number of
channels you want to add.

2. From the Item Family list, select the applicable family.
From the Item Type list, select Channel.

4, In the Name text box, type in the name for this channel, or you
can accept the default provided. If you have chosen to create
multiple channels, the Multi - Items section is enabled, and
you can provide a prefix for all the channels, or you can
accept the default provided. You can also indicate whether to
use a sequential number or letter to differentiate between the
channels.

TIP: When building controllers and channels for use with
equipment, or to be referenced by Equipment Templates,
do not include underscores or hyphens in the names
specified for the controller or channel, and avoid channel
names ending in x.

5. Click OK to add the channel(s) to the list.
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Use the properties tabs to configure each channel by first highlighting
it in the List View.

About generic and user scan task controllers

There are two specialized types of controller: generic and user scan
task.

Generic controllers

You use a generic controller if you want to configure a device that is
supported by the server (that is, the server can access its database)
but for which there is no controller-specific Property Page in Quick
Builder.

User scan task controllers

A user scan task controller is a 'virtual controller' that treats a user file
(a server database table) as if it were a controller.

Notes

m A user scan task controller can have a status of disabled or failed.
The database point is updated, regardless of the status.

m You can use a user scan task controller to interface with an
unsupported controller. For details, see the Application
Development Guide.

m For details about designing an efficient user file, see the
Application Development Guide.

Creating a generic controller

You can add generic controllers and channels to your project.

To create a generic controller and channel:

Add a Generic channel to the project.
Configure the channel as appropriate.
Add a Generic controller to the project.

F DN PE

Configure the controller as appropriate, making sure that you
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select the generic channel that you have just added.
5. Add points as appropriate.

Point parameter address syntax for a generic
controller

The address syntax for a point parameter in a generic controller is
either:

ControllerNameWord [Format]

or

ControllerNameWordBit [Width | MODE]

Part ‘ Description

ControllerName | The name of the generic controller.

Word The data address (in decimal) for the parameter value in the PLC
data table. Addresses range from 0001 to 8192.

Format For unscaled values:

. DBLE = Double precision (64-bit) floating point

. INT2 = Short (16-bit) integer

. INT4 = Long (32-bit) integer

. REAL = Single precision (32-bit) floating point number

For scaled values (If the following formats are used, the value is
assumed to be an unsigned 16-bit integer and is scaled by the range
specified for the point. The following formats specify the raw range
of the value in the device.):

U100 =0 to 100

U999 = 0 to 999

U9999 =0 to 9999
$S9999 = -9999 to 9999
U1023 =0 to 1023

Bit The start bit within the word (for partial integers).
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Part ‘ Description

You cannot specify Bit and Width for analog point parameters that
are used as controls.

Width The number of bits, including the start bit, which make up the partial
integer.

The default width is dependent on the type of point and the
parameter. For MD point parameters the default is 1-bit; for PV or
OP status point parameters the default is the PV or OP width.

You cannot specify Bit and Width for analog point parameters that
are used as controls.

MODE Only applicable to the MD parameter. Controls the bit width. If you
specify MODE, the mode is 2-bit; if you don't, the mode defaults to
1-bit.

Example

An analog point PV source: CNTGEN1 003 INT2

Creating a user scan task controller

To create a user scan task controller and channel:

Add a User Scan Task channel to the project.
Configure the channel as appropriate.
Add a User Scan Task controller to the project.

F N PE

Configure the controller as appropriate, making sure that you
select the user scan task channel that you have just added.

5. Add points as appropriate.

Point parameter address syntax for a user scan
controller

The address syntax for a point parameter in a user scan task
controller is either:

ControllerName Word [Format]

or
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ControllerName Word Bit [Width] [MODE]

Part ‘ Description

ControllerName | The name of the user scan task.

Word The data address (in decimal) for the parameter value in the PLC
data table. Addresses range from 0001 to 8192.

Format For unscaled values:

o DBLE =double precision (64-bit) floating point

o INTZ = short (16-bit) integer

o INT4 =long (32-bit) integer

o REAL =single precision (32-bit) floating point number

For scaled values (If the following formats are used, the value is
assumed to be an unsigned 16-bit integer and is scaled by the

range specified for the point. The following formats specify the raw
range of the value in the device.):

« U100 =0to 100

o U999 =0 to 999

e U9999 =0 to 9999

e S9999 =-9999 to 9999

« U1023=0t0 1023

If you want to use a user-defined data format, you must define the
format on the server. See the section titled "About user-defined

data formats" in the Server and Client Configuration Guide for more
information.

Bit The start bit within the word (for partial integers).

You cannot specify Bit and Width for analog point parameters that
are used as controls.

Width The number of bits, including the start bit, which make up the
partial integer.

The default width is dependent on the type of point and the
parameter. For MD point parameters the default is 1-bit; for PV or
OP status point parameters the default is the PV or OP width.

You cannot specify Bit and Width for analog point parameters that
are used as controls.
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Description

MODE

Only applicable to the MD parameter. Controls the bit width. If you
specify MODE, the mode is 2-bit; if you don't, the mode defaults to
1-bit.

Example

An analog point PV source: RTUUSEO 003 1 INT2

Generic and user scan task controller and
channel properties

Property

Name

This section describes the properties of generic and user scan task
controllers and their associated channels.

TIP: Every other type of controller has its own help file. If you
are currently editing a controller's or channel's properties,
press F1 to open its help file. (Alternatively select it from the
Help menu.)

Main properties for a generic channel
The Main tab defines the basic properties for a generic channel.
‘ Description

The unique name of the channel. A maximum of 10 alphanumeric
characters (no spaces or double quotes). Note: In Station displays,
underscore characters ( _) appear as spaces.

Description

(Optional) A description of the channel. A maximum of 132
alphanumeric characters, including spaces.

Associated The asset that an operator must have access to in order to see

asset system alarms from this system interface. If you leave the
associated asset field empty, the system alarms for this system
interface will be seen by anyone who has access to the system
alarms for the server on which this system interface is configured.

Port The full port description, which includes the port name, baud, and
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Property ‘ Description

parity.
Format:

serial port=PortName baud=BaudRate [parity=odd|even|none data=n
stop=n checksum=ChecksumType duplex=half|full connect=nn
read=n]

Redundant Port | The full redundant port description, which includes the port name,
baud, and parity. The redundant port format is the same as that for
the port, except for the port name.

Definition Format:
ChannelType [name=ChannelName marg=nn fail=nn]

Where:

. ChannelType is the type of channel, for example GEM8O0.
. ChannelName is the channel name.

N marg=nn is the communications marginal alarm limit at which
the channel is declared to be marginal. A high priority alarm
is generated when this number of errors is reached. To
calculate an acceptable limit, multiply the square root of the
number of controllers on the channel with the controllers'
Marginal Alarm Limit (generally, you specify the same value for
all controllers on a particular channel). For example, if there
are 9 controllers, and you have set the controllers' Marginal
Alarm Limit to 10, the value would be +9x10 (that is, 30).

. fail=nn is the communications alarm fail limit at which the
channel is declared to have failed. An urgent alarm is
generated when this number of errors is reached. Set this to
double the value of the marginal alarm limit.

Item Type Shows the channel type.

Last Modified Shows the date of the most recent modification to this channel's
property details.

Item Number The unique item number currently assigned to this item. You can
change the item number if you need to match your current server
database configuration. The number must be between 1 and the
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Property ‘ Description
maximum number of channels allowed for your system (the
maximum is shown on the Sizing tab for the server).
Last The date on which the item was last downloaded to the server.
Downloaded

Main properties for a generic controller

The Main tab defines the basic properties for a generic controller.

Property

Name

‘ Description

The unique name of the controller. A maximum of 10
alphanumeric characters (no spaces or double quotes). Note: In
Station displays, underscore characters ( _ ) appear as spaces.

Some controller types may impose restrictions on the name you
give the controller. See the specific controller interface
documentation for more information.

Description

(Optional) A description of the controller. A maximum of 132
alphanumeric characters, including spaces.

Associated asset

The asset that an operator must have access to in order to see
system alarms from this system interface. If you leave the
associated asset field empty, the system alarms for this system
interface will be seen by anyone who has access to the system
alarms for the server on which this system interface is
configured.

Channel Name

The name of the channel on which the controller communicates.
(You must have already defined the generic channel so that it
appears in this list.)

Definition

Defines the controller type and its communication settings. For
detailed information, see the documentation supplied with the
controller.

The generic syntax is:
TypeNo ID=nn [name=ControllerName marg=nn fail=nn]

Where:

. TypeNo is the number that identifies the type of controller.
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Property ‘ Description

. ID=nn is the controller ID number.
. ControllerName is the of the controller.

. marg=nn is the communications marginal alarm marginal at
which the controller is declared to be marginal. When this
number of errors is reached, a high priority alarm is
generated. The default value is 25.

. fail=nn is the communications fail alarm limit at which the
controller is declared to have failed. When this number of
errors is reached, an urgent alarm is generated. Set this to
double the marginal alarm limit.

Item Type Shows the controller type.

Last Modified Shows the date of the most recent modification to this
controller's property details.

Item Number The unique item number currently assigned to this item. You can
change the item number if you need to match your current server
database configuration. The number must be between 1 and the
maximum number of channels allowed for your system (the
maximum is shown on the Sizing tab for the server).

Last Downloaded | The date on which the item was last downloaded to the server.

Main properties of a user scan task channel

The Main tab defines the basic properties for a user scan task

channel.
Property ‘ Description
Name The unique name of the channel. A maximum of 10 alphanumeric

characters (no spaces or double quotes). Note: In Station displays,
underscore characters ( _) appear as spaces.

Description | (Optional) A description of the channel. A maximum of 132
alphanumeric characters, including spaces.

Associated The asset that an operator must have access to in order to see system
asset alarms from this system interface. If you leave the associated asset
field empty, the system alarms for this system interface will be seen by
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Property ‘ Description

anyone who has access to the system alarms for the server on which
this system interface is configured.

Marginal
alarm limit

The communications alarm marginal limit at which the channel is
declared to be marginal. When this limit is reached, a high priority
alarm is generated. To change the priority of the alarm system wide,
see the topic titled "Configuring system alarm priorities" in the Server
and Client Configuration Guide.

To change the priority of the alarm for one channel, see the topic
titled "About configuring custom system alarm priorities for an
individual channel or controller” in the Server and Client Configuration
Guide.

A channel barometer monitors the total number of requests and the
number of times the controller did not respond or response was
incorrect. The barometer increments by two or more, depending on
the error, and decrements for each good call.

To calculate an acceptable marginal alarm limit, use the formula:
Square root of the number of controllers on the channel x Marginal
Alarm Limit defined on those controllers (Normally, you specify the
same value for all controllers on a channel).

For example, if there are 9 controllers on the channel and their
Marginal Alarm Limit is set to 25, the value would be 3 (which is the
square root of 9) x 25 = 75.

Fail Alarm
Limit

The communications alarm fail limit at which the channel is declared
to have failed. When this barometer limit is reached, an urgent alarm
is generated. To change the priority of the alarm system wide, see the
topic titled "Configuring system alarm priorities" in the Server and
Client Configuration Guide. To change the priority of the alarm for one
channel, see the topic titled "About configuring custom system alarm
priorities for an individual channel or controller” in the Server and
Client Configuration Guide.

Set this to double the value specified for the channel Marginal Alarm
Limit.

Item Type

Shows the channel type.

Last
Modified

Shows the date of the most recent modification to this channel's
property details.
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Property ‘ Description
Item The unique item number currently assigned to this item. You can
Number change the item number if you need to match your current server

database configuration. The number must be between 1 and the
maximum number of channels allowed for your system (the maximum
is shown on the Sizing tab for the server).

Last The date on which the item was last downloaded to the server.
Downloaded

Main properties for a user scan task controller

The Main tab defines the basic properties for a user scan task
controller.

Property ‘ Description

Name The uniqgue name of the controller. A maximum of 10 alphanumeric
characters (no spaces or double quotes). Note: In Station displays,
underscore characters ( _) appear as spaces.

Description | (Optional) A description of the controller. A maximum of 132
alphanumeric characters, including spaces.

Associated The asset that an operator must have access to in order to see system

asset alarms from this system interface. If you leave the associated asset
field empty, the system alarms for this system interface will be seen by
anyone who has access to the system alarms for the server on which
this system interface is configured.

Channel The name of the channel on which the controller communicates. (You

Name must have already defined the generic channel so that it appears in
this list.)

Marginal The communications alarm marginal limit at which the channelis

alarm limit declared to be marginal. When this limit is reached, a high priority
alarm is generated. To change the priority of the alarm system wide,
see the topic titled "Configuring system alarm priorities" in the Server
and Client Configuration Guide.

To change the priority of the alarm for one channel, see the topic
titled "About configuring custom system alarm priorities for an
individual channel or controller" in the Server and Client Configuration
Guide.
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Property ‘ Description

A channel barometer monitors the total number of requests and the
number of times the controller did not respond or response was
incorrect. The barometer increments by two or more, depending on
the error, and decrements for each good call.

To calculate an acceptable marginal alarm limit, use the formula:
Square root of the number of controllers on the channel x Marginal
Alarm Limit defined on those controllers (Normally, you specify the
same value for all controllers on a channel).

For example, if there are 9 controllers on the channel and their
Marginal Alarm Limit is set to 25, the value would be 3 (which is the
square root of 9) x 25 = 75.

Fail Alarm
Limit

The communications alarm fail limit at which the channel is declared
to have failed. When this barometer limit is reached, an urgent alarm
is generated. To change the priority of the alarm system wide, see the
topic titled "Configuring system alarm priorities" in the Server and
Client Configuration Guide. To change the priority of the alarm for one
channel, see the topic titled "About configuring custom system alarm
priorities for an individual channel or controller" in the Server and
Client Configuration Guide.

Set this to double the value specified for the channel Marginal Alarm
Limit.

File Number

The file and record number of the user table that this ‘controller’
represents.

Record

Number

LRN The logical resource number of the user scan task to be notified of

Number point control requests.
This entry specifies the LRN of a user scan task written with the
Application Programming Interface. (For details about writing a user
scan task, see the Application Development Guide.)

Item Type Shows the controller type.

Last Shows the date of the most recent modification to this controller's

Modified property details.

Item The unique item number currently assigned to this item. You can

Number change the item number if you need to match your current server
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Property ‘ Description

database configuration. The number must be between 1 and the
maximum number of channels allowed for your system (the maximum
is shown on the Sizing tab for the server).

Last The date on which the item was last downloaded to the server.
Downloaded

Modifying a controller or channel after
download

Some of the properties of channels and controllers cannot be
changed after they have been downloaded to the server database.
However, it is possible to delete and then rebuild the channel or
controller, effectively changing the properties. The procedure is
similar to modifying the controller’s item number, described below.

The following procedures describe how to perform typical tasks:

m Modifying a controller's ltem Number

m Move a controller to another channel (this is typically done to
redistribute communications loads between channels)

m Change a channel from redundant to non-redundant

ATTENTION: These tasks must be performed on the primary
server.

The procedures for modifying the controllers involve temporarily
moving the points attached to the controller you are modifying to a
temporary controller—this is necessary to prevent loss of point
configuration and history data while you are modifying the controller.
For clarity, the controller being modified is called Original and the
temporary controller is called Temporary.

CAUTION: These procedures are laborious and if not followed
carefully have the potential to delete point configuration and
history data. You should therefore attenpt these procedures only
after you have fully backed up your system.
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To modify a controller's ltem Number

1.

2.

w

10.

11.

12.

13.
14.

15.

16.
17.

Create a controller called Temporary that is of the same type as
Original.

Arrange the points by Source Address and copy all the points
attached to Original to the clipboard.

Paste the points into an Excel worksheet.

In Excel, globally change Original to Temporary to reassign the
points to the controller called Temporary.

Copy the contents of the Exscel worksheet to the clipboard.

Paste the points back into Quick Builder. This will overwrite the
existing point definitions.

Download Temporary and its points. If the download is successful,
the points are now assigned to Temporary in the server database.

Copy Original to an Excel worksheet.
Move Original to the Recycle Bin.

Download the project, making sure that Austomatically Download
Deletions is selected.

If the download is successful, the Original controller is deleted
fron the server database and well as from the project.

In Excel:

a. Change ltem Number as required.

b. Clear the contents of the Date Downloaded entry.

c. Copy the contents to the clipboard.

Paste the controller back into Quick Builder. This recreates
Original, with its new Item Number.

Download the project.

Repeat steps 2 to 6, but this time globally change Temporary to
Original. This effectively assigns the points back to Original.

Download the project. If the download is successful, the points are
reassigned to Original in the server database.

Move Temporary to the Recycle Bin.

Download the project, making sure that the Automatically
Download Deletions option is selected.

If the download is successful, the Temporary controller is deleted
from the server database as well as from the project.
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To move a controller to another channel

1.

2.

If the channel to which you want to add the controller does not
already exist, create and configure it now.

Create controller called Temporary that is of the same type as
Original.

Arrange the points by Source Address and copy all the points
attached to Original to the clipboard.

Paste the points into an Excel worksheet.
In Excel, globally change Original to Temporary.
This effectively reassigns the points from Original to Temporary.

Copy the contents of the Excel worksheet to the clipboard.

7. Paste the points back into Quick Builder to overwrite the existing

10.
11.

12.

13.

14.
15.

16.

point definitions.

Download Temporary and its points. If the download is successful,
the points are assigned to Temporary in the server database.

Copy Original to an Excel worksheet.
Move Original to the Recycle bin.

Download the project. (Make sure that the Automatically Download
Deletions option is selected.)

If the download is successful, the Original controller is deleted
from the server database as well as from the project.

In Excel:

a. Change Channel Name as required.

b. Clear the contents of the Date Downloaded entry.
c. Copy the contents to the clipboard.

Paste the controller back into Quick Builder. This recreates
Original, which is now attached to the other channel.

Download the project.

Repeat steps 3 to 7, but this time globally change Temporary to
Original.

This effectively reassigns the points back to Original.

Download the project.

If the download is successful, the points are reassigned to Original
in the server database.

7’



Chapter 3 - Building controllers or channels

78

17.
18.

Move Temporary to the Recycle bin.
Download the project. (Make sure that the Automatically Download
Deletions option is selected.)

If the download is successful, the Temporary controller is deleted
from the server database as well as from the project.

To change a channel from redundant to non-
redundant

1.

In Quick Builder, export the channel to a local folder on the
computer. See the topic titled "Exporting project data" for more
information.

Using Notepad, open the .hdw file that was created when you
exported the redundant channel.

For example, the file is called QBDB. hdw and the contents of the
file is as follows:

&Item:ModiconChanl

ADD CHNO4 TRMSRV PORT=127.0.0.1:3003 CONNECT=200
READ=150

ADD CHNO4D TRMSRV PORT=127.0.0.1:3004
CONNECT=200 READ=150

DEF CHNO4 NAME=MODICONChanl MAR=25 FAIL=50

&

Where CHN040 isthe redundant connection you want to remove.

Edit the line that refers to the redundant link by changing ADD to
DEL and removing the remainder of the line.

To continue the example in the previous step:

&Item:ModiconChanl

ADD CHNO4 TRMSRV PORT=127.0.0.1:3003 CONNECT=200
READ=150

DEL CHNO04D

DEF CHNO4 NAME=MODICONChanl MAR=25 FAIL=50

&

Save the .hdw file.

Open a Command Prompt and change the directory to the
expoerted folder you specified at step 1.

Type hdwbld 0BDB. hdw, where QBDB is the name of the file you
edited. The non-redundant channel should now exist of the server.



Chapter 3 - Building controllers or channels

7. After successfully building the channel, return to the QUIck
Builder project, select the channel and upload the non-redundant
channel details from the server.

About scanning

Scanning is the process by which the server reads point parameter
values from controllers.

To minimize the load on the system, it is important to plan for and
implement an efficient scanning strategy, and to use the appropriate
scanning methods. This section describes the various scanning
methods.

Periodic scanning

Periodic scanning involves reading parameter values at specified time
intervals.

With periodic scanning, you select the appropriate scan period,
ranging from seconds to minutes, for each input/output parameter.
For example, if you assign a scan period of 15 seconds to the PV, the
server scans the value in the controller every 15 seconds.

When choosing a scan period, consider the following factors:

m Whether the controller automatically reports changes of state. If
so, periodic scanning might not be necessary.

m The rate of change of the value. If a value only changes once an
hour, it is inefficient to scan that value every five seconds.

m The rate at which you need to collect history for the point (in the
case of the PV parameter). A point requiring one minute snapshots
needs a scan period greater than 60 seconds.

m How quickly field changes need to appear in Station displays.
Dynamic values on a display are updated from the database at the
configured update rate of the Station.

m The number of values that can be scanned from a controller at a
particular scan rate. For example, it is unlikely that 2,000 analog
values could be scanned from a controller connected to server via
a serial line operating at 1200 baud.

m Whether periodic scanning is available—some controllers do not
respond to scanning polls and rely on reporting by exception.
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You may have to experiment to arrive at optimum scanning periods.
For details about using the lisscn utility to analyze analyzing scanning
performance, see the Server and Client Configuration Guide.

Exception scanning

Exception scanning is only available if the controller supports
reporting of significant events. They are set up and configured to
report by exception (initiate the communication).

Significant events can be caused by events such as:

m Changes in a status point
m Significant changes in an analog point
m Analog alarms

For more information about configuring exception scanning, see the
appropriate Controller Reference.

Demand scanning

Demand scanning is a ‘'one-shot' scan of a point parameter in
response to a request. Two main types of demand scanning are used:

m Scan point special

m Control confirmation

Scan point special

A demand scan of point parameters is referred to as a scan point
special. A scan point special is performed whenever scanning of a
point is disabled and then re-enabled (for example using the Point
Detail display). Application programs and free format reports can
cause a scan point special demand scan of a point. For details, see the
Application Development Guide.

Control confirmation

A control confirmation demand scan is issued on the source address
(if configured) after an OP, SP, MD, or an auxiliary parameter control
is issued. This is to confirm that the control took place correctly. If the
scanned value does not match the controlled value (within the
deviation deadband), a control fail alarm may be generated.
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Dynamic scanning

Dynamic scanning involves scanning point parameters in response to
a particular request, using a scan method that differs from its usual
scan method (if any). The particular request could be to:

m Scan a parameter that is not otherwise scanned, either as a '‘once-
off' read, or for as long as an operator views the parameter on the
display.

m Scan a parameter at an accelerated rate for as long as an operator
views the parameter on the display.

m Perform a once-off scan of all parameters on a controller
configured for dynamic scanning.

m Perform atime-limited (two-minute) scan of all parameters on a
controller configured for dynamic scanning, either at the
configured scan period (CSP) or at an accelerated rate.

See the topic titled "About dynamic scanning” in the Server and Client
Configuration Guide for more information.

About scan packets

A scan packet is the basic unit used by the server to acquire data from
a controller. A scan packet represents a single input/output
(transaction) with a controller—that is, one scan packet is used every
time the server sends a request for data to a controller.

A scan packet can access several addresses within a controller to
provide values for several points. Because the number of requests per
second is generally a limiting factor, the scanning strategy should
attempt to obtain the maximum number of point values in the
minimum number of scan packets.

The basic requirements for including points in the same scan packet
are:

m The points have the same scan period.
m The point source addresses reference the same controller.

m The number of values acquired does not exceed the scan packet
size for the particular controller.

m Some controllers require that the addresses to be scanned are
contiguous.

Whenever you change the point configuration, the server re-builds the
scan packets in order to re-optimize scanning. For example, the
server ensures that:
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m [f there are multiple references to an address at the same scan
rate, there is only one entry in the scan packet.

m [f there are multiple references to an address at different scan
rates, a single entry is made at the fastest rate.

A separate scan packet is created for database addresses. Database
addresses are used to scan information from other point parameters,
or from files in the server database.

It is strongly recommended that you follow the instructions for
optimizing scan packets—and hence maximizing scanning
performance—included in the help for the specific controller.

Building Controller Integration Mappings

About Controller Integration Mappings

Controller Integration Mappings are XML files each of which define
the SCADA point(s) that will be built for a type of program element in
any given controller for which integration with the Experion Server is
available.

A program element is a part of the controller program, for example; a
variable, a tag, a function block or the program.

Controller Integration is available for the following controllers:

m Honeywell ControlEdge PLC
= Honeywell RTU2020
m Allen-Bradley ControlLogix

Controller Integration Mappings are supplied with Experion for these
controllers. Due to the higher level of integration available for the
Honeywell RTU2020 and Honeywell ControlEdge PLC, the associated
Integration Mappings will not normally require any editing. However,
since users of the Allen-Bradley ControlLogix may use User Defined
Types that cannot be predicted, it is possible to edit existing, and
create new, Integration Mappings for any supported controller type.

Existing Integration Mappings can be edited from Configuration
Studio enabling the user to make changes as required.

An Integration Mapping is composed of four components:
m Header: Provides identification of this Integration Mapping.

m Matches: Defines the program element(s) that will be searched for
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and the rule against which each will be matched. When any one of
these matches is made the point(s) specified in the Points
component below will be created.

m Parameters: Provide a way of defining configurable properties or
constants used in the point definitions that are not derived from
the program elements in the controller. These may vary between
controllers or customer sites.

m Points: Defines the point(s) that will be created or updated when
this Integration Mapping is matched against a program element.

Header
The Integration Mapping header’s properties are:

m Name: Unique name for this Integration Mapping.
m Version: Version of this Integration Mapping (read only).

m Integration: Controller type for which this Integration Mapping
applies.

m Description: Description of this Integration Mapping.

Matches

Defines the program element(s) that will be searched for and the rule
against which each will be matched. When any one of these matches
is made a point, or points, will be created using the definitions in the
Points section below.

Parameters

Defines parameters that are used within the Points section below.
Each parameter can have a value defined per controller or across the
whole SCADA point database. Alternatively the user is able to enter a
value during the point creation in Quick Builder. See the “Automated
Point Generation for an Integrated Controller” section in this guide.
The following table shows some example mapping parameters:
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Table 3-1: Example Mapping Parameters

Default

Name Type | Label Value
Fast Scan Int2 | Scan period to be used for PV, SP, OP & MD. 1
Period
Slow Scan Int2 | Scan period to be used for Al, A2, A3 & A4. 60
Period
Point Name | char | Prefix to be applied to the program element name PPPP
Prefix when creating the point name.

Points

Defines the points that will be created or updated when a match is
made in the Matches section above. It is anticipated that most
matches would only require a single point to be created, but it is
possible to create multiple points if required for more complex
program elements.

When a point is selected its Property Details are displayed.

The properties listed are some, or all, of those properties available in
Quick Builder for the specific point type; analog, status, or
accumulator.

Each property has a value listed or an expression that will be used to
provide that property’s value when a point is created, for example:

Table 3-2: Example Point Property Detail Expressions

Property ‘ Expression ‘ Result
Name PropertyDetailName | Name of this set of property details
Class AnalogPoint An analog point will be created
StatusPoint A status point will be created
AccumulatorPoint An accumulator point will be created
[temName [%TagPrefix%]_ The point created will have an Item Name
[%#Property with the format PPPP_NNNNNNNN
(Name)%]
where:
PPPP = Tag Prefix (from Parameters section

sS4
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Property ‘ Expression ‘ Result

above)

NNNNNNNN = Name of matched element in
the controller program

ScanPeriodPV | [%ScanPeriodFast%)] | The point created will have a PV scan period
with a value defined by ScanPeriodFast in
Parameters above (1 sec in this example).

Importing Integration Mappings

Although a standard set of Integration Mappings is supplied with
Experion they are not imported into Quick Builder by default. Any
Integration Mapping required for point generation must be imported
into Quick Builder before it can be used.

To import an Integration Mapping into Quick Builder

1. From the Quick Builder menu, choose File > Import....
The Select File to Import dialog appears.

2. From the Files of Type list, select Controller Integration Mapping XML
(*.cimxml).
Locate and select the Integration Mappings you want to import.

4, Click Open.
The selected Integration Mappings are imported into Quick
Builder. If an Integration Mapping with the same name already
exists it will be overwritten.

w

The imported Integration Mapping can now be viewed in Quick
Builder under Controller Integration > Mappings. For more information
see the “Automated Point Generation for an Integrated Controller”
section of this guide.

Exporting Integration Mappings

Although a standard set of Integration Mappings is supplied with
Experion it might be required to export an Integration Mapping so
that, for example, it can be used as the basis for a new Integration
Mapping, or imported into another system’s database.
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To export an Integration Mapping from Quick Builder

1.
. Select the Integration Mapping(s) you wish to export

In Quick Builder navigate to Controller Integration>Mappings

From the Quick Builder menubar, click File > Export....
The Export dialog appears.

Under File Details

a. Browse to the folder to where you wish to export.the Integration
Mapping(s)

b. Set the Base Name for File(s): to an appropriate base name

c. Ensure the Export File Type: is set to Controller Integration
Mapping XML

Under Scope select to export all the Integration Mappings or only

those selected in step 2

Check the Summary details to verify what you are about to export

Click OK

The selected Integration Mapping(s) is(are) exported to the

location defined in step 4a with a file name basename.cim.xml.

You can now browse to these Integration Mapping in Windows

Explorer and rename them as required.

Renaming the file does not rename the Integration Mapping.

If this file is to be used as the basis for a new Integration Mapping

then its Name must be changed appropriately in the Integration
Mapping’s Header details.

Creating and Modifying Integration Mappings

A standard set of Integration Mappings is supplied with Experion
however, if the controller program contains a tag or variable name in
that is not matched in any of these Integration Mappings, then a new
Integration Mapping is required. It is recommended that an existing
Integration Mapping be copied, renamed and then modified to suit
this requirement. It is not recommended to attempt to create a new
Integration Mapping from an empty file.

To open an existing Integration Mapping

1.

From Configuration Explorer in Configuration Studio, under
Control Strategy > Controller Integration Mapping, click Build Controller
Integration Mapping.

Controller Integration Mapping Builder opens.
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From the menubar or toolbar open the required Integration
Mapping; file format is *.cim.xml

The selected Integration Mapping will open and its file name will
be displayed at the head of the Navigation pane.

To edit an existing Integration Mapping

1.

Select the Integration Mapping header and enter an appropriate
new Name and Description.

It is this Name that identifies the new Integration Mapping in Quick
Builder, not the file name.

Select Matches and add or delete program elements as required
and set the Rule for any new ones.

Select Parameters and add or delete Parameters as required and
set the data Type and Default Value (if required) for any new ones.

Select Points and delete properties whose values are not required
to be enforced when the point generation is run. Expressions may
be edited if required.

Properties cannot be added to existing point definitions. The
recommended method of doing this follows.

To add properties to existing point definitions

F N PR

Open Quick Builder.
Open a point of the required type; analog, status or accumulator.
From the menubar select Edit > Copy to copy the point.

Return to Controller Integration Mapping Builder, Points view, and
paste the point from the toolbar.

Delete unwanted properties and edit property expressions as
required.

To save an edited mapping

1.

From the menubar select File > Save As...

The Save As dialog will open

Browse to the required path. Honeywell suggests using
C:\ProgramData\Honeywell\Experion

PKS\Server\data\Controllerintegration if you are on the primary
server, or \\PrimaryServerName\Controllerintegration if you are on
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another node. This mapping will then be available for importing
into Quick Builder at any Experion node.

3. Enter a new file name

Using the original file name, or using File > Save, will overwrite the
original Integration Mapping file.

4. Click Save.
The new Integrated Mapping file with edits will be saved.
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Supported Controller Integration Mapping syntax

This topic lists and describes the syntax of expressions that are supported within Experion Controller Integration

Mappings.

Supported Controller Integration Mapping syntax

Example

Syntax

[%%ParameterName®%bo] [%%Fast Scan Period%o]

Uses the value of the parameter named
“Fast Scan Period”

Retrieving a
property
from a
program,
function
block, or
tag/variable

[%#Property(property_
name)%o]

[%#Property(property_name)%o]

See table below for valid property_name

See table below for examples of valid
entries for property_name.

Retrieving
the property
of a member
of a
structured
tag/variable

[Y%#MemberProperty(member_name,property_
name)%bo]

See table below for valid property_name

Behaves like #Property, except rather
than retrieving the property of the
matched structured variable it retrieves
the variable indicated by member_
nameand gets the property from that
member variable based on property_
name.

Retrieving
the property
of a pin on

[%#ConnectedProperty
(OP, FullAddress)%o]

[%# ConnectedProperty(pin_name_
syntax,property_name)%o]

Searches for the pin identified by pin_
name_syntax on the matched block.

Honeywell
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Description ‘ Syntax

function
block

(RTU2020
and
ControlEdge
PLC only)

where pin_name_syntax is the name of the pin

on the function block whose value is
required. If there are IN and OUT pins with
the same name, the pin_name_syntax is pin_
namelin] or pin_name[out] depending on

which pin the mapping is required to match.

See table below for valid property_name

‘ Example

‘ Result

If the pin is connected to a local/global
variable this query searches for the
variable connected to the pin of a
function identified by pin_name_syntax.
The value of property_name is then
retrieved for this variable.

If the pin is connected to a different
block from the matched block, do not
use #ConnectedProperty, instead use
#BlockProperty or #10Property.

If the pin is connected to a numerical or
string expression, e.g. 1.0, then the only
property supported is “Value” and the
value of the pin would be returned.

ControlEdge PLC only: If the pin is
connected to a numerical or string, or is
unconnected, the "FullAddress" property
can also be used.

Retrieving
the property
of a pinon an
adjacent
function
block;

where
“adjacent”
means “in the
same

[%#BlockProperty(adjacent_block_name,pin_

name_syntax,property_name)%o]

See table below for valid property_name

Searches for the function block named
adjacent_block_name which is adjacent to
the matched block. Then searches for
the variable connected to the pin
identified by pin_name_syntax on the
adjacent block. The value of property_
name is then retrieved for this variable.

If the pin is connected to a numerical or
string expression, e.g. 1.0, then the only
property supported is “Value” and the

Honeywell
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Description Syntax Example Result

worksheet”. value of the pin would be returned.

ControlEdge PLC only: If the pin is
connected to a numerical or string, or is

(RTU2020 unconnected, the "FullAddress" property
and can also be used.
ControlEdge
PLC only)
Retrieving 10 | [%#|0Property(adjacent_block_name,pin_ Retrieves the io_property_name of an |10
Channel name_syntax,io_property_name)%o] Variable connected to the pin_name_
property for a syntax pin on an adjacent function
connected block.
in .
P See table below for valid io_property_name The allowable types of |0 variables are:
. ANALOG_INPUT_TYPE
(RTU2020
and . ANALOG_OUTPUT_TYPE
ControlEdge . DIGITAL_INPUT_TYPE
PLC only)
. DIGITAL_OUTPUT_TYPE
. PULSE_INPUT_TYPE
These |0 variables must be bound to an
IO Channel for #10Property to function.
ControlLogix | [Y%#ClgxPrefix(0%] [%# ClgxPrefix(0%] Returns Name Name:Name: where
Prefix

Name =the name of the controller.

(ControlLogix
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Description ‘ Syntax ‘ Example ‘ Result
only)
[%# ClgxPrefix()%o]: Returns the address of the PV of the
[%#Property matched item (FC1001) in the format
(FullAddress)%].PV.VALUE | Controller Location, where
Controller = Name
Location =
Name:Name:PID:FIC1001.PV.VALUE
Retrieving [%#Controller(property_name)%bo] [%#Controller(property_ See table below for examples of valid
Controller name)%o] entries for property_name.
properties
from Quick See table below for valid property_name
Builder
Honeywell
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Valid Properties

Property_ AUl Example of use Description

Name controller

Name ControlLogix | [%#Property(Name)%o] Retrieves the name of the program
RTU2020 [Y%o#Property(Name)%o] Retrieves the name of the task running the program
ControlEdge | [%#Property(Name)%o] Retrieves the name of the task running the program
PLC

Description ControlLogix | [%#Property Retrieves the description of the program

(Description)%o]

RTU2020

n/a

ControlEdge
PLC

n/a

Honeywell
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Applicable
controller

Example of use Description

94

Property

Function Block

Name

ControlLogix n/a

Honeywell
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Applicable
controller

RTU2020

Example of use

[%#Property(Name)%o]

Description

Retrieves the name of the matched function block
variable

ControlEdge
PLC

[%#Property(Name)%o]

Retrieves the name of the matched function block
variable

Description

ControlLogix

n/a

RTU2020

[Y%#Property
(Description)%o]

Retrieves the description of the matched function
block variable

ControlEdge
PLC

[Y%#Property
(Description)%o]

Retrieves the description of the matched function
block variable

TypeName ControlLogix n/a
RTU2020 [Y%#Property Retrieves the matched function block’s type
(TypeName)%]
ControlEdge | [%#Property Retrieves the matched function block’s type
PLC (TypeName)%o]
FullAddress RTU2020 [Y%#Property Retrieves the full address of the matched function

(FullAddress)%o]

block

ControlEdge
PLC

[Y%#Property
(FullAddress)%o]

Retrieves the full address of the matched function
block

Honeywell

95



96

Chapter 3 - Building controllers or channels

I?’(:;J;th;f El;?ﬁ;rty_ ﬁss’tlrijlz lre Example of use Description

Units ControlLogix n/a
RTU2020 n/a
ControlEdge | [%#Property(Units)%o] Retrieves the Engineering Unit of matched variable
PLC

Max ControlLogix n/a
RTU2020 n/a
ControlEdge | [%#Property(Max)%] Retrieves the Maximum range value of matched
PLC variable

Min ControlLogix n/a
RTU2020 n/a
ControlEdge | [%#Property(Min)%] Retrieves the Minimum range value of matched
PLC variable

Honeywell
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Applicable
controller

Example of use

Description

Tag/Variable Name
(either

structured or

basic)

All types

[%#Property(Name)%o]

Retrieves the name of the matched tag/variable

Honeywell
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Property_
Name

Applicable
controller

Example of use

Description

98

Property

Description All types [%#Property Retrieves the description of the matched tag/variable
(Description)%o]
Value ControlLogix | [Y%#MemberProperty Retrieves the value of PV Low alarm limit
(PVL,Value)%bo]
RTU2020 n/a
ControlEdge n/a
PLC
FullAddress ControlLogix | [%#Property Retrieves the OPC path to the tag; requires
(FullAddress)%] [%# ClgxPrefixQO%]I[%#Property(DataType)%b] as a
prefix.
RTU2020 [%#BlockProperty Retrieves the address of the Analog Input connected
(HWDACA_ to the HWDACA_1 block adjacent to the matched
1,Al,FullAddress)%o] variable
ControlEdge | [%#BlockProperty Retrieves the address of the Analog Input connected
PLC (HWDACA_ to the HWDACA_1 block adjacent to the matched
1,Al,FullAddress)%bo] variable.
If it is not connected or connected to constant value,
then FullAddress will return the address of the
function block pin itself.
DataType All types [“%#Property Retrieves the data type of tag/variable
(DataType)%]
NumElements | Alltypes [%#Property Retrieves the number of elements in array
(NumElements)%bo] tag/variable

Honeywell
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Applicable
controller

Example of use

Description

ControlLogix | [%#Property(Units)%o]

Retrieves the Engineering Unit of matched tag

ATTENTION: This applies to basic tags,
multidimensional arrays of basic tags, and
structured types containing basic or structured
type tags.

RTU2020

n/a

ControlEdge | [Y%#Property(Units)%o]
PLC

Retrieves the Engineering Unit of matched variable

ControlLogix | [%#Property(Max)%bo]

Retrieves the Maximum range value of matched tag

ATTENTION: This applies to basic tags,
multidimensional arrays of basic tags, and
structured types containing basic or structured
type tags.

RTU2020

n/a

ControlEdge | [%#Property(Max)%bo]
PLC

Retrieves the Maximum range value of matched
variable

Source of Property_
Property Name
Units
Max
Min

ControlLogix | [%#Property(Min)%bo]

Retrieves the Minimum range value of matched tag

ATTENTION: This applies to basic tags,
multidimensional arrays of basic tags, and
structured types containing basic or structured

Honeywell

99



Chapter 3 - Building controllers or channels

Source of Property_ Applicable

Example of use Description

Property Name controller

type tags.
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Source of Property_ Applicable .
U Name controller Example of use Description
RTU2020 n/a
ControlEdge | [%#Property(Min)%o] Retrieves the Minimum range value of matched
PLC variable
StateODesc ControlLogix | [%#Property Retrieves the descriptor for state O of the matched
(StateODesc)%] tag
ATTENTION: This applies to basic tags,
multidimensional arrays of basic tags, and
structured types containing basic or structured
type tags.
RTU2020 n/a
ControlEdge | [%#Property Retrieves the descriptor for state O of the matched
PLC (StateODesc)%] variable
StatelDesc ControlLogix | [%#Property Retrieves the descriptor for state 1of the matched tag
(StatelDesc)%]
ATTENTION: This applies to basic tags,
multidimensional arrays of basic tags, and
structured types containing basic or structured
type tags.
RTU2020 n/a
ControlEdge | [%#Property Retrieves the descriptor for state 1of the matched
PLC (StatelDesc)%] variable
Controller Name All types [%# Controller(Name)%] | Retrieves the name of the controller from the Quick

Honeywell
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Applicable
controller

Example of use

Description

Property

Builder database

Description All types [%#Controller Retrieves the description of the controller from the
(Description)%o] Quick Builder database

Asset All types [%# Controller(Asset)%] | Retrieves the assetof the controller from the Quick

Builder database

Channel All types [%#Controller Retrieves the channel name of the controller from the
(Channel)%] Quick Builder database

Number All types [%# Controller Retrieves the controller number of the controller
(Number)%b] from the Quick Builder database

10 Channel EUHigh All types [%#10Property(adjacent_ | Retrieves the High value of the range in Eng Units
block_name,pin_name_
syntax,EUHigh)%o]
(RTU2020 only) EULow All types [%#10Property(adjacent_ | Retrieves the Low value of the range in Eng Units

block_name,pin_name_
syntax,EULow)%]

EUDesc All types [%#10Property(adjacent_ | Retrieves the Eng Units descriptor
block_name,pin_name_
syntax,EUDesc)%]

StateODesc All types [%#|0Property(adjacent_ | Retrieves the descriptor for state O
block_name,pin_name_
syntax,StateODesc)%o]

StatelDesc All types [%#10Property(adjacent_ | Retrieves the descriptor for state 1

block_name,pin_name_
syntax,State1Desc)%o]

102
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Example RTU2020 Integration Mapping

This topic provides the details of an example RTU2020 Mapping together with its source ControlEdge Builder
function block view.

Figure 3-1: ControlEdge Builder Function Block View
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Example Mapping Details

Mapping Components Item Data
Header Name: RTU_HWPID
Integration: RTU2020
Description: Honeywell PID Function Block
Matches Program Element: Function Block
Rule: HWPID
Parameters Point Name Prefix blank
see item (1) in table below
Fast Scan Period 0
(RTU2020 uses DNP3 class based scanning)
see item (5) in table below
Slow Scan Period 0
(RTU2020 uses DNP3 class based scanning)
see item (6) in table below
Points See table below for Property Details
104 Honeywell
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Example Point Property Details

Item | Quick Builder Parameter

Mapping Expression

Result

1 ltemName

[%Point Name Prefix%][%#Property(Name)%bo]

HWPID_1

2 SourceAddressPV

[%# Controller(Name)%o] [%#BlockProperty(HWDACA_
1,Al,FullAddress)%].PV

Address of analog input for PV

RangeHigh [%#|0Property(HWDACA_1,Al,LEUHigh)%o] High Range value of analog input
channel
Unit: [%#|0Property(HWDACA_1,Al,EUDesc)%] Eng Units description from analog

input channel

3 Source/DestinationAddressSP

[%# Controller(Name)%] [%#ConnectedProperty
(SP,FullAddress)%o]

Address of SP

4 Source/DestinationAddressAl

[%# Controller(Name)%o] [%#ConnectedProperty
(K,FullAddress)%o]

Address of K factor (proportional
gain)

5 ScanPeriodPV

[%%Fast Scan Period%o]

Scan period based on DNP3 class
based scanning

6 ScanPeriodSP

[%%Slow Scan Period%o]

Scan period based on DNP3 class
based scanning

Honeywell
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CHAPTER

4 BUILDING SERVERS

This section outlines how to use Quick Builder to build and configure
servers.

In this section:

Creating @ SEIVEI .. ... . 107
Main properties for a SeIVer ... .o 107
Sizing limits for the server ... ... 108
Upload and download paths fora server ..............ooiieeeio .. 108
Server specific OPtIONS .. 108
History options for a server ... .. 110
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Creating a server

To create a server

1. Use one of the following options to create a new server:

Option ‘ Result

From the Servers section The new server appears in the List
within the Library, drag View, and the properties tabs enable
and drop the Server item | you to complete the configuration
into the List View. of the new server.

Click E The Add Item(s) dialog box appears.

1. From the Item Family list,
select the applicable family.

2. From the Item Type list, select
Server.
3. In the Name text box, type in

the name for this server, or
you can accept the default
provided.

4, Click OK to add the server to
the list.

2. Use the properties tabs to configure the server.

Main properties for a server

The Main tab defines basic server details, including the server name.

Property ‘ Description

Name The server's unique name. 30 alphanumeric characters
maximum.

Server Type The version of Experion that runs on this server.

Description A brief description of the server.

Item type Shows the server type.
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Property Description

Last Modified Shows the date on which this project was last modified.

Sizing limits for the server

The Sizing tab shows the size limits for each type of item. The figures
in the Limit column are determined by your license, and the figures in
the Maximum column are basic Experion limits.

ATTENTION: As the server sizing limits displayed on this

property page are not read directly from the server, they may
not be accurate.

Upload and download paths for a server

The Server Details tab defines the upload and download paths for each

server.
Property ‘ Description
Server Name The server's computer (TCP/IP) name.
If you are running Quick Builder on the server, set the
name to LocalHost.
Upload Path The folder Quick Builder uses when uploading details
into this project.
Download Path The folder Quick Builder uses when downloading

details from this project.

Project last downloaded on | The date on which this project was last downloaded to

the server.
Last project upload from The date on which this project was last uploaded from
server on the server.

Server specific options

The Server Specific Options tab defines options specific to this server.
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Property

Enforce naming
rules for points,
parameters and
areas

‘ Description

If selected (the default), Quick Builder enforces the naming
rules. For more information about naming rules, see the
Server and Client Configuration Guide.

Allow Point Names
to contain only
numeric characters

Note: This option is primarily designed to allow you to define
new points on legacy systems.

Allows you to define non-standard point IDs that contain only
numbers. (Standard point names must contain at least one
letter.)

Note that points with numeric IDs cannot be used with
algorithms.

Allow Point Names
to contain full stops

Note: This option is primarily designed to allow you to define
new points on legacy systems.

Allows you to define non-standard point IDs that contain
periods (full stops). (Standard point cannot contain any
periods.)

Note that point IDs containing periods cannot be used for
container points, or in a DSA system.

Use Electronic
Signatures

If selected, the server will request one (or two) electronic
signatures before executing control on a point.

If you configure points for electronic signature, you are
requested for a password when downloading a project to (or
uploading from) the server.

Enabling this option adds the Signature tab for any newly
created point where you can configure the electronic
signature properties for that point.

Never download
initial UDP value to
the server

Specifies the default download setting of initial values on
user-defined parameters.

If selected, selects the Never download initial value to the server
check box on the point’s User Defined tab for all newly created
user-defined parameters.

For use with topologies where a user-defined parameter is
linked with a process value in a third party system.
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Property ‘ Description

Enable audit log If selected, all changes made to a Quick Builder project on
this server are captured including details of the user who
made the change.

Server Logger is used to store the log files, and Honeywell
Log Viewer (HLV) can be used to view the log files.

You can access the log files through a shortcut in the Start
menu.

Note the following rules for the audit log:
. The maximum size for a single log file is 8MB
. The maximum number of log files is 100

. After the maximum storage is reached (800MB), the log
files will be overwritten

History options for a server

The History Options tab displays the history collection rates and offset

groups that have been configured on the server and uploaded to
Quick Builder.
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CHAPTER

5 BUILDING A FLEX STATION

This topic outlines how to use Quick Builder to build a Flex Station.

In this section:

About Station tYPES ..o 113
About secUrity types ...l 113
Creating a Flex Station ... 114
Main properties for a rotary Station ... ... 114
Main properties for a static Station ... ... 115
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About Station types

Experion supports the following Station types, each of which is
connected to the server in a particular manner.

Type ‘ Description

Rotary
Station

Connects the Station to the server via a LAN but without the need for a

dedicated connection. This type of connection is recommended for Stations
used by management or others who do not use the Station full-time. (If a

rotary Station is not used for the idle timeout period, the connection is
made free so that it can be used by another rotary Station.)

Static
Station

Connects the Station to the server via a LAN with a dedicated (permanent)

connection. This is the recommended Station type for operators.

About security types

There are two types of security: operator-based security and Station-
based security. During initial system planning, you must select the
security type appropriate to your needs.

If you use operator-based security, each user is assigned an ID and
password (as well as an appropriate security level). Each user must
log on to Station before being able to use it.

If you use Station-based security, there are no user IDs, only security
levels. When users start Station, they are immediately assigned to the
OPER level. If required, they can change to a higher security level.
Users will need to know the password for that level on that Station.

See the Server and Client Configuration Guide for a detailed
description of security types.
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Creating a Flex Station

To create a Flex Station

1. Use one of the following options to create a new flex station:

Option ‘ Result
From the Stations section | The new station appears in the List
within the Library, drag View, and the properties tabs enable
and drop the Station item | you to complete the configuration
into the List View. of the new station.
Click E The Add Item(s) dialog box appears.
1. From the Item Family list,
select the applicable family.
2. From the Item Type list, select
Stations.
3. In the Name box, type in the

name for this station, or you
can accept the default
provided.

4, Click OK to add the station to
the list.

2. Use the properties tabs to configure the station.

Main properties for a rotary Station

The Main tab defines the basic properties of a rotary Station.

Property ‘ Description

Name The Station's name.

Description A description of the Station.

Associated asset The asset that an operator must have access to in order

to see system alarms from this system interface. If you
leave the associated asset field empty, the system alarms
for this system interface will be seen by anyone who has
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Property

‘ Description

access to the system alarms for the server on which this
system interface is configured.

Operator-Based Security

Indicates that you have operator-based security.

Enable Card Image Callup

Not applicable to Experion.

Image Display Time

Not applicable to Experion.

Idle Page The name/number of the display that Station
automatically calls up if there has been no operator
activity for the idle timeout period.

Item Type Shows the Station type as Rotary.

Last Modified

Shows the date/time on which the Station details were
last modified.

ltem Number

The unique item number assigned by Quick Builder. You
can change this if you need to match an existing
configuration (if you are uploading a database for
example).

Last Downloaded

Shows the date on which the item was last downloaded
to the server.

Main properties for a static Station

The Main tab defines the basic properties of a static Station.

Property ‘ Description
Name The Station's name.
Description A description of the Station.

Associated asset

The asset that an operator must have access to in order
to see system alarms from this system interface. If you
leave the associated asset field empty, the system alarms
for this system interface will be seen by anyone who has
access to the system alarms for the server on which this
system interface is configured.

Update Rate

The rate, in seconds, at which dynamic values from
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Property ‘ Description

controllers and other devices are updated in the server
database.

Care should be taken when setting this rate to ensure
that you are not placing an unnecessary load on your
controllers.

To enable operators to temporarily increase this
standard update rate, you can configure a function key
to act as a Fast Update key. This key works like the Fast
Update key on an IKB/OEP keyboard. When operators
press the Fast Update key, the server obtains updates
from controllers at the fast update rate described below
(instead of the rate specified here) until a new display is
called up.

Note that:

. This update rate does not apply to rotary Stations.
You configure update rates for rotary Stations on
the Connection tab of the Connection Properties
dialog box in Station.

o Custom displays and individual parameter values
on custom displays can be configured to update at
a different rate to the rate specified here.

Fast Update Rate The rate, in seconds, at which dynamic values available
from the server are updated on Station displays.

Note that:

. This update rate does not apply to rotary Stations.
You configure update rates for rotary Stations on
the Connection tab of the Connection Properties
dialog box in Station.

o Custom displays and individual parameter values
on custom displays can be configured to update at
a different rate to the rate specified here.

Operator-Based Security Indicates that you want operator-based security.

Enable Card Image Callup | Not applicable to Experion.
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Property

Image Display Time

‘ Description

Not applicable to Experion.

Idle Page The name/number of the display that Station
automatically calls up if there has been no operator
activity for the idle timeout period.

Item Type Shows the Station type as Static.

Last Modified

The date/time on which the Station details were last
modified.

Item Number

The unique item number assigned by Quick Builder. You
can change this if you need to match an existing
configuration (if you are uploading a database for
example).

Last Downloaded

The date on which the item was last downloaded to the
server.




CHAPTER

6 BUILDING AND CONFIGURING POINTS

You can use Quick Builder to create the following types of points:
m Accumulator
= Analog
m Container
s OPC Advanced
m Status

This section describes how to create and configure each type of point.

Tabs

The following table lists the Quick Builder tabs, and associated
configuration tasks, for each point type.

Point type Tab Go to
Accumulator | Main "Main properties for an accumulator point" on
page 122
Display "Display-related properties” on page 155
Alarms "Alarm properties for an accumulator point" on
page 124
History "History collection properties” on page 156
Scripts "Creating or editing scripts" on page 161
User Defined "Configuring user-defined parameters" on
page 163
PV Algo "Configuring algorithm parameters” on
page 155
Action Algo "Configuring algorithm parameters" on
page 155
Analog Main "Main properties for an analog point" on
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Point type Tab Go to
page 126
Display "Display-related properties" on page 155
Alarms "Alarm properties for an analog point" on
page 128
Control "Control properties for an analog point" on
page 131
Auxiliary "Auxiliary properties for an analog point" on
page 133
History "History collection properties" on page 156
Scripts "Creating or editing scripts" on page 161
User Defined "Configuring user-defined parameters" on
page 163
Non Scanned "Subscribing to non-scanned parameters” on
Parameters page 159
PV Algo "Configuring algorithm parameters” on
page 155
Action Algo "Configuring algorithm parameters” on
page 155
Container Main "Container points" on page 135
Contained Points "Main properties for a container point" on
page 137
OPC Main "Main properties for an OPC advanced point"
advanced on page 140
Display "Display-related properties" on page 155
Scripts "Creating or editing scripts" on page 161

User Defined

"Configuring user-defined parameters" on
page 163

OPC Parameters

"OPC parameters for an OPC advanced point"
on page 145
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Point type Tab Go to
History "History collection properties" on page 156
Status Main "Main properties for a status point" on
page 146
Display "Display-related properties" on page 155
Alarms "Alarm properties for a status point" on
page 148
Control "Control properties for a status point" on
page 150
History "History collection properties" on page 156
Scripts "Creating or editing scripts" on page 161
User Defined "Configuring user-defined parameters" on
page 163
Non Scanned "Subscribing to non-scanned parameters” on
Parameters page 159
PV Algo "Configuring algorithm parameters" on
page 155
Action Algo "Configuring algorithm parameters” on
page 155
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Building points

1. Use one of the following options to create a new point:

Option ‘ Result

within the
Library, drag
and drop
the relevant
Point item
into the List
View.

From the The new point appears in the List View, and the
Points properties tabs enable you to complete the
section configuration of the new point.

1.

5.

Click E The Add Item(s) dialog box appears.

In the Number of items to Add text box, type
the number of points you want to add.

From the Item Family list, select the
applicable family.

From the Item Type list, select Point.

In the Name text box, type in the name for
this point, or you can accept the default
provided. If you have chosen to create
multiple points, the Multi — Items section is
enabled, and you can provide a prefix for all
the points, or you can accept the default
provided. You can also indicate whether to
use a sequential number or letter to
differentiate between the points.

Click OK to add the point(s) to the list..

2. Use the properties tabs to configure each point by first
highlighting it in the List View.

Assigning points to an asset

1. From the main Quick Builder, click on the Asset view filter option
to display the assets that have been downloaded from the server.
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2. Click the asset to which you want to assign the point.

Any items already assigned to this asset are displayed in the List
View.

w

From the Library, click the Points category to list the point types.

4. Select the item for the type of point you want to create. Drag and
drop the item into the List View.
The new point appears in the List View and you can use the
Properties tab to complete the configuration of the new point.

The point is automatically assigned to the asset.

Accumulator points

An accumulator point is a standard point type with a fixed data
structure that represents total values. For example, an accumulator
point can represent the volume of water that has flowed into a tank or
through a turbine.

This section contains the configuration information that is specific to
accumulator points. Other tabs also appear in the properties pane for
the accumulator point, but are generic to all points. They are:

m Display tab

History tab
Scripts tab

m User Defined tab
m PV Algo tab

m Action Algo tab

See the related topics for links to more information about each of
these tabs.

Main properties for an accumulator point

The Main tab defines the point's basic properties.

Property Description

Point ID The point's name.

See the topic "Naming rules for points" in the chapter on
"Points" in the Server and Client Configuration Guide.
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Property

Enterprise Name

‘ Description

An intuitive name given to a point, which can be used as an
alternative to the point ID. It must be unique amongst entities
with the same parent asset. The enterprise name property is
also referred to as the Use Name on the initial Add Items
screen.

Description

A description of the point that helps identify it. The description
often appears in Station displays. 132 characters maximum,
including spaces.

Parent Asset

The asset to which the point belongs.
Click =l to select from a list of assets.

A parent controller can also be configured to enable alarms
raised on the point to appear in the System Status display
instead of the Alarm Summary. Instead of selecting an asset
from the list, enter $CONTROLLER followed by the last four digits
of the controller's item number. For example, for controller
RTUOO0018 you would enter $CONTROLLEROO18. Note that this is
only possible for status points, accumulator points, and analog
points.

PV Source Address

The controller name/address where the PV is stored.

Either type the full address, or click -l to specify the address
using Address Builder.

PV Scan Period

The interval, in seconds, at which the server scans the controller
for the parameter value. Select O (the default) if you do not want
scanning.

Dynamic Scanning

When selected, dynamic scanning is enabled for the PV
parameter. The default setting for this check box is selected.

Engineering Units

The engineering unit that the PV value represents.

100% Range
Value

The highest register value for the PV.

If you have scaled the PV by specifying a data format, type in the
number that represents the highest register value.

If you haven't used a data format, use the default value, 100%.

Rollover Value

Should be set to the maximum value attained by the 'physical’
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Property ‘ Description

counting or totalizing mechanism. The default is 4095.

Scale Factor The value used to convert the counts to engineering units. The
default, 1, means that a one-to-one ratio exists between the
counts and the engineering units. A value of 10 would mean
that one count equals 10 engineering units.

For example, if your engineering unit is ml/s and 1 count is
equivalent to 52.5 ml/s, then the scale factor is 52.5.

Meter Factor The meter factor is a multiplier used for calibration of the PV
value, using the following formula:

PV(new) = PV(old) + (scale factor x meter factor x raw counts)

The default value is 1.

PV Algo The PV algorithm associated with this point. If you select an
algorithm, the PV Algo tab appears.

The default is NONE.

Action Algo The action algorithm associated with this point. If you select an
algorithm, the Action Algo tab appears.

The default is NONE.

Scanning Enabled | Indicates that scanning is to be enabled as soon as you
download the point.

Item Type Shows the point type.

Last Modified Shows the date of the most recent modification to this point's
property details.

Last Downloaded The date on which the item was last downloaded to the server.

Alarm properties for an accumulator point

The Alarms tab specifies the characteristics of up to four alarms that
an accumulator point can generate.

Property Description

Alarm Type The type of alarm:
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Property

‘ Description

o None. The default

. PVHigh. An alarm is generated when the PV reaches or
exceeds the value specified in Limit.

N PVHighHigh. Used in conjunction with a PVHigh alarm to
indicate a more serious alarm. The value specified in Limit
for the PVHighHigh alarm must be greater than that
specified for PVHigh alarm.

. RateOfChange. An alarm is generated if the rate of change of
the PV (in engineering units per second) exceeds the value
specified in Limit.

Priority
Sub Priority

These two properties specify the alarm's severity, and where it
appears in the list of alarms.

Priority can be: Urgent, High, Low and Journal (the default). All
alarms, except for Journal, appear in the Alarm Summary display.
If critical alarm support has been enabled, urgent priority alarms
with a sub priority of 15 will be shown as critical priority alarms
on the Alarm Summary and other displays. For information about
how to enable critical alarms, see “Customizing alarm colors” in
the Server and Client Configuration Guide. Journal alarms do not
appear in Station as alarms, but are written to the event file.

Sub-priority range from 15 (highest), to O (lowest and default).

Limit

The PV value, in engineering units, at which an alarm is generated.

On Delay
Off Delay

On Delay and an Off Delay values can be specified (in seconds) for
the following alarms:

. PVHigh
. PVHighHigh
. RateOfChange

Alarm Message
Index

The index number of the message associated with alarms for this
point.

For details about creating messages, see the Server and Client
Configuration Guide.

Disable Alarming

If selected, disables all alarms for this point.
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Property Description

Journal Only Handles all alarms for the point as journaled events; alarms do
not appear in the alarm summary.

Analog points

An analog point is a standard point type with a fixed data structure
that represents continuous values. For example, an analog point can
represent pressure in a boiler or temperature in a furnace.

This section contains the configuration information that is specific to
analog points. Other tabs also appear in the properties pane for the
analog point, but are generic to all points. They are:

m Display tab

m History tab

m Scripts tab

m User Defined tab

m Non Scanned parameters tab
m Action Algo tab

m PV Algo tab

See the related topics for links to more information about each of
these tabs.

Main properties for an analog point

The Main tab defines the point's basic properties.
Property ‘ Description

Point ID The point's name.

See the topic "Naming rules for points" in the chapter on
"Points" in the Server and Client Configuration Guide.

Enterprise Model An intuitive name given to a point, which can be used as an

Item Name alternative to the point ID. It must be unique amongst entities
with the same parent asset. The item name property is also
referred to as the Use Name on the initial Add Items screen.
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Property

Description

‘ Description

A description of the point that helps identify it. The description
often appears in Station displays. 132 characters maximum,
including spaces.

Parent Asset

The asset to which the point belongs.
Click =l to select from a list of assets.

A parent controller can also be configured to enable alarms
raised on the point to appear in the System Status display
instead of the Alarm Summary. Instead of selecting an asset
from the list, enter "$CONTROLLER" followed by the last four
digits of the controller's item number. For example, for
controller RTUOOOO18 you would enter "$CONTROLLEROO018."
Note that this is only possible for status, accumulator, and
analog points.

PV Source Address

The controller name/address where the PV is stored.

Either type the full address, or click -l to specify the address
using Address Builder.

If you select an OPC controller, the Non-Scanned Parameters
tab appears.

PV Dynamic
Scanning

When selected, dynamic scanning is enabled for the PV
parameter. The default setting for this check box is selected.

PV Scan Period

The interval, in seconds, at which the server scans the controller
for the parameter value. Select O (the default) if you do not want
scanning.

Engineering Units

The engineering unit that the PV value represents.

100% Range
Value

The highest register value for the PV.

If you have scaled the PV by specifying a data format, type in the
number that represents the highest register value.

If you haven't used a data format, use the default value, 100%.

0% Range Value

The lowest register value for the PV. If the parameter value has
been scaled by specifying a scaling data format, this value
equals 0% (the default) of the register range.

Drift Deadband

Specifies the percentage change in a parameter's value that is
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Property ‘ Description

significant enough to require processing.

Specifying a drift deadband helps reduce system load. The
default is 0.000%.

PV Algo The PV algorithm associated with this point. If you select an
algorithm, the PV Algo tab appears.

The default is NONE.

Action Algo The action algorithm associated with this point. If you select an
algorithm, the Act Algo tab appears.

The default is NONE.

Scanning Enabled | Indicates that scanning is to be enabled as soon as you
download the point.

Clamp PV If selected, the PV value is clamped to either 0% (low) or 100%
(high) if the value exceeds either low or high limits set for the
PV clamp.

The PV clamp high and low limits are defined in Station using
the Point Processing tab of the Alarm & Point Processing
display. See the Server and Client Configuration Guide.

Item Type Shows the point type.

Last Modified Shows the date of the most recent modification to this point's
property details.

Last Downloaded The date on which the item was last downloaded to the server.

Alarm properties for an analog point

The Alarms tab specifies the characteristics of up to eight alarms that
an analog point can generate.

During operation, only the highest priority alarm is displayed.
Consequently, if you define more than one alarm, you need to ensure
that the priority/sub priority you assign to each alarm reflects its
relative importance. For example, you should assign a higher priority
to a PVHighHigh alarm than to a PVHigh alarm. (If you want to assign
the same priority to alarms, the alarm that appears higher in the list
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Property

Alarm Type

takes precedence. For example, you should define the PVHighHigh
alarm above the PVHigh alarm.)

‘ Description

The type of alarm:

DeviationHigh. An alarm is generated when the PV
rises above the SP by more than the value specified
in Limit.

DeviationLow. An alarm is generated when the PV falls
below the SP by more than the value specified in
Limit. Note that the value must be negative, for
example -5.

None. The default

PVHigh. An alarm is generated when the PV reaches
or exceeds value specified in Limit.

PVHighHigh. Used in conjunction with a PVHigh alarm
to indicate a more serious alarm. The value specified
in Limit for the PVHighHigh alarm must be greater
than that specified for PVHigh alarm.

PVLow. An alarm is generated when the PV falls below
the value specified in Limit.

PVLowLow. Used in conjunction with a PVLow alarm to
indicate a more serious alarm. The value specified in
Limit for the PVLowLow alarm must be less than that
specified for PVLow alarm.

RateOfChange. An alarm is generated if the rate of
change of the PV (in engineering units per second)
exceeds the value specified in Limit.

TransmitterHigh. Similar to a PVHigh alarm, it is
typically used to indicate a failed transmitter.

TransmitterLow. Similar to a PVLow alarm, it is
typically used to indicate a failed transmitter.

Priority
Sub Priority

These two properties specify the alarm's severity, and
where it appears in the list of alarms.

Priority can be: Urgent, High, Low and Journal (the default).
All alarms, except for Journal, appear in the Alarm
Summary display. If critical alarm support has been
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Property ‘ Description

enabled, urgent priority alarms with a sub priority of 15
will be shown as critical priority alarms on the Alarm
Summary and other displays. For information about how
to enable critical alarms, see “Customizing alarm colors” in
the Server and Client Configuration Guide. Journal alarms
do not appear in Station as alarms, but are written to the
event file.

Sub-priority range from 15 (highest), to O (lowest and
default).

Limit The PV value, in engineering units, at which an alarm is
generated.

On Delay On Delay and an Off Delay values can be specified (in

seconds) for the following alarms:
Off Delay

. PVLowlLow

. PVLow

. PVHigh

. PVHighHigh

. RateOfChange

. TransmitterHigh
. TransmitterLow
N DeviationHigh

. DeviationLow

o Unreasonable Value

External Change Alarms | If selected, an alarm is raised if the parameter changes
without the change being initiated from the server.

Unreasonable Value Raises an alarm if the PV goes outside the reasonable
value range. (The high and low limits for this range are
specified in Station.)

Control Fail Alarm Raises an alarm if the value of a control parameter, such as
OP or SP, is not correct. (After issuing a new control value,
the server scans the point to check the point's control
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Property

‘ Description

value is correct.)

Alarm Message Index The index number of the message associated with alarms

for this point.

For details about creating messages, see the Server and
Client Configuration Guide.

Alarm Deadband Reduces the number of alarms that are generated when

the PV value is moving in and out of the alarm limit.

For example, if you select 1% and an alarm is raised
because the PV exceeded a limit, no more alarms are
raised unless the PV first drops more than 1% and then
rises back above the alarm limit.

Disable Alarming If selected, disables all alarms for this point.

Journal Only

Handles all alarms for the point as journaled events;
alarms do not appear in the alarm summary.

Property

Control properties for an analog point

The Control tab defines the point's control-related properties.

‘ Description

Source The address from which the server reads (scans) the associated

Address parameter value. The address can be a controller, a point, or a
database file.
Either type the full address, or click -l to specify the address using
Address Builder.

Dest Address | The address to which the server writes the associated parameter

value. The address can be a controller, a point, or a database file.

Either type the full address, or click I to specify the address using
Address Builder.

Scan Period

The interval (in seconds) between successive scans of the source
address.

Dynamic
Scanning

When selected, dynamic scanning is enabled for the parameter. The
default setting for this check box is selected.
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Property ‘ Description

Reverse Reverses source and destination parameter values. Select it if the
Output device being controlled closes and opens on reverse signals.

Reverse Reverses the mode parameter value for the MAN state. Do not enable
Mode MD reverse on points connected to Bristol Babcock controllers and

Bristol Babcock OpenBSI controllers.

Control When this check box is selected and a control action is performed on
Confirmation | the point, displays the prompt: Please confirm control request. The
operator must press Y to confirm the control action.

If you configure the point to use electronic signatures, the server
writes to the Dest Address only after the correct entry of the password
(s).

Low Control | The lowest value that can be set for the associated parameter. The
Limit value is clamped at this value.

For OP, the value is specified as a percentage of the PV output range.
The default is 0%.

For SP, the value is specified in engineering units.

High Control | The highest value that can be set for the associated parameter. The
Limit value is clamped at this value.

For OP, the value is specified as a percentage of the PV output range.
The default is 100%.

For SP, the value is specified in engineering units.

Control The percentage deviation from the SP value that constitutes a good
Deadband control. (The default value is 1.000%.) The value is calculated using
the formula:

(new SP value) +/-(control deadband percentage)

If the PV value is not within the target range, a PV fail alarm is raised.

Control The maximum time (in seconds) allowed, after a change in SP or OP,
Timeout for the PV value to reach an acceptable value before a control fail
alarm is raised. The default is None (no control timeout).

The server checks the value every 10 seconds during the timeout
period.
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Property

‘ Description

You must specify a value other than None to enable the control fail
alarm.

Control Level

Only applicable if you use operator-based security.

The minimum control level (between O and 255) required to perform
supervisory control on this point. The default is O.

Normal
Mode

The normal mode for this point, to which it is reset to after a
command is issued. The modes are:

. AUTO (default). Automatic mode. The controller (or server)
controls the output and operators cannot change the output
value.

. MAN. Manual mode. The operator is permitted to change either
the SP or OP.

. CASC. Cascade mode. Only applicable to S9000, TDC, and UDC
controllers. Used when the SP comes from the output of
another PID loop within the controller. When in CASCade mode,
operators cannot change either the SP or OP.

. COMP. Computer mode. Only applicable to a TDC controller.
Used when the SP comes from a computer that is performing
automatic control. When in COMPuter mode, operators can
change either the SP or OP.

Disable
mode
checking on
output

If selected, operators can change parameter values regardless of
point's mode.

If cleared, the server checks the mode before allowing an operator to
change a parameter value. (If the mode is set to AUTO, the operator is
not allowed to change the OP value.)

Note that there is no indication to an operator on Station displays
that the mode checking is disabled.

Control
Inhibit

Inhibits control of the point. Operators can view, but not control, the
point.
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Auxiliary properties for an analog point

The Auxiliary tab is exclusive to analog points, and defines up to four
auxiliary parameters. You can use these auxiliary parameters to read
auxiliary data from a controller (or write auxiliary data to it).
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Property ‘ Description

Parameter Name The name of the auxiliary parameter. This name can be no longer

than 8 alphanumeric characters, including spaces.

If the name matches the name of an internal point parameter, the
internal parameter's value tracks the value in the controller. If the
value of the internal parameter is changed, that value is also
written to the auxiliary parameter's destination address. In this
way, for example, alarm limits in a controller are kept in
synchronization with point alarm limits.

NOTE: If the parameter has both a short name (for example
AL1) and a long name (for example Alarm1), the long form
will be shown on the Auxiliary tab of the Point Detail display
regardless of which name is configured as the Parameter
Name.

Source Address | The address of the auxiliary parameter. The source can be a
controller, point, or database file.

Either type the full address, or click | to specify the address
using Address Builder.

Destination For an SP, OP or MD parameter, type the destination address. The
destination can be a controller, point, or database file.

Either type the full address, or click J to specify the address
using Address Builder.

Scan Period The interval (in seconds) between which the source address is
scanned. The default is O (no scanning).

Dynamic When selected, dynamic scanning is enabled for the parameter.
Scanning The default setting for this check box is selected.
About drift deadbands

Drift deadbands eliminate unnecessary processing of analog point
parameters, and therefore reduce system load.

When a parameter is scanned, processing is only performed if the
value has changed by more than the deadband amount since
processing last occurred. The deadband value is expressed as a
percentage of the point range.
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Container points

A container point ties together a set of related points so that you can

manage them as if they were one point. A container point s, in effect,
a user-defined point type that matches your data requirements for a

particular device type or scenario.

Container points are specifically designed to be used where you have
numerous devices or scenarios of the same type—typical examples
include compressors, tanks and security zones.

Container points have the following restrictions:

m All child points must be on the same server as the container
point—that is, they cannot be on a remote server.

m Alarms raised on the contained (child) points are not promoted to
the container point. This means that a container point never goes
into alarm.

m You cannot attach an algorithm to a container point.

m You cannotinclude points from more than one server in the same
container point.

This section contains information on how to use Quick Builder to
create and configure container points.

Defining the structure of a container point

ATTENTION: It is essential that you design the structure of a
container point with great care. There is no easy way to change
the structure of a container point type after you start adding
container points in Quick Builder. Instead, you have to

individually change the structure of every container point you
have created.

The first step in defining a new type of a container point is to identify
its contained (child) points. For example, you may use the following
points to monitor and control a particular type of compressor:

m An analog point to monitor the pressure
m A status point to control the motor
m An accumulator point to monitor hours run

Having identified the contained points, you can give the container
point type an appropriate name and define an alias for each
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contained point. Note that periods () are not allowed in alias names
for container points; for example, flow.rate is not a valid alias name.

Continuing with the compressor example, you could call the container
point type CompressTypel, and define the following aliases:

m Pressure (to represent the analog point)
m Motor (to represent the status point)

m HoursRun (to represent the accumulator point)

Creating container points

There is no mechanism in Quick Builder for creating container point
templates. Consequently, we recommend the following two-step
process when adding container points:

1. Create a container point that defines its basic properties, including
the aliases for the contained points. (This point becomes, in effect,
the template for a new type of container point.)

2. Create duplicates of the template point and then configure each
duplicate as necessary.

To create a container point

1. Click = to add a container point.

In the Add Items dialog box, select Point as the item and Container
as the point type.

N

On the Main tab, enter the container point details as required.
Click the Contained Points tab.
Add one row for each alias by clicking Insert Point.

o 0k w

Name each alias in accordance with your design.

Main | Contained Points ]

Paint D |

Erterprize Model |

Description [Rh_DACA_301 to 600
Parent Azzet |Hahul5_l,ls.-’-'-.rEEl

Associated Display |RAHUL_DACA_Template
Template Type |
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tain  Contained Paoints |

Aliaz | Contained Paint | D ezcription [read anly]
Coot Rih_DACA_201

| conz Rh_DACA,_302

| cooz Rh_ DA, 302

| cons Rk DACA_204

| coos Rh_DACA,_305

To create duplicates of the template container point

1. Select the container point and then choose EditDuplicate Items.
The Duplicate dialog box opens.

2. Create the required number of duplicates.

3. Configure the properties of each duplicate as appropriate. This
includes specifying the point associated with each alias.

Main properties for a container point

The Main tab defines the basic properties of the container point.
Because of the nature of a container point, it has relatively few
properties.

Property ‘ Description

Point ID A unique identifier given to an entity.

Enterprise An intuitive name given to a point, which can be used as an alternative

Model Item | to the point ID. It must be unique amongst entities with the same

Name parent asset. The enterprise model property is also referred to as the
Use Name on the initial Add Items screen.

Description | A description of the point that helps identify it. The description often

appears in Station displays. 132 characters maximum, including
spaces.

Parent Asset

The asset to which the point belongs.

Associated The point detail (template) display that is used to show the point
Display information.

Template The name of the container point type.

Type
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‘ Description

Item Type Shows the point type.

Last Shows the date of the most recent modification to this point's
Modified property details.

Last The date on which the item was last downloaded to the server.

Downloaded

Reviewing and adding contained points

Use the Contained Points tab to view the points associated with a
container point. You can also use this tab to add and remove points
inside the container point.

Using an existing point detail display as the
associated display

If you want to use a point detail display as the associated display for
the container point (specified on the point's 6), use the following
syntax:

DisplayFileName?Point=PointID

‘ Description

DisplayName | The filename of the point detail display (without the extension).

[ PointID

The container point's ID. For example, if you are configuring a
container point called 'Chillerl’, you would specify Chillerl.

Creating a point detail display for a container point

Each type of container point requires its own point detail display (also
called a template display), which you create in HMIWeb Display
Builder. (This display is functionally equivalent to a standard point
detail displays.)

The following procedure summarizes the special steps required when
creating a point detail display for a container point.
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To create a point detail display

1.

On the HMIWeb Display Builder toolbar, click the arrow to the
right of = and select Display from Template.

The New Display dialog box opens.

Select the Point Detail template and click OK.

A new display, based on the template, appears.

Add an appropriate object for each parameter you want users to
see.

Open the Properties Window.

Select each of these objects in turn and, using the following table,
specify the parameter's details. (For most objects, use the Data tab;
for a chart, use the Details tab.)

Property ‘ Description

Type of database Select Point/Parameter.

linkl

Point Select CurrentPoint.
Parameter The syntax is: Alias.Parameter

Where:

. Alias is the name you defined for the
contained point

. Parameter is parameter's name.

For example, if you wanted to display the
PV of a contained point whose alias is
'HoursRun', you would type: HoursRun.PV

Data entry allowed | Allows users to change the parameter's
1 value.

If you allow data entry, select the minimum
Security Level required to change the value.

1INot applicable to a chart.
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OPC advanced points

An OPC advanced point allows you to create arbitrary point parameter
names to reference OPC items. An OPC advanced point also allows
you to have more than eight scanned parameters, and can also have
user-defined names.

This section contains the configuration information that is specific to
OPC advanced points. Other tabs also appear in the properties pane
for the OPC advanced point, but are generic to all points. They are:

m Display tab
m Scripts tab
m User Defined tab
m History tab

See the related topics for links to more information about each of
these tabs.

Main properties for an OPC advanced point

The Main tab defines the basic properties of an OPC advanced point.
(An OPC advanced point represents a collection of related OPC items.)
Note the following points:

m Having configured the properties on this tab, you then use the
OPC Parameters tab to add the OPC items.

m For anintroduction to OPC advanced points, and the Experion
OPC Advanced Client, see the Server and Client Configuration
Guide.

m You may find it easier to simultaneously import all the OPC
advanced points from a spreadsheet.

Property ‘ Description

Point ID

The point's name.

See the topic "Naming rules for points" in the chapter on "Points" in
the Server and Client Configuration Guide.

Enterprise
Name

An intuitive name given to a point, which can be used as an alternative
to the point ID. The enterprise name is used within the full item name
of a point, which shows the point's location within the asset hierarchy.
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Property ‘ Description

Description

A description of the point that helps identify it. The description often
appears in Station displays. 132 characters maximum, including
spaces.

Parent Asset

The asset to which the point belongs.

Note: All the OPC items associated with this point must belong to this
area.

Downloaded

Server Alias | The server alias of the OPC Advanced Client to which this point
belongs. (The server alias was specified when the OPC Advanced Client
was configured in Station.)

Item Type Shows the point type.

Last Shows the date of the most recent modification to this point's

Modified property details.

Last The date on which the item was last downloaded to the server.

Importing OPC advanced point definitions from a
spreadsheet

This section is only applicable if you have the Experion OPC Advanced
Client option and want to map OPC items to OPC advanced points.
(For an introduction to the Experion OPC Advanced Client, see the
topic titled "Configuring the Experion OPC Advanced Client" in the
Server and Client Configuration Guide.)

Instead of individually configuring OPC advanced points in Quick
Builder, it may be easier to simultaneously import them from a
Microsoft Excel spreadsheet. This is a three-part procedure, which
involves:

1. Creating a spreadsheet with the required format.
2. Populating the spreadsheet.

3. Importing the point definitions.

Creating a spreadsheet with the required format

This procedure creates a spreadsheet with the required format, which
contains a sample point and one or more OPC parameters attached
to that point.
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To create a correctly formatted spreadsheet:

1. In Quick Builder, add one OPC advanced point.
2. Add at least one OPC parameter to the point.

=
Select the point and click to copy it to the clipboard.
4. In Excel, choose File > New.

w

5. Click I: to paste the point definition into the spreadsheet.

Populating the spreadsheet

You must populate the spreadsheet columns as specified in the
following tables.

The following figure shows a populated spreadsheet. Note how it
contains two parts:

m The first part contains the heading row and a separate row for
each point.

m The second part (which must be separated from the first part by a
blank row) contains the heading row and a separate row for each
OPC parameter (OPC item).

Because each point typically has many OPC parameters, the
second part contains more rows. For example, if each point has
five OPC parameters, there will be five parameter rows for each

point row.

A, B [ D
1 ltemMame Class DownloadedMame  Tag Date
2 |DpcAdvPntdo? COPCPaint FALSE
3 |OpcAdvPnt002 COPCPaint FALSE
4
A |ParentlternPMarme | Class FaramMame HistaryFast Hist:
b |OpcAdyPntO01 OFCFarameters P TRLE FAL
7| DpcAdyPnt01 OFCFarameters SF TRLUE FAL
8 |OpcAdyPnt002 OFCParameters P TRUE FAL
9 OpcAdyPnt002 OFPCFParameters 5P TRLUE FAL

Table 6-1: Point definitions (first part of the spreadsheet)

Column Description
[temName Corresponds to Point ID on the Main tab in Quick
Builder
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Column Description

Class

Must be OPCPoint.

DownloadedName

Leave blank.

Tag

Must be FALSE.

DateModified

Leave blank.

DateDownloaded

Leave blank.

TagDeleted Must be FALSE.
Target Leave blank.
ltemNumber Leave blank.

ItemDescription

Corresponds to Description on the Main tab in Quick
Builder.

OPCServer

Corresponds to Server Alias on the Main tab in Quick
Builder.

InstructionsDisplayNumber

Leave as default.

Scripts

Leave blank.

PositionInTrendSet

Corresponds to Position in Trend Set on the Display tab
in Quick Builder.

PositionInGroup

Corresponds to Position in Group on the Display tab in
Quick Builder.

PointGroupTemplatePage

Corresponds to Group Faceplate Template Display on the
Display tab in Quick Builder.

GroupNumber

Corresponds to Group Number on the Display tab in
Quick Builder.

AssociatedDisplayNumber

Corresponds to Associated Display on the Display tab in
Quick Builder.

TrendNumber

Corresponds to Trend Number on the Display tab in
Quick Builder.

PointDetailPage

Corresponds to Point Detail Display on the Display tab
in Quick Builder.
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Column Description

ParentAsset Corresponds to Parent Asset on the Main tab in Quick

Builder.

Table 6-2: OPC Parameter definitions (second part of the spreadsheet)

Column Description

ParentltemName The Point ID of the point to which this item belongs.
Class Must be OPCParameters.
ParamName Corresponds to Parameter Name on the OPC Parameters tab

in Quick Builder.

HistoryFast Corresponds to Fast history on the History tab in Quick
Builder.

HistoryStandard Corresponds to Standard history on the History tab in Quick
Builder.

HistoryExtended Corresponds to Extended history on the History tab in Quick
Builder.

HistoryException Corresponds to Exception history on the History tab in Quick
Builder.

HistoryFastGating Leave blank.

HistoryStandardGating | Leave blank.

HistoryExtendedGating | Leave blank.

OPCltem The name of the OPC item. (Corresponds to OPC Item on
the OPC Parameters tab in Quick Builder.)
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Importing the point definitions

To import the point definitions:
1. In Microsoft Excel, select the rows and copy them to the clipboard.

2. In Quick Builder, click I: to add the points into the project.
If a point already exists in the project, Quick Builder updates it in

accordance with the spreadsheet's definition.
OPC parameters for an OPC advanced point

This tab defines a parameter for each OPC item you want to add to
the selected OPC advanced point.)

To add an OPC item (point parameter)

1. Click Insert.
2. Type an appropriate name in Parameter name.

3. Specify the parameter's remaining properties.

Property ‘ Description

Parameter The name of the OPC parameter.

Name

OPC Item The name of the OPC item that this parameter represents.

Details Displays all properties and corresponding values of an OPC
Parameter.

Status points

A status point is a standard point type with a fixed data structure that
represents digital inputs or outputs. For example, a status point can
represent the on and off states of a pump.

This section contains the configuration information that is specific to
status points. Other tabs also appear in the properties pane for the
status point, but are generic to all points. They are:

m Display tab
m History tab
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Scripts tab

User Defined tab

Non Scanned parameters tab
PV Algo tab

Action Algo tab

See the related topics for links to more information about each of
these tabs.

Main properties for a status point

The Main tab defines the point's basic properties.

Property

Point ID

‘ Description
The point's name.

See the topic "Naming rules for points" in the chapter on
"Points" in the Server and Client Configuration Guide.

Enterprise Model
Item Name

An intuitive name given to a point, which can be used as an
alternative to the point ID. It must be unique amongst entities
with the same parent asset. The item name property is also
referred to as the Use Name on the initial Add Items screen.

Description

A description of the point that helps identify it. The description
often appears in Station displays. 132 characters maximum,
including spaces.

Parent Asset

The asset to which the point belongs.
Click Ll to select from a list of assets.

A parent controller can also be configured to enable alarms
raised on the point to appear in the System Status display
instead of the Alarm Summary. Instead of selecting an asset
from the list, enter "$CONTROLLER" followed by the last four
digits of the controller's item number. For example, for
controller RTUOOOO18 you would enter "$CONTROLLEROO018."
Note that this is only possible for status, accumulator, and
analog points.

Number of States

The number of discrete input states you want to configure.

Non-consecutive

Available only when the value in the Number of States list is 4 or
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Property ‘ Description

Bits 8.
When selected, you can address up to three non-consecutive
bits as the PV Source Addresses. The number of addresses is
controlled by the value in the Number of States list. That is, a 4-
state point will have two addresses and an 8-state point will
have three addresses.
If the bit addresses are consecutive (adjacent), clear this check
box and address only the lowest bit required for the PV source
address.

Reverse Bit For a 2-state point, reverses the parameter (i.e., Bit 0).
For a 4-state point, reverses Bit 0 and/or Bit 1. Select the
appropriate check boxes.
For an 8-state point, reverses Bit 0 and/or Bit 1 and/or Bit 2.
Select the appropriate check boxes.

PV Source Address | The controller name/address where the PV is stored.

Either type the full address, or click -l to specify the address
using Address Builder.

If you select an OPC controller, the Non-Scanned Parameters
tab appears.

When the Non-consecutive Bits check box is selected, you can
address up to three non-consecutive bits as the PV Source
Addresses. The number of addresses is controlled by the value
in the Number of States list.

A 4-state point will have two PV source addresses: Bit O Source
Address and Bit 1 Source Address.

An 8-state point will have three PV source addresses: Bit O
Source Address, Bit 1 Source Address, and Bit 2 Source Address.

PV Scan Period

The interval, in seconds, at which the server scans the controller
for the parameter value. Select O (the default) if you do not want
scanning.

PV Dynamic
Scanning

When selected, dynamic scanning is enabled for the PV
parameter. The default setting for this check box is selected.
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Property ‘ Description

PV Algo The PV algorithm associated with this point. If you select an
algorithm, the PV Algo tab appears.

The default is NONE.

Action Algo The action algorithm associated with this point. If you select an
algorithm, the Action Algo tab appears.

The default is NONE.

Scanning Enabled | Indicates that scanning is to be enabled as soon as you
download the point.

State Descriptors A state descriptor describes the associated state, and can have a

(State O — State 7) | maximum of eight characters (no spaces allowed). For example,
you might make 'Open’ the state descriptor for state 1 and
'Closed' for state 0.

For a control (output) point, there must be a unique state
descriptor for each valid state. This is also recommended for a
monitor (input) point.

Item Type Shows the point type.
Last Modified The date of the most recent modification to this point's property
details.

Last Downloaded The date on which the item was last downloaded to the server.

Alarm properties for a status point

The Alarms tab specifies the characteristics of the alarms that a status
point can generate.

ATTENTION: If you clear the Disable Alarming check box (that is,
enable alarming) but do not specify any state alarms, a Journal
alarm is raised each time the point changes state.

Property Description

Enable If selected, an alarm is raised when the PV changes to the
specified state.
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Property
Priority
Sub Priority

‘ Description

These two properties specify the alarm's severity, and
where it appears in the list of alarms.

Priority can be: Urgent, High, Low and Journal (the default).
All alarms, except for Journal, appear in the Alarm
Summary display. If critical alarm support has been
enabled,urgent priority alarms with a sub priority of 15 will
be shown as critical priority alarms on the Alarm Summary
and other displays. For information about how to enable
critical alarms, see “Customizing alarm colors” in the
Server and Client Configuration Guide. Journal alarms do
not appear in Station as alarms, but are written to the
event file.

Subpriority range from 15 (highest), to O (lowest and
default).

On Delay
Off Delay

On Delay and an Off Delay values can be specified (in
seconds) for each of the eight state alarms.

External Change Alarms

If selected, an alarm is raised if the parameter changes
without the change being initiated from the server.

Control Fail Alarm

Raises an alarm if the value of a control parameter, such as
OP or SP, is not correct. (After issuing a new control value,
the server scans the point to check the point's control
value is correct.)

Alarm Message Index

The index number of the message associated with alarms
for this point.

For details about creating messages, see the Server and
Client Configuration Guide.

Change of state events

If selected, a CHANGE event is raised in the event journal
whenever the PV changes state. By default, this setting is
disabled.

Ack Destination
Address

Enables the acknowledgement of an alarm to be
registered in a controller.

The server writes a 1 to this address when the alarm is
acknowledged by an operator. Ack Destination Addresses
can only be used on status points. The address must be an
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Property ‘ Description

address within a real (physical) controller (not a database
or point reference). The PVSOURCE address also needs to
be an address within a real (physical) controller.

Note: You must ensure that ladder logic within the
controller resets the PV to O when the required task has
been performed.

For example, if you have configured a process to stop
when the current point goes into alarm, you could
configure your process to restart when the PV of the Ack
Destination Address changes to 1—that is, when the
operator acknowledges the alarm.

Either type the full address, or click -l to specify the
address using Address Builder.

Re-alarm on state If selected, an alarm is raised whenever the PV changes to
transition another alarm state.

For example, if you make states 7 and 8 alarm states, an
alarm is raised if the PV changes to state 7 and another
alarm is raised if the state then changes to state 8.

Disable Alarming If selected, disables all alarms for this point.

Journal Only Handles all alarms for the point as journaled events;
alarms do not appear in the alarm summary.

Control properties for a status point

The Control tab defines the point's control-related properties.
Property ‘ Description
Number of OP States | The number of possible output states for this point. The

minimum is 2 (the default), the maximum is 4. Single bit
outputs can only have 2 states.

OP Individual Bits Available only when the value in the Number of OP States list is
4.

When selected, you can address two non-consecutive bits as
the OP Source Addresses and two non-consecutive bits as the
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Property

‘ Description

OP Destination Address.

Reverse Output

Reverses source and destination parameter values. Select it if
the device being controlled closes and opens on reverse
signals.

OP Reverse

Reverses source and destination parameter values. Select it if
the device being controlled operates on reverse signals.

For a 2-output-state point, reverses the parameter (i.e., Bit 0).

For a 4-output-state point, reverses Bit O and/or Bit 1. Select
the appropriate check boxes.

For an 8—output-state point, reverses Bit O and/or Bit 1
and/or Bit 2. Select the appropriate check boxes.

Output (OP)

When the OP Individual Bits check box is selected, you can
address two non-consecutive bits as the OP Source
Addresses and two non-consecutive bits as the OP
Destination Addresses.

Source Address:

. The address(es) from which the server reads (scans) the
associated parameter value.

Either type the full address, or click -l to specify the
address using Address Builder.

Dest Address:

. The address(es) to which the server writes the
associated parameter value.

Either type the full address, or click -l to specify the
address using Address Builder.

Source Address

The address from which the server reads (scans) the
associated parameter value. The address can be a controller,
a point, or a database file.

Either type the full address, or click I to specify the address
using Address Builder.

Dest Address

The address to which the server writes the associated
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Property ‘ Description

parameter value. The address can be a controller, a point, or a
database file.

Either type the full address, or click -l to specify the address
using Address Builder.

OP Scan Period The interval (in seconds) between successive scans of the OP
source address(es).

OP Dynamic When selected, dynamic scanning is enabled for the OP
Scanning parameter. The default setting for this check box is selected.
MD Reverse Reverses the mode parameter value for the MAN state. Do not

enable MD reverse on points connected to Bristol Babcock
controllers and Bristol Babcock OpenBSI controllers.

Mode (MD) Source Address:

. The address from which the server reads (scans) the
associated parameter value. The address can be a
controller, a point, or a database file.

Either type the full address, or click -l to specify the
address using Address Builder.

Dest Address:

. The address to which the server writes the associated
parameter value. The address can be a controller, a
point, or a database file.

Either type the full address, or click -l to specify the
address using Address Builder.

MD Scan Period The interval (in seconds) between successive scans of the MD
source address.

MD Dynamic When selected, dynamic scanning is enabled for the MD
Scanning parameter. Default is selected.
Pulse Width The time (in seconds) the OP value is maintained at a non-

zero value. The default value, Latched, latches the OP at the
non-zero value.

For example, if the value is set to 2 seconds and the operator
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Property ‘ Description
sets the OP to a non-zero state, the OP returns to zero after 2
seconds.

Control When this check box is selected and a control action is

Confirmation

performed on the point, displays the prompt: Please confirm
control request. The operator must press Y to confirm the
control action.

If you configure the point to use electronic signatures, the
server writes to the Dest Address only after the correct entry of
the password(s).

Control Timeout

The maximum time (in seconds) allowed, after a change in SP
or OP, for the PV value to reach an acceptable value before a
control fail alarm is raised. The default is None (no control
timeout).

The server checks the value every 10 seconds during the
timeout period.

You must specify a value other than None to enable the
control fail alarm.

Control Level

Only applicable if you use operator-based security.

The minimum control level (between O and 255) required to
perform supervisory control on this point. The default is O.

Normal Mode

The normal mode for this point, to which it is reset to after a
command is issued. The modes are:

. AUTO (default). Automatic mode. The controller (or
server) controls the output and operators cannot
change the output value.

. MAN. Manual mode. The operator is permitted to
change either the SP or OP.

. CASC. Cascade mode. Only applicable to S9000, TDC,
and UDC controllers. Used when the SP comes from the
output of another PID loop within the controller. When
in CASCade mode, operators cannot change either the
SP or OP.

. COMP. Computer mode. Only applicable to a TDC
controller. Used when the SP comes from a computer
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Property ‘ Description

that is performing automatic control. When in
COMPuter mode, operators can change either the SP or
OP.

Disable mode If selected, operators can change parameter values
checking on output regardless of the point's mode.

If cleared, the server checks the mode before allowing an
operator to change a parameter value. (If the mode is set to
AUTO, the operator is not allowed to change the OP value.)

Note that there is no indication in the displays that the mode
checking is disabled.

Target Input State These properties associate the four OP states with the
Associations appropriate input (PV) states. (The input states are defined in
State Descriptors on the Main tab.)

A value of F means 'not used.' You must specify F for OP State

2 and OP State 3 for a single-bit output and you must specify F
for OP State 4, OP State 5, OP State 6, and OP State 7 for a dual-
bit output.

Operators can control the point by using Station's Raise and
Lower buttons to select a target input state.

Control Inhibit Inhibits control of the point. Operators can view, but not
control, the point.

Configuring the Raise and Lower buttons for OP
control

To give operators control of a point's OP parameter using Station's

~ (Raise) and ' ¥ (Lower) buttons, you must assign the appropriate
parameter values to the two buttons.

For reasons of consistency, you should always assign the active state
(such as On or Start) to the Raise button and the inactive state (such
as Off or Stop) to the Lower button.

The following table shows the correspondence between the buttons
and the OP states. (Note that if you select Reverse Output, you must
reverse the associations—that is, you associate Raise with the OP state
normally associated with Lower, and vice versa.)
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Button Single-bit output Dual-bit output

Raise OP State 1 OP state 2

Lower OP State O OP State 1
Example

The point is single-bit output point for which the value of State O is
Closed and the value of State 1 is Open. (These properties are defined
on the Main tab.)

To associate the Raise button with Open, and the Lower button with
Closed, you set the OP State values as follows:

m OP StateOto O
m OPStateltol
m OP State2to F
m OPState3to F

Configuring algorithm parameters

Algorithms are used in parameter types that change value in
accumulator, analog, or status points.

When defining the point’s properties in Quick Builder, you can select
algorithms from the Action Algo and PV Algo lists provided on the Main
tab. The Action Algo or PV Algo tab will then appear, enabling the
algorithm’s configuration.

Parameter requirements are different for each algorithm. Refer to the
specific Action or PV algorithm for parameter requirements and
descriptions.

Display-related properties

Property

Group Number

The Display tab defines the point's display-related properties.

Description

The number of the group to which the point is assigned. Each
group is identified by a unique ID, which is an integer between
1 and 2000.
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Property ‘ Description

Position in Group The position of the point in the group, (1 to 8).

Trend Number The trend to which this point is assigned. Each trend is
identified by a unique ID, which is an integer between 1 and
1000.

Position in Trend Set | The position of this point in the trend, (1 to 8).

Trend Parameter Parameter used to define what values are shown on a trend
display, for example, PV.

Associated Display The display that is called up when an operator selects the
point (or its alarm in the Alarm Summary) and then clicks the
Associated Display button on the toolbar.

Point Detail Display | The point detail display that is used to show detailed point
information. If you leave the value as default, the standard
detail display for the point type is used.

Group Faceplate The group faceplate template display that is used to display

Template Display point information when the point is part of a group. If you
leave the value as default, the standard faceplate for the point
type is used.

History collection properties

You use the History tab to define the history-collection properties for
SCADA (and OPC advanced) point parameters.

ATTENTION: The default history collection rates are configured
and stored on the server. Before configuring history collection
for SCADA point parameters, make sure that you have uploaded
the current history collection rates from the server. You can do
this by selecting the appropriate server in Quick Builder and
choosing the UploadSelected Items Only option.

Property Description
Parameters Select the type of parameter for which you want to collect history.
Fast Fast history stores snapshots of point parameter values at short

regular intervals called fast history intervals. You can choose from
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Property

‘ Description

up to eight collection rates. The initial default base rate is 5
seconds.You can add up to 3 more fast history collection rates to
the default fast history groups of 5, 10, 15, 20, and 30 seconds.

If the configured base rate for fast history collection is a value
other than 1,000 or 5,000 milliseconds, you can only collect history
at that one rate. For example, if your fast history collection rate was
3 seconds before you migrated to the current release of Experion,
this is the rate that all points assigned to fast history collection will
use. If you want to be able to assign points to different fast history
collection rates, contact Honeywell technical support staff.

Standard

Standard history stores snapshots and averages of point parameter
values at regular intervals called standard history intervals. You can
choose from up to eight standard history collection rates for
snapshots. The initial default choices are: 1, 2, 5, 10, 30, and 60
minutes. Standard history averages are based on the default base
rate of 1 minute. You can choose from four collection rates for
averages: 6 minutes, 1 hour, 8 hours, and 24 hours.

Extended

Extended history stores the following snapshots of point parameter
values:

o 1-hour snapshots
o 8-hour snapshots

. 24-hour snapshots

Exception

Whereas standard, fast, and extended history collect and store
point parameter values periodically, exception history collects
point parameter values but only stores them if the value of that
point parameter has changed since it was last stored. The default
collection rates for exception history are:

o 5, 10, 15, 30, and 60 seconds
o 5, 10, 15, 30, and 60 minutes
o 2,4,6,8,12, and 24 hours

Exception history only supports string values when values are
collected in real-time, but supports both numeric values and string
values when values are stored by history backfill by the DNP3
interface.
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Property ‘ Description

NOTE: Even though Exception history can collect data at the
same interval as Fast history, it stores by exception. While
this approach may help decrease controller congestion, data
retrieval performance would be considerably worse that that
experienced with Fast history.

Collection Rate | For fast, standard, and exception history, choose a rate from the
drop-down list. The rates shown here are set on a server-wide basis
on Station.

Offset When collecting standard and exception history for TPS points, you
can choose an offset rate from the drop-down list. The rates shown
here are set on a server-wide basis on Station.

Backfill Only If the controller on which the point is built can store history,
selecting this option reduces the scanning load on the server. If the
option is selected, the server collects all outstanding history each
time it scans the point. For example, you can collect fast history but
only scan the controller at hourly intervals. The history backfill
option is only supported by the DNP3 interface.

You should select this option if you are collecting history on a
point on a dial-up controller.

Note: If you select this option, do not specify a gating point.

If selected for exception history, the DNP3 will not collect and store
current live point parameter values in exception history. Instead, it
will store values in history that come directly from the DNP3
controller event data (that is, class polls).

Default is unselected.
Exception history and exception history backfill:

. Allows storage of exact timestamp of events from DNP3
controller

. Stores values only when they change

. Is good for slow moving values or if you need sub-second
accurate timestamps.

Periodic history and periodic history backfill:
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Property ‘ Description
N When choosing for standard history, will get averages, but
note that averages will not be recalculated in backfill
scenarios.
. When choosing for fast history, is good for constantly
changing values.
Gate Point Use these boxes if you want history collected only when the point

Gate Parameter

State

parameter value is in a specific state.

Gating is used, for example, to stop history collection when a
generator or motor is turned off.

PHD Collection

Use these boxes to specify PHD collection for fast, standard,
extended, and exception history.

N Default = PHD collects history for this point according to the
PHD collection rule.

. Override = PHD overrides the PHD collection rule and collects
history for the point at this history assignment rate.

. Disable = PHD does not collect history at this history
assignment rate.

It is possible to assign Override to multiple history assignments for
the same point. However, PHD will collect history assignment at
only one rate. To determine the collection of history to the PHD
server, see the topic titled "PHD collection rule" in the Hardware
and Point Build Reference.

Subscribing to non-scanned parameters

Non-scanned parameters provide a mechanism to group related PLC
stored information directly to a SCADA point without overloading the
communications. For example, to access configuration properties or
maintenance information that is infrequently accessed. The result is a
SCADA point structure that more closely reflects what can be quite
complex PLC point structures. Data is acquired only when requested
by a client, such as when an Operator is calling up a display. When the
Operator calls up a different display, Experion no longer acquires the
parameter. By contrast, a scanned parameter is constantly acquired,
regardless of whether or not any client is using it. Controls can be
issued to non-scanned parameters and they can be assigned for
history collection.
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You can define non-scanned parameters to:

m Group related PLC stored information directly to a SCADA point
without increasing the base scanning load.

m Read non-numeric data types from an OPC server.

m Add numeric parameters from an OPC server but all of the
scanned parameter fields (e.g., for analog points: PV, SP, OP, MD,
Al, A2, A3, and A4) have been used.

You use this tab to subscribe analog points and status points to non-
scanned point parameters on an OPC controller.

Note: This tab appears only when the PV Source Address on the point’s
Main tab contains an OPC controller.

Property ‘ Description

Add Adds a new parameter to the list.

Delete Deletes the selected parameter(s) from the list.

Parameter | The unique name of the parameter.

name

Channel The name of the OPC channel, which is shared by all non-scanned

name parameters under the same point.

Item Click = to browse to an OPC Server address space to specify the item.

name
You can also type the full address. However, because the address format
can be difficult to follow, clicking the ellipsis button is the preferred
method.

Copy Copies the selected parameter to the Clipboard.

Parameter

Paste Pastes a copy of the parameter from the Clipboard to the list. The new
parameter’s name is preceded by Copy_of_.

Parameter

ATTENTION: When you use Quick Builder to configure non-
scanned parameters that connect to a remote OPC server, your
Windows account username and password must also reside on
the remote OPC server. In addition, the username must be a
member of the Product Administrators group on the remote
OPC server.
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If your Windows account does not exist or does not have
sufficient privileges on the remote OPC server, you will not be
able to select parameters from the list of parameters stored on
the server.

Username and passwords must match on both machines.

Creating or editing scripts

You can enhance the functionality of a point by writing scripts that
run when, for example, the point goes into alarm.

To write or edit a script for the point, go to the Scripts tab, and click
Create New or Edit Existing Server Scripts to open the Script Editor.
Creating scripts

You can extend a point's functionality by writing server scripts that, for
example, run when the point goes into alarm.

To write or edit a script for a point:

1. Select the point and click the Scripts tab.

2. Click Create New or Edit Existing Server Scripts to open the Script
Editor.

Electronic signature related properties

The Signature tab defines a point's electronic signature-related
properties.

Property ‘ Description
Electronic The number of electronic signature(s) required to control the point:
Signature
Type . None. No signature is required.
. Single. The signature of an operator with control rights to the
point is required.
. Double. Two signatures are required.
Reason Set The number of the reason set assigned to the point. (The operator
Number must select the appropriate reason from this set when controlling the
point.)
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Property ‘ Description

For details about configuring a reason set, see the Server and Client
Configuration Guide.

Primary Describes the meaning of entering the primary signature, for example:
Signature 'Issued,’ 'Implemented.’ It should be an approved term for your
Meaning industry/work practices.

Secondary Describes the meaning of entering the secondary signature, for
Signature example: 'Confirmed,' 'Authorized.' It should be an approved term for
Meaning your industry/work practices.

Secondary The minimum security level of the person who enters the second
Signer signature.

Security

Level

Configuring points for electronic signatures

If your server is licensed for electronic signatures, you can configure a
point so that when an operator attempts to control it, the server
requests one (or two) electronic signatures before executing the
control.

The following procedure summarizes the main steps involved in
configuring points for electronic signatures.

To learn about electronic signatures, see the topic titled "Configuring
Electronic Signatures” in the Server and Client Configuration Guide.

If you configure points for electronic signature, you are requested for
a password when downloading a project to (or uploading from) the
server. If this fails, then you are prompted for another user name,
password and domain. After successfully logging on to the server,
Quick Builder performs background logons for the rest of the session.
At the next session, Quick Builder remembers the last correct user
name and domain, but requires a password.

To configure points for electronic signatures

1. Select the server item and click the Server Specific Options tab.
2. Select Use Electronic Signatures.
3. Add a point that you want to configure for electronic signature.
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4. Click the Control tab and select Control Confirmation.
The Signature tab is added for that point.

5. Click the Signature tab and configure point's electronic signature
properties.

6. Configure the point's other properties as appropriate.

7. Repeat steps 3 to 6 for any other points that require electronic
signatures.

8. When you have finished updating the project, upload it to the
server in the normal manner.

9. Type your password when prompted.

Configuring user-defined parameters

You can create your own (user-defined) parameters for a point, which
can then be used to store custom or server scripting data on the
server.

A user-defined parameter can be a:

m Variable (For example, you may want store a value produced by a

script or entered by an operator.)

Constant (For example, you may want to record the serial number
of the device associated with the point.)

Word/record in a database (user) file (For example, you may want
to store a value produced by a custom application.)

Parameter of another point (For example, you may want to store
the PV of a related point.)

Scanned status parameter (Can be added to an analog point and a
status point.)

Scanned analog parameter (Can be added to an analog point and
a status point.)

Scanned string parameter (Can be added to an analog point and a
status point.)

Custom parameter (This parameter type is reserved for future use.)

TIP: Use the Copy Parameter and Paste Parameter buttons to
make a duplicate of a parameter for the current point, or to
copy it to another point or to Excel for modification. Note that if
you are modifying a parameter and you do not want the
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parameter to be duplicated, you can copy and paste the whole
point.

Use the Add Bulk Scanned button to add multiple scanned status
parameters or scanned analog parameters in the same action.

Adding a variable user-defined parameter

To add a user-defined parameter - Variable

1. Select the point for which you want to define the parameter.
2. On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

w

Type the parameter's name in Parameter name.
Select Variable from the Link type list.
5. Select the Value type:

« 16 bit signed integer (INT2)
« 32 bit signed integer (INT4)
o 32 bit floating point (REAL)
» 64 bit floating point (DBLE)
o 64 bit signed integer (INT8)

£

« String

6. To specify an initial value for the parameter, enter it in the Initial
value field.

7. To update the initial value that displays in Initial value field when
uploading points from the server, select the Update initial value
from the server during upload check box.

This check box is selected automatically and disabled (dimmed)
when the Never download initial value to the server check box is
selected.

8. To prevent the value in the Initial value field, including null, from
downloading to the server, select the Never download initial value to
the server check box.

Note that this setting is ignored when you change the Value type of
an existing parameter.

To change the default value of this check box for all new user-
defined parameters, go to the server’s Server Specific Options tab
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9.

and select or clear the Never download initial UDP value to the server
check box.

See the topic titled "Server specific options" for more information.

Select a security level from the Security Level list.

Adding a constant user-defined parameter

To add a user-defined parameter — Constant

1.

Select the point for which you want to define the parameter.

2. On the User Defined tab, click Add.

& w

6.
T.

A new unconfigured parameter is added to the list.

Type the parameter's name in Parameter name.
Select Constant from the Link type list.
Select the Value type:

« 16 bit signed integer (INT2)
« 32 bit signed integer (INT4)
o 32 bit floating point (REAL)
« 64 bit floating point (DBLE)
« String

Type the parameter’s value in the Constant value field.
Select a security level from the Security Level list.

Adding a database reference user-defined parameter

To add a user-defined parameter — Database reference

1.
2.

£

Select the point for which you want to define the parameter.
On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

Type the parameter's name in Parameter name.
Select Database reference from the Link type list.
Select the Value type:

« 16 bit signed integer (INT2)
« 32 bit signed integer (INT4)
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o 32 bit floating point (REAL)

« 64 bit floating point (DBLE)

e String

« Bit Field

Type the location of the parameter’s value in the server database in

the File, Record, and Word fields.

For String value type parameters, type the string’s length in the
String Length field.

For Bit Field value type parameters, Select the starting bit from the
Start Bit list, and select the number of bits to use from the Bit Width
list.

Select a security level from the Security Level list.

Adding a parameter reference user-defined parameter

To add a user-defined parameter — Parameter

reference

1.

Select the point for which you want to define the parameter.

2. On the User Defined tab, click Add.

£

7.
8.

A new unconfigured parameter is added to the list.

Type the parameter's name in Parameter name.
Select Parameter reference from the Link type list.

Type the point name on which the parameter is based in the Point
name field.

Type the parameter name on which the parameter is based in the
Parameter name field.

For history parameters, type the sample offset in the Offset field.
Select a security level from the Security Level list.

About user-defined scanned parameters

User-defined scanned parameters are a subset of user-defined
parameters. The only difference is that they can be scanned, whereas
other user-defined parameter types cannot.

The maximum number of user-defined scanned parameters you can
add to a point is 200.
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You can assign these parameters to fast, standard, extended, and
exception history collection.

No additional licensing is required to add user-defined scanned
parameters to points.

Supported controllers

The following controller types support points with user-defined
scanned parameters:

ABB Totalflow

Allen-Bradley PLC

Bristol Babcock OpenBSiI
ControlEdge PLC

ControlEdge RTU

DNP3

Enron Modbus

Fisher ROC

Honeywell Fail Safe Controller (FSC) PLC
Honeywell Universal Modbus
Modbus

Omni Flow Computer

OPC Client Interface

OPC UA Controller

Safety Manager PKS Ethernet/Serial
Spirit IT Flow-X

User Scan Task (Database Controller)

Naming rules

User-defined parameter names must follow certain naming rules:
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Parameter names must be unique.

Parameter name can contain up to 255 alphanumeric characters,
with at least one alpha character.
User-defined scanned parameter name can contain up to 180
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alphanumeric characters, with at least one alpha character.

m Parameter names can contain periods (.). However, user-defined
scanned parameters cannot contain periods.

m Parameter names are not case-sensitive.
m Parameter names cannot contain any of the following characters:

e Ampersand (&)

o Asterisk (*)

« Backslash (\)

o Caret(™

« Colon ()

e Comma ()

« Double quote (")

o Forward slash (/)

« Greater than (>)

o Less than (<)

o Number sign (#)

« Percent (%)

o Period () Applies to user-defined scanned parameter names
only. Parameter names can contain periods.

o Question mark (?)
« Semi-colon (;)

« Single quote ()

e Space

o Tab

« Vertical bar (])

Exporting and importing user-defined scanned
parameters

There might be times when you need to export and import user-
defined scanned parameters. For example, to bulk modify multiple
user-defined scanned parameter on multiple points.

168



Chapter 6 - Building and configuring points

169

In these situations, you can copy and paste these parameters to an
Excel spreadsheet. See the topic titled "Copying and pasting items" for
more information.

Adding a scanned analog user-defined parameter

You can add scanned analog user-defined parameters to analog
points and to status points.

To add a user-defined parameter — Scanned analog

1. Select the point for which you want to define the parameter.
2. On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

3. Type the parameter's name in Parameter name.
4. (Optional) Type the associated parameter's name in Associated

Param.

This specifies the name of an internal point parameter to be
associated with the new parameter.

If it is specified, the internal parameter's value tracks the value in
the controller. For example, point alarm limits are kept
synchronized with the alarm limits in a controller.

5. Select Scanned - Analog from the Link type list.

6. Select a security level from the Security Level list.
This configures the minimum security level required for writing
the parameter value.

7. Enter the source address of the parameter in the Source Address
box.

8. Enter the destination address of the parameter in the Dest Address
box.

9. Select a scan period from the Scan Period list.

10. If you selected a scan period of DEMAND, select the Dynamic

Scanning check box to turn on dynamic scanning for this
parameter.

11. Enter the unit of measurement in the Engineering Units box.

12. To raise an external change alarm, select the External Change Alarm
check box.

This will raise an alarm when a point parameter value changes in
the controller, and that change in value was not requested from
the server.
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13. Enter the 100% and 0% ranges of the engineering units in the
100% Range Value and 0% Range Value boxes.

14. Select an appropriate drift deadband from the Drift Deadband (%)
list.

The drift deadband defines what constitutes a significant change
of the Input analog parameter signal. If the change is less than this
drift amount, the new value will not be processed.

15. To clamp the PV, select the Clamp PV check box.

This causes the analog parameter value to be clamped at the user-
defined scanned parameter 0% range if it is less than the PV
clamp low limit. Similarly, the PV will be clamped at at the user-
defined scanned parameter 100% range if it is greater than the PV
clamp high limit.

16. If applicable, select the Reverse check box.

17. Select an appropriate control deadband from the Control Deadband
(%) list.

The control deadband defines what constitutes a good control. If
the PV signal, read back after a control value is issued, does not
reach the {new control value + this deadband} within the control
timeout period, then this results in a control fail alarm being
generated.

18. To support the data type INT8, select the 64 bit Integer Data Type
check box.

If this check box is not selected, the default data type is Double.

Adding a scanned status user-defined parameter

You can add scanned status user-defined parameters to analog points
and to status points.

To add a user-defined parameter — Scanned status

1. Select the point for which you want to define the parameter.
2. On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

3. Type the parameter's name in Parameter name.

4. (Optional) Type the associated parameter's name in Associated
Param.
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10.

11.

12.

13.

14.

15.

This specifies the name of an internal point parameter to be
associated with the new parameter.

If it is specified, the internal parameter's value tracks the value in
the controller. For example, points unit is kept synchronized with a
numeric status value in a controller.

Select Scanned - Status from the Link type list.

Enter the source address of the parameter in the Source Address
box.

Enter the destination address of the parameter in the Dest Address
box.

If you select a scan period of DEMAND from the Scan Period list,
select the Dynamic Scanning check box to turn on dynamic
scanning for this parameter.

Select a scan period from the Scan Period list.

From the Number of States list, select the number of discrete input
states you want to configure.

If applicable, select Reverse options:
o For a 2-state point, reverses the parameter (i.e., Bit 0).

o For a 4-state point, reverses Bit 0 and/or Bit 1. Select the
appropriate check boxes.

o For an 8-state point, reverses Bit 0 and/or Bit 1 and/or Bit 2.
Select the appropriate check boxes.

To raise an external change alarm, select the External Change Alarm
check box.

This will raise an alarm when a point parameter value changes in
the controller, and that change in value was not requested from
the server.

Select a security level from the Security Level list.

This configures the minimum security level required for writing
the parameter value.

In the State Descriptions area, enter descriptors for each state of a
status point. State descriptors may be composed of any 8
alphanumeric characters.

For single-bit status points, two state descriptions must be
specified; for dual-bit status points, four state descriptions, and for
3-bit points, all eight state descriptions are required.

In the Target Input State Associations area, assign target states to
single-, dual-, or 3-bit status points for CLOSED/STOP/OFF and
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OPEN/START/ON output states.
Specify F if you do not wish to assign a state to that OP state.

Adding a scanned string user-defined parameter

You can add scanned string user-defined parameters to analog points
and to status points.

To add a user-defined parameter — Scanned string

1.
2.

Select the point for which you want to define the parameter.

On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

Type the parameter's name in Parameter name.
(Optional) Type the associated parameter's name in Associated

Param.

This specifies the name of an internal point parameter to be
associated with the new parameter.

If it is specified, the internal parameter's value tracks the value in
the controller. For example, point units are kept synchronized with
units in a controller.

5. Select Scanned - String from the Link type list.

Enter the source address of the parameter in the Source Address
box.

Select a scan period from the Scan Period list.

If you select a scan period of DEMAND from the Scan Period list,
select the Dynamic Scanning check box to turn on dynamic
scanning for this parameter.

Adding a custom user-defined parameter

To add a user-defined parameter - Custom

1.
2.

Select the point for which you want to define the parameter.
On the User Defined tab, click Add.
A new unconfigured parameter is added to the list.

Type the parameter's name in Parameter name.
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4. Select Custom from the Link type list.
5. Type a value in the Custom Field field.
6. Select a security level from the Security Level list.

ATTENTION: This parameter type is reserved for future use.

Adding multiple user-defined scanned parameters

You can add multiple instances of user-defined scanned parameters
to analog points and status points using the Add Bulk Scanned button
on the User Defined tab. You can create multiple scanned analog
parameters and multiple scanned status parameters, but only type at
atime.

The maximum number of user-defined scanned parameters you can
add to a point is 200.

To add multiple user-defined scanned parameters —
Scanned analog

1. Click Add Bulk Scanned.
The Add User-defined scanned parameters window appears.

2. Select Scanned - Analog from the Link type list.

3. In the Number of Items box, enter the number of parameters you
want to create.
Out of a maximum of 200, and after the current bulk add is

complete, the remaining number of user-defined scanned
parameters that can be added to the point will be displayed.
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4. Enter name details in the Parameter Name area.

Option ‘ Description

Prefix Enter alphabetical, numeric, and special characters to
form the prefix of every parameter name.

Variable | Choose the type of variable.

. For Numeric, enter the length in the Digits box,
followed by the Start number, and the Step.

. For Letter, enter the starting letter in the Start
box.

Suffix Enter alphabetical, numeric, and special characters to
form the suffix of every parameter name.

\

5. Enter address details in the Source Address area.

Option ‘ Description

Controller | Select a controller from the list.

Prefix Enter alphabetical, numeric, and special
characters to form the prefix of each source
address.

Variable Choose the type of variable.

. For Numeric, enter the length in the Digits
box, followed by the Start number, and the
Step.

. For Letter, enter the starting letter in the Start
box.

Data Enter alphabetical, numeric, and special
Format characters to indicate the format of each source
address.

The data format follows the address, separated by
a space.

Suffix Enter alphabetical, numeric, and special
characters to form the suffix of each source
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Option ‘ Description

address. The value entered is appended
immediately after the variable text without a space.

Note that the suffix can be applied, for example,
when a data format is required to be added to the
addresses.

Copy to Select the check box to copy to the destination
destination | address. This enables read and write access to the
address register in the device.

Option

Scan Period

6. Enter default parameter details in the Defaults area.

‘ Description

Select a scan period from the Scan Period list.

External
Change
Alarm

To raise an external change alarm, select the
External Change Alarm check box.

This will raise an alarm when a point parameter
value changes in the controller, and that change
in value was not requested from the server.

Engineering
Units

Enter the unit of measurement in the Engineering
Units box.

Dynamic If you selected a scan period of DEMAND, select

Scanning the Dynamic Scanning check box to turn on
dynamic scanning for this parameter.

100% Enter the 100% and 0% ranges of the

Range engineering units in the 100% Range Value and

Value 0% Range Value boxes.

0% Range

Value

Drift Select an appropriate drift deadband from the

Deadband Drift Deadband (%) list.

(%)

The drift deadband defines what constitutes a
significant change of the Input analog parameter
signal. If the change is less than this drift amount,
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Option ‘ Description

the new value will not be processed.

Clamp To clamp the PV, select the Clamp Value check
Value box.

This causes the analog parameter value to be
clamped at the user-defined scanned parameter
0% range if it is less than the PV clamp low limit.
Similarly, the PV will be clamped at at the user-
defined scanned parameter 100% range if it is
greater than the PV clamp high limit.

Control Select an appropriate control deadband from the
Deadband Control Deadband (%) list.
(%)

The control deadband defines what constitutes a
good control. If the PV signal, read back after a
control value is issued, does not reach the {new
control value + this deadband} within the control
timeout period, then this results in a control fail
alarm being generated.

7. Inthe History Parameter Options area, enter history assignments
that will be applied to all newly created user-defined scanned
parameters.

Option ‘ Description

Type Select the appropriate to configure Fast, Standard,
Extended, and Exception history.

Collection | For fast, standard, and exception history, choose a
Rate rate from the drop-down list. The rates shown here
are set on a server-wide basis on Station.

Offset When collecting standard and exception history for
TPS points, you can choose an offset rate from the
drop-down list. The rates shown here are seton a
server-wide basis on Station.

PHD Use these boxes to specify PHD collection for fast,
Collection | standard, extended, and exception history.
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8.

Option ‘ Description

. Default = PHD collects history for this point
according to the PHD collection rule.

o Override = PHD overrides the PHD collection
rule and collects history for the point at this
history assignment rate.

. Disable = PHD does not collect history at this
history assignment rate.

It is possible to assign Override to multiple history
assignments for the same point. However, PHD will
collect history assignment at only one rate. To
determine the collection of history to the PHD
server, see the topic titled "PHD collection rule" in

the Hardware and Point Build Reference.

Click OK.

To add multiple user-defined scanned parameters —
Scanned status

1.

Click Add Bulk Scanned.
The Add User-defined scanned parameters window appears.

Select Scanned - Status from the Link type list.

In the Number of Items box, enter the number of parameters you
want to create.

Out of a maximum of 200, and after the current bulk add is
complete, the remaining number of user-defined scanned
parameters that can be added to the point will be displayed.

Enter name details in the Parameter Name area.
Option ‘ Description

Prefix Enter alphabetical, numeric, and special characters to
form the prefix of every parameter name.

Variable | Choose the type of variable.

. For Numeric, enter the length in the Digits box,
followed by the Start number, and the Step.
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Option ‘ Description

. For Letter, enter the starting letter in the Start
box.

Suffix Enter alphabetical, numeric, and special characters to
form the suffix of every parameter name.

\

5. Enter address details in the Source Address area.

Option ‘ Description

Controller Select a controller from the list.

Prefix Enter alphabetical, numeric, and special
characters to form the prefix of each source
address.

Variable Choose the type of variable.

. For Numeric, enter the length in the Digits
box, followed by the Start number, and the
Step.

. For Letter, enter the starting letter in the
Start box.

Data Enter alphabetical, numeric, and special
format/Suffix | characters to form the suffix of each source
address.

Note that the suffix can be applied, for example,
when a data format is required to be added to
the addresses.

Copy to Select the check box to copy to the destination
destination address. This enables read and write access to
address the register in the device.

6. Enter default parameter details in the Defaults area.

Description

Scan Period | Select a scan period from the Scan Period list.
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Option ‘ Description
Number of From the Number of States list, select the number
States of discrete input states you want to configure.
Reverse If applicable, select Reverse options:
. For a 2-state point, reverses the parameter
(i.e., Bit 0).
. For a 4-state point, reverses Bit 0 and/or Bit
1. Select the appropriate check boxes.
. For an 8-state point, reverses Bit 0 and/or
Bit 1 and/or Bit 2. Select the appropriate
check boxes.
Dynamic If you selected a scan period of DEMAND, select
Scanning the Dynamic Scanning check box to turn on
dynamic scanning for this parameter.
External To raise an external change alarm, select the
Change External Change Alarm check box.
Alarm o ] )
This will raise an alarm when a point parameter
value changes in the controller, and that change
in value was not requested from the server.
State In the State Descriptions area, enter descriptors

Descriptions

for each state of a status point. State descriptors
may be composed of any 8 alphanumeric
characters.

For single-bit status points, two state
descriptions must be specified; for dual-bit status
points, four state descriptions, and for 3-bit
points, all eight state descriptions are required.

Target Input
State
Associations

In the Target Input State Associations area, assign
target states to single-, dual-, or 3-bit status
points for CLOSED/STOP/OFF and
OPEN/START/ON output states.

Specify F if you do not wish to assign a state to
that OP state.
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7. In the History Parameter Options area, enter history assignments
that will be applied to all newly created user-defined scanned
parameters.

Option ‘ Description

Type Select the appropriate to configure Fast, Standard,
Extended, and Exception history.

Collection | For fast, standard, and exception history, choose a
Rate rate from the drop-down list. The rates shown here
are set on a server-wide basis on Station.

Offset When collecting standard and exception history for
TPS points, you can choose an offset rate from the
drop-down list. The rates shown here are set on a
server-wide basis on Station.

PHD Use these boxes to specify PHD collection for fast,
Collection | standard, extended, and exception history.

. Default = PHD collects history for this point
according to the PHD collection rule.

o Override = PHD overrides the PHD collection
rule and collects history for the point at this
history assignment rate.

. Disable = PHD does not collect history at this
history assignment rate.

It is possible to assign Override to multiple history
assignments for the same point. However, PHD will
collect history assignment at only one rate. To
determine the collection of history to the PHD
server, see the topic titled "PHD collection rule" in
the Hardware and Point Build Reference.

8. Click OK.

Quick Builder creates the specified number of user-defined scanned
parameters with the settings you chose.

You can change any of the parameters either individually or in bulk.
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Modifying multiple user-defined scanned parameters

To save time and effort, you can modify more than one user-defined
scanned parameter at a time on the same point. For example, you
want to change the engineering units for a series of Scanned - Analog
parameters.

TIP: To change multiple user-defined scanned parameters for
more than one point, you can export the user-defined scanned
parameters to an Excel spreadsheet, make the changes, and
then import them back into Quick Builder. See the section titled
"Exporting and importing user-defined scanned parameters” in
the topic titled "About user-defined scanned parameters” for
more information.

To modifying multiple user-defined scanned
parameters

1. Select two or more user-defined scanned parameters you want to
modify.
Select user-defined scanned parameters of the same type to
increase the number of fields you can change at a time. For
example, select only Scanned — Analog parameters.

Fields with same values appear in the normal state with the same
value; fields with different values appear without values and with a
gray background, which indicates that the value in the fields are
not consistent.

2. Modify the field values as necessary.

You can modify values in fields in the normal state. You can also
modify field values with a gray background. When you do, all fields
will take the new value. However, you cannot modify the Parameter
Name field.

Importing/uploading specialized point
configurations

This topic is only applicable if you have specialized point
configurations and want to import or upload them into Quick Builder.
(Such configurations are generally achieved by manually editing the
point definition file—a process which bypasses Quick Builder.)
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The following table describes what Quick Builder does when you
import or upload specialized point configurations.

Configuration ‘ Result

Point assigned to more | Quick Builder only imports one group number, and the
than one group display | assignment details of the other groups are lost.

Separate gating points | Quick Builder assigns the same gating point to all selected
for each history type on | history types, and the assignments of the other gating
the same parameter points are lost.

Gating points for user- | Quick Builder does not lose the gating point details.
defined parameters However, you cannot change them because they are not
visible on the User Defined tab of the Property Page.

ATTENTION: To import a point build file into Quick Builder, the
"long form" file must be used. Use the -FD flag when running
BCKBLD to generate a long form file if you intend to import the
file into Quick Builder. Typical usage would be BCKBLD -FD.

Specifying point parameter addresses

You must specify the point parameter addresses in a controller's
database so that the server can read from/write to those addresses.
The address syntax is specific to controller type.

ATTENTION: If an SP (set point) address references either a
database file or a point parameter, you must only specify the
SPSOURCE address. (This is because the SPSOURCE and
SPDESTIN fields are the same for database and point
addresses.)

To learn about the address
Go to:

syntax for:

Generic controller "Point parameter address syntax for a generic
controller” on page 65

User scan task controller Point parameter address syntax for a user scan task
controller on page 1

Any other controller Accessing help for a specific controller on page 1
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Using Address Builder

Address Builder makes it easier to specify point parameter addresses
if you don't know its syntax.

To specify an address with Address Builder

1. Click "I to the right of the address box.
The Address Builder dialog box opens.

2. Select the type of address you are defining from Address Type.
A box for each part the address syntax appears in the Details
section.

3. Fillin the Details boxes and click OK. To see the syntax for a
particular controller:

a. Select Controller from Address Type.

b. Select the controller from Controller.

c. Press F1 to call up the help for that controller.
To see the syntax for a:

o Generic controller, see the topic titled "Point parameter address
syntax for a generic controller.”

o User scan task controller, see the topic titled "Point parameter
address syntax for a user scan task controller."
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Configuring the address syntax for a file
1. Configure the syntax parts as shown here:

Part ‘ Description

File The file identification number to which the
address refers.

Record The record in the selected file to which the
address refers.

Word The data word number in the selected record
to which the address refers.

Bit The bit within the selected word to which the
address refers.

Width The number of bits to read/write, starting
with the specified bit.

Format The data format:

. DBLE. Double precision (64-bit) floating
point

. INT2. Short (16-bit) integer
. INT4. Long (32-bit) integer

. REAL. Single precision (32-bit) floating
point number

Controller Name | The controller that scans this address.
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Configuring the address syntax for a point

1. Configure the syntax parts as shown here:

Part ‘ Description

Point Name The name of the point being addressed.
Select the point from the list of points
already added to the project file.

Parameter The point parameter to which this address
applies. Select the parameter from the list.

Controller Name | The controller that scans this address.

(. J

Using Address Builder with an Integrated
Controller connected

Address Builder makes it easier to specify point parameter addresses
if you don't know its syntax.

To specify an address with Address Builder

1. Click =l to the right of the address box.
The Address Builder dialog box opens.

2. Set Address Type.to Controller
A box for each part the address syntax appears in the Details
section.

3. Fillin the Details boxes and click OK. To see the syntax for a
particular controller:
a. Select the controller from Controller.
b. Click zlto the right of the Location box.

A browser window will open enabling the user to browse the
whole of the available address space for the selected integrated
controller type (only applicable for RTU2020 and ControlLogix
integrated controllers, not applicable for ControlEdge PLC).

c. Browse to the required controller location and click Apply
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Automated Point Generation for an Integrated

Controller

This topic describes how to create points automatically for integrated
controllers.

Prerequisites

m The Integrated Controller has been built.

m All required Integration Mappings (standard and customized) have

been imported.

For more information about reviewing which Integration
Mappings have been imported, see “To view the imported
Integration Mappings”.

For more information about importing, see “Importing Integrated
Mappings” and “Creating and Modifying Integrated Mappings”.

To automatically generate points for an integrated
controller

1.

Filter the Quick Builder navigation pane by clicking Controller
Integration.

The navigation pane lists three views:
e Controllers

+ Mappings

¢ Global Mapping Parameters

Select Controllers

The List View displays a list of all the controllers, and integration
type, that have had the controller integration option enabled.

Select the target controller.
The Properties Pane will display the Generate Points view.

Table 6-3: Details of the Generate Points view

Column Description

Controller | List of the variable names, or tag names, found in
Data the selected controller’s Experion Export File
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Column ‘ Description

Integration | The mapping that has been matched for each

Mapping variable name, or tag name, and the point type that

Data will be generated for each. There may be some
instances where more than one mapping has been
matched; in these cases you should select which
mapping is to be used.

Point Data | Names of the points that will be generated
depending on the Action that has been configured.

For more information on each Action, see the
“Actions in the Generate Points view”.

Table 6-4: Actions in the Generate Points view

Location
of drop-

D ipti
down escription

list

Column | Generate | Will set the Action of every visible row to

Header | All Generate.
Reset All | Will set the Action of every visible row to
No Action.

Delete All | Will set the Action of every visible row to
Delete.

Ignore All | Will set the Action of every visible row to
Ignore.

Generate | Will set the Action of every row whose

From variable Name, or Tag Name, matches a

Clipboard | name in the Clipboard (for example,
copied from an Excel spreadsheet or
similar) to Generate.

The clipboard must contain a single
name per line.

Row Generate | This is the default Action for all rows.

A point will be generated or, if it already
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Location
of drop-

down Description

list

exists, modified to match the properties
defined in the matched mapping.

No Action | No action will be taken on this row, no
point will be generated or, if it already
exists, modified. Action can be changed
on a future occasion.

Delete Deletes the point defined by this row
(point will be moved to the Quick Builder
recycle bin)

Ignore This row will be ignored, no point will be

generated. This row will be hidden if Show
Ignored elements option is disabled.

Use this option for internal PLC/RTU
variables for which Experion points are
not required.

Table 6-5: Filter options in the Generate Points view

Filter ‘ Description

Show Enable this option to show all rows where the
ignored Action has been set to Ignore.

elements

The default state is disabled, thus all rows where
the Action has been set to Ignore will be hidden.

Show Enable this option to show all rows where the
unmatched tag, or variable, has not been matched to a
elements mapping.

The default state is disabled, thus all unmatched
elements will be hidden.

Click Compare Points to highlight the differences between the
existing points in the Quick Builder database and all the points in
the Generate Points view for which Action is set to Generate or
Delete..
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4. Click Generate Points button to add points to the Quick Builder
database.

A dialog is displayed allowing the user to select between
generating New and Modified Points or New points only.

New Points are points that have not yet been created in the Quick
Builder database.

Modified Points are points that have previously been created in the
Quick Builder database

The Summary shows how many:

o New points will be generated

« Existing points will be modified
o Points will be ignored

« How many points will be deleted and moved to the recycle bin.

Generate Points applies to all rows in the table where the Action has
been set to Generate or Delete regardless of the two filter options or
any column filters that may have been applied.

To customize Integration Mappings

1. From the Controller Integration navigation pane select Controllers
and then select the target controller.

2. From the Generate Points view click the Customize tab.

The Properties Pane will display Integration Mapping details that
can be edited if necessary.

Section ‘ Description

Available All imported mappings of the same integration
Integration | type as the target controller are listed and enabled
Mappings by default.

If you know that there are some mappings that are
not relevant to the target controller then they can
be disabled in order to reduce the potential
number of multiple matched mappings.

To assist with managing a large list of mappings it
can be filtered and ordered.

Integration | Lists all parameters defined in all the selected
Mapping integration mappings, each with its default value
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Section ‘ Description

Parameters | as defined in the integration mapping.
You can change a value from default if required.

To assist with managing a large list of mapping
parameters each column can be filtered and
ordered.

To simplify managing parameters that are used in
multiple mappings, and that will always be
assigned the same value, you can move them to
the Global Mapping Parameters list. For more
information, see “To create and use Global
Mapping Parameters”.

To view the imported Integration Mappings

1. From the Controller Integration navigation pane select Mappings.

The List View displays a list of all the Integration Mappings that
have been imported.

This list is read-only. For more information on modifying an
Integration Mapping, see “Creating and Modifying Integration
mappings”.

To create and use Global Mapping Parameters

1. From the Controller Integration navigation pane select Global
Mapping Parameters.

The Properties Pane displays a list of all Global Mapping
Parameters.

Global Mapping Parameters have the same name wherever they
are used and will always be assigned the same value. These are
intended for constant properties used across the database, such
as a standard fast and slow scan period that are to be applied
consistently to all points.

2. To move a global mapping parameter to Integration Mapping
Parameters in the Customize tab select the parameter and click
Delete.
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The parameter will be moved from Global Mapping Parameters to
the Integration Mapping Parameters list in the Customize tab.

. To add a global mapping parameter click Add and enter the

parameter name.

The global mapping parameter will be added to the list and
removed from the Integration Mapping Parameters in the
Customize tab.



CHAPTER

BUILDING EQUIPMENT TEMPLATES

You can use equipment templates to quickly and easily build
equipment, such as wells, pumps, generators, and all the associated
items that make up the equipment. These items typically include
points and controllers.

Equipment templates are created in the Equipment Template Builder,
and stored in the Template Library, in Quick Builder. Two sample
templates (including a Well template and a Well Field template) are
provided with Experion, and you can use these templates to create
new templates.

If you modify an equipment template and import the updated
template into Quick Builder, those changes will be applied to all
equipment that has been built using that template. If you delete a
template from the library, you will receive a warning dialog stating
that any equipment based on that template will also be deleted.

In this section:

About building equipment templates ... ... 193
Creating equipment templates ........ ... 194
Configuring equipment templates ... 199
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About building equipment templates

In Configuration Studio, you can create and maintain equipment
templates that define equipment items.

After building a new equipment template, you import it into the
Template Library in Quick Builder where you can use it to create
equipment.

To modify an existing equipment template, you need to open it in the
Equipment Template Builder, make the required changes, and then
import the modified template into the Template Library in Quick
Builder.

The following properties can be configured to define how equipment
based on this template will be viewed in Station:

m Summary view properties, which define the content and layout of
the information on the Equipment Summary display.

m Tabular view properties, which define the content and layout of the
information on the Equipment Detail display.

You can create more than one tabular view in a template and
assign one as the default view for the Equipment Detail display.
For example, the Detail view.

m Trend view properties, which define the content and layout of the
information on a trend display. It will be called up from the
Equipment Detail display.

You can create more than one trend view in a template.
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Layout of the Equipment Template Builder

The following figure shows the layout of the the Equipment Template
Builder.

E Configuration Explorer I Equipment Template Builder[New) | X

@ &)

2

I[tem ‘ Description
1 Visual Editor

Defines the content and layout of views for the equipment to be viewed in
Station.

2 Properties list

Lists all the properties that have been defined to be associated with the
equipment, including point properties and equipment properties.

3 Property Editor

Defines the property details for the relevant item selected in the Visual Editor or
the property selected in the Properties list.

Creating equipment templates

Every equipment item is based on an equipment template. You can
create an equipment template either by:
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m Modifying an existing template and saving it with a new name.

m Creating a new equipment template.

Prerequisite

You have logged in to Configuration Studio with a security level of
SUPV or higher.

Creating an Equipment Template by modifying an
existing template

Equipment templates are comprised of 2 files:

m An EQT file, that describes the data capture and detail part of the
template; and,

m ATYP file that describes the summary part of the template. Each
TYP file can be referenced by multiple EQT files.

When you create a new template based on an existing template you
need to consider both parts of the template. Changes you make to an
existing template, if not implemented correctly, can impact all
templates referencing the TYP file used by that template.

1. From Configuration Studio, choose Control Strategy > Equipment >
Build Equipment Template.

2. From the toolbar, click (= (Open Template).

3. Inthe Open Equipment Template dialog box, locate and select the
template you want to use, then click Open.

The existing template opens in the Equipment Template Builder.
4. Choose File > Save as to open the Save As dialog box.

5. In the File name box, type a unique name for the new template and
click Save.

The new template is created and saved in the template folder.

TIP: If you intend on changing the Summary portion of the
new template, you need to type a different TYP value in the
Equipment Type field. Otherwise, any changes you make to
the summary section of this new template will impact all
other templates that reference the TYP file from the original
template.
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Next steps

You are now ready to add new views and shapes and to configure
your new template. For more information, see:

m "Creating a tabular view" on page 209

m "Creating a trend view" on page 210

m "Working with shapes" on page 1

m "Configuring equipment templates” on page 199.

Creating a new Equipment Template

1. From Configuration Studio, choose Control Strategy > Equipment >
Build Equipment Template.

2. From the toolbar, click (Save) to open the Save Equipment
Template dialog box.

3. In the File name box, type a unique name for the new template and
click Save.
The new template is created and saved in the template folder.

4. Work through each of the views to configure the template.

For more information, see "Configuring equipment templates" on
page 199.

Next steps

You are now ready to add shapes and configure your new template.
For more information, see:

m "Creating a tabular view" on page 209

m "Creating a trend view" on page 210

m "Working with shapes" on page 1

m "Configuring equipment templates” on page 199.

Exporting templates from the Template Library

To make changes to an existing template in the Equipment Template
Builder, you can either edit the template's EQT and TYP files directly,
or you can export the template from Quick Builder and then edit the
files. For both approaches, you need to import the updated template
files into Quick Builder when finished.
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If you want to create a new template based on an existing template,
you can export a similar template from Quick Builder to use as your
starting point.

To export a template from the Template Library to the Equipment
Template Builder:

1. From Configuration Studio, choose Control Strategy > Equipment >
Build Equipment to launch Quick Builder.

2. From the toolbar, click g (Export) to open the Export dialog box.

3. From the Folder for File(s) box, select a folder for the exported
equipment files.

4. In the Base Name for File(s) box, enter a base name for the exported
files.

5. From the Export File Type drop-down list, select Equipment
Template/Type File.

6. Click OK.
The equipment files are exported to the specified folder.

Next steps

Now that you have the existing template in your Equipment Template
Builder folder, you can either modify it and import it back into Quick
Builder, or you can rename it and configure it as a new equipment

template.

Updating equipment by modifying its equipment
template

Every equipment item is based on an equipment template. One of the
major advantages of this defined relationship and hierarchy it
contains is that you can update a large number of equipment items by
simply modifying the template on which they were based.

Prerequisite

You have logged in to Configuration Studio with a security level of
SUPV or higher.

To modify an equipment template:

1. From Configuration Studio, choose Control Strategy > Equipment >
Build Equipment Template to open the Equipment Template Builder.

2. From the toolbar, click
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(= (Open Template) and select a template from your template
folder.

3. Work through each of the views that has been defined for the
Equipment Detail display in the template.
For more information, see "Configuring equipment templates" on
the next page.

4. Select File > Save to save the modified template.

5. To keep the original version of the template intact, you can save
the modified template as a new file by selecting File > Save As...

6. To modify the Summary view, type a new name for Equipment type,
click Copy to save it as a new file for the template.

7. Click OK to save the template, and then import it into the Template
Library for use in Quick Builder.

If there is equipment that will be impacted by the changes to this
equipment template, a dialog box appears listing the equipment
items that will be updated with the template changes. Click OK to
proceed. After you have downloaded the egiupment, and the
equipment items are automatically updated.

Deleting an equipment template

Deleting an equipment template can have an impact on equipment
that has been created based on that template, and on templates that
have inherited data from the template on which they were based.
Make sure that you understand the relationship between the
equipment and templates in your system before deleting any
templates.

Prerequisite

You have logged in to Configuration Studio with a security level of
SUPV or higher.

To delete an equipment template:
1. From the Template Library, select the template to be deleted.

2. Right-click on the equipment template and click Delete.

A message appears asking for confirmation that you want to
delete the template.
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3. Click Yes to proceed.

The system deletes the template, and all content associated with
the template, including:

o Other templates, associated equipment, any contained sub-
equipment and associated items such as controllers and points.

« Inheritance links to any templates based on this template (the
name of the deleted template is removed from the Base
Template field in the template properties).

o Any entries in the Template Library for this template.

If the template cannot be deleted because it is needed for some
equipment or derived templates to continue functioning, a
message is displayed identifying the items in question and the
template is not deleted.

Configuring equipment templates

The Equipment Template Builder contains a Property Editor, where
you can configure the properties of your equipment templates.

This involves configuring views to define the presentation of your
equipment,, and configuring properties to define the data represented
by your equipment items.

TIP: You can use Microsoft Excel to perform batch updates of
some of the template properties. For more information, see
"Editing properties in Microsoft Excel" on page 209.

In this section:

Configuring the Template properties ...............ccooeeeeieeaio.. 200
Creating a Related Equipment table ....................cc............ 202
Configuring Point and Equipment properties .......................... 203
Editing properties in Microsoft Excel ................................... 209
Creating a tabular View ... L 209
Creating a trend VIEW ... L 210
Configuring the SUmMmMary VIeW ... 211
Template Properties .. ... .. 214
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Configuring the Tabular view ..., 217
Summary VIew Properti€s ........ ... 220
Point properties ... .. 222
Equipment Properties ... 224
Shape Properties ... . 227

Configuring the Template properties

The template properties define a template's basic properties.

Prerequisites
m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Creating equipment
templates” on page 194.

To configure the template properties:

1. From the Visual Editor, click the Detail tab to open the Detail view.

2. From the Property Editor, in the tabs Common, Quick Builder, and
Content link groups, configure the properties, using the following as
guidance:

Property ‘ Description

View properties

Name A unique identifier for this view.

Label The text that will appear in Station to identify this view.

Description | A short description of this view.

Content The content link group that the view is associated with.

link group . . . . .
The content link groups are where you group various views in Station.
The groups in the list are defined in the Content link groups tab.

Common
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Property ‘ Description

Name A unique identifier for this template. It is recommended that you use a
prefix, or namespace, to the template name, for example,
Honeywell.OpApps.pipeline, where Honeywell. OpApps is the prefix. The
prefix will prevent this template from overwriting other pipeline
templates.

Label The text that will appear in the Quick Builder Library to identify this
template.

Description | A short description of this template.

Default The name of the view that you want to specify as the default view
view showing on the Equipment Detail display.
Tooltip Text for the tool tip that appears when you hover over this template in

the Template Library.

Quick Builder

Category The category in which this template will be listed in the Quick Builder

Library.
Template Template version is used when the Experion server finds multiple
Version copies of the template. For example, in a Distributed Server
Architecture. In this case, the template with the highest version number
is used.
Show in Indicates whether this template should be visible in the Quick Builder
Library Library. The default value is True.

Content link groups

Content Defines the groups that you can use for grouping various tabular /

link group | trend views together in Station. There are four default values: trend,
schematic, tabular, and related. Each group contains the properties:
Name, Label, and Icon.

Relationships

Name .The name of this relationship. Click a relationship, or click + to add a
new relationship, and the Relationships dialog appears enabling you to
view or edit the relationship properties. For more information, see
"Adding or editing Relationship properties" on page 1
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Property ‘ Description

Enumerations

Name The name of the enumeration available within the template. Click an
enumeration, or click + to add a new enumeration and the
Enumerations dialog appears ebaling you to view or edit the
enumeration value.

Creating a Related Equipment table

A Related Equipment table displays equipment that is related through
a configured relationship. The Equipment Summary of the related
equipment is displayed in the original Equipment's Detail view.

To add a related equipment table:

1. From the Visual Editor, click + (Add a related equipment table) and
select an equipment template file.

2. From the Property Editor, in the Related equipment tab, specify the
following properties for the related equipment summary table:

Property ‘ Description

Equipment | The equipment type that is relevant for this

type relationship.

Table The table that will be displayed for the related
equipment. It is defined in the chosen Equipment
type file.

Label prefix | Text that will be shown before the title text in the
label for this table.

Label suffix | Text that will be shown after the title text in the
label for this table.

Expandable | Indicates whether the table is able to be expanded
/ collapsed. The default value is True.

Hide row Indicates whether the row count indicator is
count visible on the lower left of the related equipment
selection table.

Hide row Indicates whether the row lock indicator and page
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Property ‘ Description

lock navigation buttons are visible on the lower right of
the related equipment table.

Display Enables you to add display elements to the footer

Footer of a relationship table. You can link display
elements from the equipment containing the
relationship table, and this will appear under the
table. You can configure the width of each display
element as required.

Configuring Point and Equipment properties
The Properties list in the Equipment Template Builder has two tabs:

m The Point Properties tab lists the points that have been defined in
an equipment template.

m The Equipment Properties tab defines the equipment properties
for the template. Equipment properties are created as parameters
on the Equipment, rather than the containing points that make up
the equipment. The equipment property may reference another
point parameter.

Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Creating equipment
templates" on page 194.

Configuring Point properties
To configure the properties for a point within an Equipment item:

1. From the Properties list, click the Properties tab to expand the
properties list.

2. Click the Point Properties tab to view the list of existing properties.

TIP: You can type keywords in the Filter field to reduce the
number of properties being displayed.
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3. To add a property to the list, click + in the Properties list.

4. Configure the property details as required, using the following
table as guidance:

‘ Description

Type Specifies the point type.

Valid values are Analog, Status, or String. The default value is Analog.
Point Specifies the name of the point.
Parameter Specifies the parameter for the point.

Description

The description of the parameter.

Data Source

Source Specifies the controller name / address where the parameter value is
Address stored.
Range or Only visible if the Type value is Analog.

Enumeration

Choose to configure either Range or EnumSet.

Range Low Specifies the lower bound of the range. Only visible if the Type value is
Analog and the Range or Enumeration value is Range.

Range High | Specifies the upper bound of the range. Only visible if the Type value
is Analog and the Range or Enumeration value is Range.

Range Units | Only visible if the Type value is Analog and the Range or Enumeration

value is Range.

The name of the engineering units. For example, Gallons, Liters, °F,
and °C.

Enumeration
Set Value

Only visible if the Type value is Analog and the Range or Enumeration
value is EnumSet.

The value part of the enumeration value / string pair.

Enumeration
Set String

Only visible if the Type value is Analog and the Range or Enumeration
value is EnumSet.

The string part of the enumeration value / string pair.
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Property ‘ Description

Number of Only visible if the Type value is Status and the Parameter value is PV or

States OP.
Specifies the number of states you want to configure for status points
related to the selected parameter. Valid values for PV are 2, 4, and 8.
Valid values for OP are 2 and 4. The default value is 2.

State O - The states for status points related to the selected parameter.

State 7

Visualization

Shape Specifies a shape from the list of available shapes. For more
information, see "Shape properties" on page 227.

Display Specifies the name assigned to the shape instance that will be

Element displayed in Station.

Component | From the list of components for the selected shape, select a
component to be linked to the parameter.
Each shape is made up of components (a shape with a single
component will have this blank).

Label Specifies the text that will appear in Station to identify the display

element.

Formatting (Shape related properties, see "Shape properties" on page 227)

Behavior (Shape related properties, see "Shape properties” on page 227)

Source (Shape related properties, see "Shape properties” on page 227)

History (Only visible if the Type value is Analog or Status.)

Enable Fast | Specifies whether the point parameter is assigned to fast history. The
History default value is False.

Enable Specifies whether the point parameter is assigned to extended
Extended history. The default value is False.

History

Enable Specifies whether the point parameter is assigned to standard history.
Standard The default value is False.

History
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Property ‘ Description

Properties

Period The interval, in seconds, the server scans the controller for the
parameter values. The default value is O for no scanning. It can also be
set to an Equipment Property value of the 2-byte Integer type.

Alarms Configure alarm type and priority for Analog parameters and alarm
state priorities for Status parameters.

Algorithm Configure PV algo associated with the point. Only algo20 and algo21
are supported.

Configuring equipment properties
To configure the equipment properties for an equipment template:

1. From the Properties list, click the Properties tab to expand the
properties list.

2. Click the Equipment Properties tab to view the list of existing
properties.

TIP: You can type keywords in the Filter field to reduce the
number of properties being displayed.

w

To add a property to the list, click + in the Properties list.

4. Configure the property details as required, using the following
table as guidance:

Property ‘ Description

Equipment Properties

Type The data type for this equipment parameter. Valid values are:

. 2-byte Integer

. 4-byte Integer

. Floating-point number

. Double-precision number

. Character String
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Property ‘ Description
. Variable String
. Enumeration
Name The unique name of the equipment property.

Description

Specifies the description to be used in Quick Builder for the
equipment property.

Category

Specifies the category that the equipment property will be grouped in
when viewing in Quick Builder.

Data Source

Default Specifies the default value for this equipment property.
Value
Units Specifies the units of measurement for this equipment property

(optional).

Validation Rules

Range
Minimum

Only visible if the Type is Integer or number.

Specifies the lower bound of the range. The value entered here will be
used by Quick Builder as the minimum value accepted for this
equipment property.

Range
Maximum

Only visible if the Type is Integer or number.

Specifies the upper bound of the range. The value entered here will be
used by Quick Builder as the maximum value accepted for this
equipment property.

Length

Only visible if the Type value is Character String or Variable String.

Specifies the maximum length for this equipment property used in
Quick Builder.

For Character String type, the maximum length if 256 characters. For
Variable String types, the maximum string length is 8000 characters.

Class Name

Enforce a type of item, for example, AnalogPoint, or Asset.

Enumeration
Name

The name of the enumeration available within the template. Only
visible if the Type value is Enumeration.
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Property ‘ Description

Visualization

Shape Specifies a shape from the list of available shapes. For more
information, see "Shape properties" on page 227.

Display It is not configured by default for equipment properties. You can
Element configure it by selecting a shape from the list or entering the name in
the Display Element field.

Component | From the list of components for the selected shape, select a
component to be linked to the parameter.

Each shape is made up of components (a shape with a single
component will have this blank).

Label Specifies the text that will appear in Station to identify the equipment
property.

Download Flags

Download Select one or more of the following point build flags to be used when
Flags downloading this equipment property to the server (optional.

. Unique - Indicates whether the value for this equipment
parameter should be unique across all instances of this
parameter in Quick Builder.

. Auto-increment - Indicates whether the default value for this
equipment parameter will be automatically incremented for
each item created in a bulk-build operation in Quick Builder.

. Optional - Indicates whether this equipment parameter will be
optional (or mandatory) when creating equipment based on this
template. If it is not selected (mandatory), the user needs to
enter any mandatory values when instantiating the template.

. Constant Value - Indicates whether this equipment parameter
will be built as a constant on the server. Valid values are True and
False.

. Read-Only - Indicates whether the default value for this
equipment parameter will be ready only in Quick Builder. Valid
values are True and False.
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Editing properties in Microsoft Excel

You can use Microsoft Excel to edit the properties shown in the
Properties list. This section describes how to copy the properties from
the Equipment Template Builder into Microsoft Excel, edit the values
in Microsoft Excel, and then paste the updated properties back to the
Equipment Template Builder.

Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the EqQuipment
Template Builder. For more information, see "Creating equipment
templates" on page 194.

To edit properties in Microsoft Excel:

1. From the Point Properties tab or the Equipment Properties tab, in the
list of existing properties, select the row of properties that you
want to edit in Microsoft Excel.

TIP: Use the CTRL key or the SHIFT key to select multiple
rows.

2. Click & (Copy selected row(s).)

3. Open a new spreadsheet in Microsoft Excel and paste the rows in
the spreadsheet.

4. Edit the property details in the spreadsheet.

TIP: If you create new rows in the spreadsheet to paste into
to the Properties list, leave the first column (ID) blank.

5. Copy the header and the new and/or updated rows and click [El
(Paste row(s)) to paste them into the relevant tab in the EqQuipment
Template Builder.

The Properties list is updated with the pasted rows.

Creating a tabular view

A Tabular view defines the layout of tables on the Equipment Detail
display. After deciding on the layout of the table, you need to
determine which parameters to include in the table.
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Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Exporting templates
from the Template Library" on page 196

To create a tabular view:

1. From the Visual Editor, either use the default View tab provided or
click + to add a new View tab.

2. In the Configure new view dialog box, specify values for the
following properties and click OK.

Property ‘ Description

Name A unique identifier for the view.
Label The text that will appear in Station to identify this
view.

Description | A short description of this table contents.

Group Specifies the Group to use for this Tabular view.
The Group value determines where this new view
appears in the Equipment Detail display in Station.

Select a group from the Group list to assign this
new view to that group.

View type Select Tabular for the view type.

Next steps

You can use the new tabular view to create tables for Detail displays.
For more information about configuring tables and other display
elements for inclusion on Detail displays, see "Creating a Related
Equipment table" on page 202.

Creating a trend view

A Trend view defines the layout and parameters of trends.
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Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Exporting templates
from the Template Library" on page 196

To create a trend view:
1. From the Visual Editor, click + in the toolbar to add a new view tab.
2. In the Configure new view dialog box, specify values for the

following properties and click OK.

Property ‘ Description

Name A unique identifier for this view.
Label The text that will appear in Station to identify this
view.

Description | A short description of this view.

Group Specifies the Group to use for this Tabular view.
The Group value determines where this new view
appears in the Equipment Detail display in Station.

Select a group from the Group list to assign this
new view to that group.

View type Select Trend for the view type.

Next steps

You can use the new trend view to create trends to be displayed in the
Experion App. You can also choose which trends to display Station if
required.

For more information about configuring trend items, see
"Configuring the Trend view" on page 1.

Configuring the Summary view

The Summary view properties define the content and layout of the
table on the Equipment Summary display for the equipment type and
the layout of the related equipment tables for this equipment type.
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This topic describes how to configure the Summary view for an
equipment template using the Equipment Template Builder.

Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Creating equipment
templates” on page 194.

To configure the Summary view:

1. From the Visual Editor, click the Summary tab to open the Summary
view.

The layout of the currently selected Default Table appears.

2. From the Property Editor, specify the following properties for the
Summary view.

TIP: Properties are grouped by the tab on which they

appear.:
Property ‘ Description
Common
Equipment | Specifies the type of the equipment. You can change the default value
type by selecting an existing TYP file, copying the existing layout into a new
TYP file, or creating a new TYP file.
The equipment type is the general type of the equipment, and is used
in the equipment visualization to group equipment into tables of the
same type.
Default From the list of tables configured in the Summary view, specifies
table which table will be shown on the Equipment Summary display.
Version Version is used when the Experion server finds multiple copies of the
equipment type. For example, in a Distributed Server Architecture. In
this case, the equipment type with the highest version number is used.
Summary If selected, and only one row exists in the table, a banner will be
equipment displayed instead of a table.
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Property ‘ Description

The default value is True.

Icon Select the icon associated with the equipment type.

Tables (double-click a table item to display the Define table dialog box)

Name The name of the table.

Label The label of this table that will appear on the EQquipment Summary
display.

Expanded Indicates whether this table is expanded when the display is first

invoked. The default value is True.

Sort binding | Specifies which of the Display Element bindings will be used to sort
the table by default.

Sort The order of the rows in the table, according to the Sort binding Field.
direction Valid values are Ascending or Descending. The default value is Ascending.
Order The order of the equipment type to be shown on the Equipment

Summary display. For example, the equipment type with order 1
appears before the equipment type with order 2. The default value is 1.

If two equipment types have the same order number, the default order
of equipment applies which is based on the equipment type names in
alphabetical order.

Initial page | The number of visible rows to be included in the table.

size

Columns

Label The column header of the table as it will appear on the Equipment
Summary display.

Display Select a display element from the template that will be shown in this

element summary column.

Element The shape used to display the display element.

type

Sort display | For equipment shapes with more than one display element part,
element allows you to select the display element part on which to sort.

For example, the Dual Indicator allows sorting on either the arrow
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value or the bar value.

Visualization

It is only used for the message shape. The valid value is message.

Units Engineering unit to be displayed in the column header.

Width Specifies the width of column in characters.

Visible Specifies whether the column will be visible in the Summary view.
Sortable Specifies whether the column can be sorted.

Filters

Name The name of the filter.

Label The label used to select the filter.

Definition The definition of the filter.

Default sort
order

Specifies the order of the rows to sort the table by default when
applying this filter.

Valid values are Ascending or Descending. The default value is Ascending.

Default sort

column

Specifies which of the columns will be used to sort the table by default
when applying this filter.

Template properties

The Template properties define the template’s basic properties. They
are displayed in the Property Editor after creating or opening a
tabular view.

The following table lists the details of the template properties.

Property Description

View properties

Name

A unique identifier for this view.

Label

The text that will appear in Station to identify this view.

Description

A short description of this view.
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Property

Content link
group

‘ Description
The content link group that the view is associated with.

The content link groups are where you group various views in Station.
The groups in the list are defined in the Content link groups tab.

Common

Name A unique identifier for this template. It is recommended that you use
a prefix, or namespace, to the template name, for example,
Honeywell.OpApps.pipeline, where Honeywell.OpApps is the prefix. The
prefix will prevent this template from overwriting other pipeline
templates.

Label The text that will appear in the Quick Builder Library to identify this

template.

Description

A short description of this template.

Default view

The name of the view that you want to specify as the default view
showing on the Equipment Detail display.

Tooltip

Text for the tool tip that appears when you hover over this template in
the Template Library.

Quick Builder

Category The category in which this template will be listed in the Quick Builder
Library.

Template Template version is used when the Experion server finds multiple

Version copies of the template. For example, in a Distributed Server
Architecture. In this case, the template with the highest version
number is used.

Show in Indicates whether this template should be visible in the Quick Builder

Library Library. The default value is True.

Content link groups

Content link
group

Defines the groups that you can use for grouping various tabular /
trend views together in Station. There are four default values: trend,
schematic, tabular, and related. Each group contains the properties:
Name, Label, and Icon.

Relationships
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‘ Description

Name The name of this relationship.
Label The text that will appear in the Quick Builder Library to identify this
relationship.
Role to The name of the role (relationship) to the related equipment.
Related (Optional, although one of either Role to or Role from must be
Equipment specified.)
Role from The name of the role (relationship) from the related equipment.
Related (Optional, although one of either Role to or Role from must be
Equipment specified.)
Default Default values to be used for the related equipment in this
values relationship. Where the Collection property is set to True, more than
one default can be specified separated by a semicolon.
If the Read only property has been set to True, you must also provide a
value for the Default value.
Valid Lists the valid equipment types for any related equipment. Values
Equipment entered here will populate a list of valid equipment in the Equipment
types Type drop-down list in Quick Builder. Where multiple values are

provided, separate them with a semicolon.

One to many

Indicates whether this relationship can be a one-to-many
relationship. Valid values are True, False. The default value is True.

Read only Indicates whether the related equipment defined by this relationship
can be edited in Quick Builder. Valid values are True, False. If set to
True, you must also define Default values so that the Relationship can
be automatically generated by Quick Builder.

Alarm Indicates whether alarms will be aggregated between this equipment

Aggregation | and its related equipment. Valid values are: No Alarm Aggregation, To

related equipment, From related equipment. The default value is No Alarm
Aggregation.

Enumerations

Name

The name of the enumeration available within the template.

Only valid for Type values of Enumeration.
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Enumeration | The values associated with the named enumeration.

Configuring the Tabular view

The Tabular view properties define the basic properties for each table
that is included in the tabular view. One example of a Tabular view is a
Detail view as represented by a Detail display in Station.

The properties for a Tabular view are displayed in the Property Editor
after creating or opening a table in the Visual Editor.

Prerequisites

m You have logged in to Configuration Studio with a security level of
SUPV or higher.

m You have opened an equipment template in the Equipment
Template Builder. For more information, see "Creating equipment
templates" on page 194.

To create a Tabular view:
1. From the Visual Editor, click the Detail tab to open the Detail view.
2. From the Property Editor, in the View properties tab, specify the

following properties for this view:

Property ‘ Description

Name A unique identifier for this view.
Label The text that will appear in Station to identify this
view.

Expandable | Indicates whether the table is able to be expanded
/ collapsed. The default value is True.

Is Indicates whether the table is expanded by default.
Expanded
Column For the Station view of a template, this setting

specifies the physical position of the table on the
detail display. For example, 1 would result in the
table being positioned in the first column. Read-
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Property ‘ Description
only.

The Experion App (mobile) view of the same
template shows the order of the content as it will
appear in the Experion App.

Row For the Station view of a template, this setting
specifiesthe physical position of the table on the
detail display. For example, 1 would result in the
table being positioned in the first row. Read-only.

The Experion App (mobile) view of the same
template shows the order of the content as it will
appear in the Experion App.

Description | A short description of this view.

Content The content link group that the view is associated
link group | with.

The content link groups are where you group
various views in Station. The groups in the list are
defined in the Content link groups tab.

. From the Property Editor, in the Table tab, specify the following
properties for this table:

Property ‘ Description

Name A unique identifier for this table.
Label The text that will appear in Station to identify this
table.

. From the Visual Editor, click + to add a row for a display element.
. Select the new row, click the Link button to open the Link display
element dialog box.

In the Link display element dialog box, there is a list of options
including New point property and New equipment property followed
by a list of all the existing properties.
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TIP: In the Filter display elements box, you can type keywords
to filter the list.

6. In the Link display element dialog box, choose one of the following
options to link a property to this display element:

To use this option ‘ Complete these steps
Create a new point 1. Select New point property
ropert
property 2. Click OK.
Create a new equipment |1.  Select New equipment property
property .
2. Click OK.
Select an existing display | 1. From the list, select an existing
element display element.
2. Click OK.

The label of the linked item and the shape associated with the
linked item are added to the row. By default, the shape
alphanumeric is associated with a new item.

7. From the Properties list, in the Point Properties tab or the Equipment
Properties tab, select the property that you have linked to the
display element, and then configure the property details either in
the Properties list or the Property Editor.

For more information, see "Configuring Point and Equipment
properties” on page 203.

8. To add more display elements, repeat step 6 to step 7.

9. To add a parameter table in the Tabular view, from the Visual
Editor, click + (Add a parameter table) and repeat step 4 to step 10.

TIP: You can also create a new table by dragging a display
element row from an existing table to the blank area to the
right of the columns or by dragging it over the + (Add a
parameter table) button.
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TIP: You can drag any of the existing parameter tables to
arrange their order and positions to be displayed in this
view.

Summary view properties

The Summary view properties define the content and layout of the
table on the Equipment Summary display for the equipment type and
the layout of the related equipment tables for this equipment type.
The properties are displayed in the Property Editor after opening the
Summary view in the Visual Editor.

The following table lists the Summary view properties.

Property ‘ Description

Common

Equipment | Specifies the type of the equipment. You can change the default value

type by selecting an existing TYP file, copying the existing layout into a new
TYP file, or creating a new TYP file.
The equipment type is the general type of the equipment, and is used
in the equipment visualization to group equipment into tables of the
same type.

Default From the list of tables configured in the Summary view, specifies

table which table will be shown on the Equipment Summary display.

Version Version is used when the Experion server finds multiple copies of the
equipment type. For example, in a Distributed Server Architecture. In
this case, the equipment type with the highest version number is used.

Summary If selected, and only one row exists in the table, a banner will be

equipment displayed instead of a table.
The default value is True.

Icon Select the icon associated with the equipment type.

Tables

Name The name of the table.

Label The label of this table that will appear on the Equipment Summary

display.
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Expanded

Indicates whether this table is expanded when the display is first
invoked. The default value is True.

Sort binding | Specifies which of the Display Element bindings will be used to sort
the table by default.

Sort The order of the rows in the table, according to the Sort binding Field.

direction Valid values are Ascending or Descending. The default value is Ascending.

Order The order of the equipment type to be shown on the Equipment
Summary display. For example, the equipment type with order 1
appears before the equipment type with order 2. The default value is 1.
If two equipment types have the same order number, the default order
of equipment applies which is based on the equipment type names in
alphabetical order.

Initial page | The number of visible rows to be included in the table.

size

Columns

Label The column header of the table as it will appear on the Equipment
Summary display.

Display Select a display element from the template that will be shown in this

element summary column.

Element The shape used to display the display element.

type

Sort display
element

For equipment shapes with more than one display element part,
allows you to select the display element part on which to sort.

For example, the Dual Indicator allows sorting on either the arrow
value or the bar value.

Visualization

It is only used for the message shape. The valid value is message.

Units Engineering unit to be displayed in the column header.
Width Specifies the width of column in characters.
Visible Specifies whether the column will be visible in the Summary view.
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Sortable Specifies whether the column can be sorted.
Filters

Name The name of the filter.

Label The label used to select the filter.

Definition The definition of the filter.

Default sort | Specifies the order of the rows to sort the table by default when
order applying this filter.

Valid values are Ascending or Descending. The default value is Ascending.

Default sort | Specifies which of the columns will be used to sort the table by default
column when applying this filter.

Point properties

The Point Properties tab lists all the points that have been defined
within the template.

After clicking a point from the Point Properties tab, you can configure
the following property details in the Property Editor.

Property Description

Point Properties

Type Specifies the point type.

Valid values are Analog, Status, or String. The default value is Analog.

Point Specifies the name of the point.

Parameter Specifies the parameter for the point.

Description The description of the parameter.

Data Source

Source Specifies the controller name / address where the parameter value is
Address stored.
Range or Only visible if the Type value is Analog.
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‘ Description

Choose to configure either Range or EnumSet.

Range Low Specifies the lower bound of the range. Only visible if the Type value is
Analog and the Range or Enumeration value is Range.

Range High | Specifies the upper bound of the range. Only visible if the Type value
is Analog and the Range or Enumeration value is Range.

Range Units | Only visible if the Type value is Analog and the Range or Enumeration

value is Range.

The name of the engineering units. For example, Gallons, Liters, °F,
and °C.

Enumeration
Set Value

Only visible if the Type value is Analog and the Range or Enumeration
value is EnumSet.

The value part of the enumeration value / string pair.

Enumeration

Only visible if the Type value is Analog and the Range or Enumeration

Set String value is EnumSet.
The string part of the enumeration value / string pair.
Number of Only visible if the Type value is Status and the Parameter value is PV or
States OP.
Specifies the number of states you want to configure for status points
related to the selected parameter. Valid values for PV are 2, 4, and 8.
Valid values for OP are 2 and 4. The default value is 2.
State O - The states for status points related to the selected parameter.
State 7

Visualization

Shape Specifies a shape from the list of available shapes. For more
information, see "Shape properties" on page 227.

Display Specifies the name assigned to the shape instance that will be

Element displayed in Station.

Component | From the list of components for the selected shape, select a

component to be linked to the parameter.

Each shape is made up of components (a shape with a single
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Property ‘ Description

component will have this blank).

Label Specifies the text that will appear in Station to identify the display
element.

Formatting (Shape related properties, see "Shape properties" on page 227)

Behavior (Shape related properties, see "Shape properties" on page 227)

Source (Shape related properties, see "Shape properties" on page 227)

History (Only visible if the Type value is Analog or Status.)

Enable Fast | Specifies whether the point parameter is assigned to fast history. The
History default value is False.

Enable Specifies whether the point parameter is assigned to extended
Extended history. The default value is False.

History

Enable Specifies whether the point parameter is assigned to standard history.
Standard The default value is False.

History

Properties

Period The interval, in seconds, the server scans the controller for the

parameter values. The default value is O for no scanning. It can also be
set to an Equipment Property value of the 2-byte Integer type.

Alarms Configure alarm type and priority for Analog parameters and alarm
state priorities for Status parameters.

Algorithm Configure PV algo associated with the point. Only algo20 and algo21
are supported.

Equipment properties

The Equipment Properties tab displays all the equipment properties that
have been defined within the template.

After clicking an equipment property from the Equipment Properties
tab, you can configure the following property details in the Property
Editor.
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Equipment Properties

Type The data type for this equipment parameter. Valid values are:

. 2-byte Integer

. 4-byte Integer

. Floating-point number

. Double-precision number
. Character String

. Variable String

. Enumeration

Name The unique name of the equipment property.

Description Specifies the description to be used in Quick Builder for the
equipment property.

Category Specifies the category that the equipment property will be grouped in
when viewing in Quick Builder.

Data Source

Default Specifies the default value for this equipment property.

Value

Units Specifies the units of measurement for this equipment property
(optional).

Validation Rules

Range Only visible if the Type is Integer or number.

Minimum
Specifies the lower bound of the range. The value entered here will be
used by Quick Builder as the minimum value accepted for this

equipment property.

Range Only visible if the Type is Integer or number.

Maximum . )
Specifies the upper bound of the range. The value entered here will be

used by Quick Builder as the maximum value accepted for this
equipment property.
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Length Only visible if the Type value is Character String or Variable String.

Specifies the maximum length for this equipment property used in
Quick Builder.

For Character String type, the maximum length if 256 characters. For
Variable String types, the maximum string length is 8000 characters.

Class Name | Enforce a type of item, for example, AnalogPoint, or Asset.

Enumeration | The name of the enumeration available within the template. Only
Name visible if the Type value is Enumeration.

Visualization

Shape Specifies a shape from the list of available shapes. For more
information, see "Shape properties” on the next page.

Display It is not configured by default for equipment properties. You can
Element configure it by selecting a shape from the list or entering the name in
the Display Element field.

Component | From the list of components for the selected shape, select a
component to be linked to the parameter.

Each shape is made up of components (a shape with a single
component will have this blank).

Label Specifies the text that will appear in Station to identify the equipment
property.

Download Flags

Download Select any of the following point build flags to be used when
Flags downloading this equipment property to the server (optional).

. Unique - Indicates whether the value for this equipment
parameter should be unique across all instances of this
parameter in Quick Builder.

. Auto-increment - Indicates whether the default value for this
equipment parameter will be automatically incremented for
each item created in a bulk-build operation in Quick Builder.

. Optional - Indicates whether this equipment parameter will be
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optional (or mandatory) when creating equipment based on this
template. If it is not selected (mandatory), the user needs to
enter any mandatory values when instantiating the template.

. Constant Value - Indicates whether this equipment parameter
will be built as a constant on the server. Valid values are True and
False.

. Read-Only - Indicates whether the default value for this
equipment parameter will be ready only in Quick Builder. Valid
values are True and False.

Shape properties

Depending on the shape selected from the Shape list in the

Visualization tab, only the properties that associated with this shape

will be shown in the tabs Formatting, Behavior, Source, and Command.

The following table lists all the shape-related properties.

Property ‘ Description

Formatting

Indicate Bad | If True, Station overrides the current color to indicate a bad value,

State such as a bad quality, OOS, or a lost value. The bad state color is
defined in the station.ini file. The default value is False.

Indicate If True, Station overrides the current color with the system-defined

Scan State color for 'off-scan'. The default value is False.

Indicate If True, Station overrides the current color with the system-defined

NaN State colors to indicate the bound data's NaN quality state. The NaN state
color is defined in the station.ini file. The default value is True.

Show Specifies whether to include milliseconds for time or date-time

Milliseconds

presentation types.

Duration
Format

Specifies the date time format for duration presentation type, for
example, D HH:MM:SS.

Date Format

Specifies the date format for date and date-time presentation types,
for example, Short date, long date.

Time

Specifies the time format, for example, HH:MM:SS.
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Format

DateTime Select the format type to be displayed, for example, Date format, Time

Format format.

Numeric Specifies the format of value for numeric or hexadecimal presentation

Display types.

Format

Display Specifies the display value to show for values which are NaN.

Value for

NaN

Conditional | Changes the text color based on the value. Can set ranges, for

Text Color example, O-2: green,3-5: blue; or integer values, for example, 1:blue.
Can set to color names, or hex values. Can use the color palette to
select a color for each range.

Help Summary text for the faulthelp or alarmhelp shape.

Summary

Help Details | Detail text for the faulthelp or alarmhelp shape.

Inverse If itis set to true, O is used as the true value and everything else is false.

Logic

9 If it is set to false, O is used as the false value and everything else is

true.

State Maps values to the states for shapes. Multiple inputs should be

Mapping entered in value pairs separated by the comma key. For example,
0:Good,1:Marginal.

Fill Color Fill the color of the shape component, for example, the progress bar
part of the Banner Value shape.

Visible Configures the fill starting point of the indicator.

Range

Origin

Visible Configures the lower bound of the indicator.

Range Low

Visible Configures the upper bound of the indicator.

Range High
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Icon Indicates the path of an icon to be displayed. Station’s search paths
are used to locate the icon file on disk.

Auto Scale If enabled, causes the trend to scale to the range of the plot data

Trend automatically. This setting overrides any other range defined.

Parameter Sample offset for the right most sample in the trend. The larger the

Offset offset, the further back in history the first sample retrieved will be.

Parameter The number of samples to be shown for each plot.

Offset Count

Parameter The history interval for the retrieved data. Valid values are:
Offset
Interval « 1 minute history (snapshot)
. 6 minute history (average of H1M)
. 1 hour history (average of H1M)
. 8 hour history (average of H1M)
. 24 hour history (average of H1M)
. Fast history
. 1 hour history (snapshot)
. 8 hour history (snapshot)
. 24 hour history (snapshot)
Summary The label to show on the summary card.
Card Label
Behavior
Enable Indicates whether to invoke a faceplate for the associated point. The
Faceplate default value is True.
Enable Indicates whether to invoke a Parameter view for the associated point.
Parameter The default value is True.
View
Enable Indicates whether to invoke a popup for the associated point, where
Popup you can specify the point’s properties. The default value is True.

Parameter

The name of the Parameter view that will be invoked if the value of
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Linked View | Enable Parameter View is True.

Name

Popup The name of the popup file that will be invoked if the value of Enable
Display File | Popup is True.

Source

Security The security level required for a user to be able to edit the value of or
Level control this display element. Valid values are Read-Only, Operator,

Supervisor, Engineer, Manager. The default value is Operator.

Presentation | The type of data to be presented. Affects how formatting attributes will
Type be applied.

Alarm Mode | The mode to use for finding the alarm state. Values are Aggregated or
Local. Aggregated is intended to be used on an alarm count
representing the entire row. Local is intended to be used on an alarm
count for a specific cell.

Include Specifies whether the value is displayed for the shape.
value

Include unit | Specifies whether the units are displayed for the shape.

Include Specifies whether the alarms are displayed for the shape.

alarm

Include Specifies whether range minimum and range maximum are displayed
range for the shape.

Command

Action The action to use for this command. Valid values are Navigate Internal,

Navigate External, and Custom.

View The view to use for this command.

Url The URL to use for this command.

Custom The custom action to be executed for this command.
Action

Value The value to use for this command.
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CHAPTER

8 BUILDING AND CONFIGURING EQUIPMENT

Equipment is the collective term used in Experion to represent a real
world piece of equipment at a site, such as a well, pump, or generator.
Equipment Templates are a quick and easy way to create equipment
with a predefined set of associated items such as points and
controllers.

This section outlines how to use Quick Builder to build and configure
equipment.

In this section:

Building equipmMeNnt ... o 233
Importing equipment templates to the Template Library ........... 234
Modifying equipment properties ... 235
Configuring equipment relationships ... i . 239
Assigning equipment to a different asset ............................... 240
Deleting equUIpMENt ... .o L 240
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Building equipment

To build new equipment

1. Use one of the following options to build a new piece of

equipment:

Option

From the
Quick Builder
Library, drag
and drop an
Equipment
Template into
the List View.

‘ Result

The new piece of equipment appears in the List
View, and the properties tabs enable you to
complete the configuration of the new
equipment.

Click E}

The Add Item(s) dialog box appears.

1.

In the Number of Items field, type the
number of equipment items you would
like to create. This field defaults to 1.

From the Item Family list, select the
applicable family. This field might be pre-
populated depending on the context of
any selection made prior to clicking the
Add Item icon.

From the Item Type list, select Equipment.

In the Name text box, type in the name for
this equipment, or you can accept the
default provided.

If you have chosen to create more than one
equipment item, extra fields are provided
where you can choose to add a prefix and/or
suffix to the names generated for the
equipment, therefore making them unique.
The prefix and suffix values can be
alphabetical or numeric.

If the Equipment Template is configured to
provide a default template name, this
template derived value will override any text
that you enter here.
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5. Click OK to add the equipment to the list.

2. Provide values for any properties without a default value that have

been defined by the template as 'required'. These are indicated as
mandatory fields.

Use the rest of the properties tabs to configure the equipment.

Depending on what has been configured in the template for this
equipment, many of the properties may be pre-populated, and a
number of associated items will also be automatically generated.

If, for some reason, the equipment cannot be created successfully
a dialog will be displayed explaining of the error encountered. One
example of this might be that the new equipment cannot create an
associated item because the item's name clashes with an existing
item that is already associated with another equipment item.

Importing equipment templates to the
Template Library

After creating or updating a template in the Equipment Template
Builder, you need to import it into the Template Library in Quick
Builder.

Prerequisite

You have logged in to Configuration Studio with a security level of
SUPV or higher.

To import a template into the Template Library:

1.

From Configuration Studio, choose Control Strategy > Equipment >
Build Equipment to launch Quick Builder.

From the toolbar, click @ (Import) to open the Select File to Import
dialog box.

Locate and select the template you want to import.

NOTE: A template includes an EQT file defining the various
tabular / trend views in the template and a TYP file defining
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e Equipment Summary display, you need to import both
the files.

4. Click OK.

If any items will be updated when this template is imported, a
dialog appears listing them.

. Click OK to proceed with the template import.

If the template already exists in the library, it is overwritten by the
imported template.

Any items impacted by this template are automatically updated
with the template changes.

Modifying equipment properties

Modifying equipment properties is the same as modifying properties
for any other Quick Builder item.

1. Select an equipment item from the navigation pane or the List

view.

. Use the properties tabs to modify the equipment item. The

properties tabs provided are specific to the equipment type and
can contain tabs including Details, Point References, Associated
ltems, and Relationships.

Quick Builder validates the changes you have made according to
the rules for the template used to create this equipment item, and
highlights any changes that are invalid.

Depending on the equipment template's configuration, property
changes are propagated to Point References and Associated
items. Where a template rule uses an equipment's property value
to control an associated item's parameter, that parameter will be
overwritten every time the equipment parameter is modified.
Usually as a result of the user modifying the equipment value, but
also when the equipment item is imported, uploaded or pasted
into Quick Builder.

. When you have finished, you need to download the changes to the

Experion server. Depending on the rules contained in the template
for associated items, the changes will filter through to any
associated items for this equipment item as appropriate.
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Details for an Equipment item

The Details properties tab contains parameters that define basic
details for the equipment. Anything that is controlled by the
Equipment Template will be predefined and cannot be changed.

‘ Description

The name of this equipment item.

Description

A short description of the equipment item.

Associated asset | The asset to which this equipment item is assigned. Select the

Browse button to display the Asset Browser, from where you can
select an asset.

Template

The Equipment template on which this equipment is based.

Equipment properties

Template defined properties specific to equipment built from that template.

Label The text that will appear in Quick Builder to identify the equipment
property.

Name The name for this equipment item, as defined in the Equipment
Template Builder.

Value The value for this equipment item. If you change this value, it will
be validated according to any rules imposed by the Equipment
Template.

Units The units of measure for this equipment parameter (optional).

Point references for an Equipment item

Point References enable a point’s parameters to be available as
equipment parameters. The Point References tab lists the equipment
parameters created for this equipment which you can use to control
the points through the equipment.

The referenced point can be any SCADA or CDA point on the same
server as the equipment point, whether it has been created
automatically as an associated item or was preexisting. Note that each
SCADA or CDA point can only be referenced from a single equipment
point. For example, a SCADA point referenced by a particular meter
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equipment point cannot be referenced by another meter equipment
point.

TIP: Note that the values on this tab are READONLY. They are
defined by the template, and depending on the template
configuration may be updated as a consequence of changing
the value of equipment parameters in the Details tab.

Property ‘ Description

Alias The name of the equipment parameter to hold the point reference.
Point The name of the point being referenced.

Alarm Indicates whether any alarms on this point should be aggregated to

Aggregation | the equipment. Valid values are True and False.

Associated items for an Equipment item

The Associated Items tab lists the items that have been automatically
generated for this equipment item. This can include items such as
controllers and points. The following table lists the details shown for
each associated item.

Property ‘ Description

ltemName

The name of the associated item.

Description

A description of the associated item, for example, Flow meter 1.

Family

A grouping used to categorize the associated items. For example, all
Analog, Status and Accumulator points will appear under a Family of
Point.

Relationships for an Equipment item

When creating Equipment Templates, you can define relationships to
help make working with equipment much more efficient and effective.

A relationship between equipment items means that information is
shared and can be accessed from any equipment item that is part of
that defined relationship. This information can include:

m Alarm details — alarms can be aggregated to appear on the
equipment detail displays of other equipment items.
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m Key parameter values — from one equipment detail display you can
view the real time values for key parameters of related equipment.
You can also create scripted calculations enabling you to see
things like averages and accumulations across your related
equipment.

You can also navigate easily between related equipment by using the
navigation aids provided in the header of the equipment detail display
for any of the related equipment items.

The Relationships tab contains information about the template
defined relationships between this equipment item and other
equipment items.

Property ‘ Description

Relationship

A list of the defined relationship types that can be added to this
equipment item (defined by the Equipment Template).

Related A field where the item name of related equipment can be entered. The
Equipment | list contains equipment already configured in the Quick Builder
database for the selected Relationship.
Role “From” | The first equipment in this relationship.
Role “To” The second equipment in this relationship.
Equipment | Name of the equipment point's parameter used to store the
Parameter relationship. The parameter value identifies the Related Equipment.
For example if you define a Pod relationship with these values:
o Well name is WellOO1
. Equipment Parameter is POD
. Related Equipment is Pod00O1
You can access the related Pod via WellOO1 using WellOO1.POD, which
will have a value of Pod0O1.
Alarm Defines whether the alarms should aggregate to or from the related

aggregation

equipment.

Related
Equipment

The name of the equipment that you want to be listed as Related
Equipment for this equipment item. The drop down list contains
equipment contained in the database of the role defined in the Role
“To” column. If the equipment you wish to create the relationship is

238



Chapter 8 - Building and configuring Equipment

239

Property Description

not in the Quick Builder database it will not be listed and you will need
to type its name in the field provided.

Configuring equipment relationships

The types of relationships that can be configured for an equipment
item are defined in the equipment's template. The Relationships tab
can be used to configure the equipment items for the selected
equipment.

To add equipment to a relationship

1.

From the List View, select the equipment item for which you want
to configure a relationship.

Select the Relationships tab.

Listed are the relationship types that have been defined for this
equipment.

For each relationship type, select the equipment you want to
include in this relationship from the Related Equipment list. The list
contains equipment already configured in the Quick Builder
database that can be chosen for the selected Relationship.

To add extra relationships (for those relationship types that allow
multiple relationships), use the Add Related Equipment fields
provided at the top of the table.

a. Select the relationship type from the Relationship list.

b. Select the name of the equipment you want to include in this
relationship from the Related Equipment list. The list contains
equipment already configured in the Quick Builder database
that can be chosen for the selected Relationship.

c. Click Add.

The relationship is added to the table with the other
relationships of this type.

Download your changes to the server to view the relationships in
the Related Equipment table on the detail display for this equipment
item.
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Assigning equipment to a different asset

You can move equipment items from one asset to another by using a
standard drag and drop action. Associated items for that equipment
item will also be updated automatically.

To assign an equipment item to a different asset

1.
. Select the Equipment node.

In the navigation pane, select All Items.

In the List View, select the equipment item you want to assign to a
different asset.

On the Details tab, click the Browse button next to the Associated
Asset field to display the Asset Browser.

Select the Asset you wish to assign the equipment to, then click OK.
The equipment is assigned to the new asset.

Deleting equipment

Deleting equipment is the same as deleting any other Quick Builder
items, but will also result in any sub-equipment or associated items
being deleted.

To delete equipment

1.

From the All Items view in the Navigation pane, select the
Equipment node.

Defined equipment items are displayed in the List View.

Select the equipment item to be deleted.

Use one of the following methods to delete the equipment:

a. Pressthe Delete icon on the Toolbar.

b. From the menu bar, select Edit > Delete.

c. Right-click on the equipment item and click Delete.

A confirmation dialog box is displayed, stating that the equipment
item and any included sub-equipment will be deleted.

Click OK to proceed.

The equipment item is moved to the Recycle Bin.
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CHAPTER

BUILDING ELECTRONIC FLOW
MEASUREMENT (EFM)

This section outlines how to build and manage Electronic Flow
Measurement (EFM) components using Quick Builder.

In this section:

Building EFM meters ... e 243
Managing EFM meter templates ... . 247
Defining EFM CSV data export formats ..o .. 298
Defining the monthly export format ... .. ..., 301
Managing EFM schedules ... ... .. 302
Managing meters and meter templates .................................. 304
Uploading EFM configurations from the server ........................ 305
Exporting and importing EFM configurations .......................... 306
Collecting and exporting EFM data ... ... 306
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Building EFM meters

To build a new EFM meter, do one of the following:

Option ‘ Result
1.  Ensure that List View is displaying EFM | The new meter appears in the List View,
Meters. and the properties tabs enable you to
complete the configuration of the new
If necessary, select EFM Meters from the | io/
Navigation pane.
2. From the EFM Meter section within the
Library, drag and drop the meter item
into the List View.
Click E+ The Add Item(s) dialog box appears.
1 In the Number of items to Add text

box, type the number of meters
you want to add.

2. From the Item Family list, select
EFM Meter.

3. From the Item Type list, select
EFM Meter.

4, In the Name text box, type in the

name for this meter, or you can
accept the default provided. If
you have chosen to create
multiple meters, the Multi - Items
section is enabled, and you can
provide a prefix for all the
meters, or you can accept the
default provided. You can also
indicate whether to use a
sequential number or letter to
differentiate between the meters.

5. Click OK to add the meter(s) to
the list.

Use the properties tabs to configure each meter by first highlighting it
in the List View.
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To edit an EFM meter

1. Select EFM Meters from the Navigation pane.

A list of meters appears in the List View, with the first meter
selected.

2. Select the meter you want to edit.

The meter appears in the List View, and the properties tabs enable
you to edit the configuration of the meter.

Main properties for an EFM meter

The Main tab defines the basic properties for a meter.

Property ‘ Description

Tagname

The tag name of the meter. In most cases, the meter number is also
used as the tag name. This text box is read-only.

Meter
Number

The unique identifier of the meter.

Third-party flow analysis applications use the meter number to
uniquely identify the meter.

Description

(Optional) A description of the meter. A maximum of 132
alphanumeric characters, including spaces.

Meter
Template

The template to which this meter is linked. The meter template
specifies which logs can be collected and defines data export
definitions. Choosing a meter template updates the following read-
only fields, which are configured in the meter template:

. Flow Computer = The name of the flow computer.
. Protocol = The communications protocol used.
. Meter Type = The type of EFM meter used.

. Run Number = The run number used. A controller or flow
computer may be connected to multiple flow meters. Each of
these connections is termed as a run and is identified by a run
number.

. Other Descriptions = Any other description about the meter
template when it was built.

If already selected, the controller type determines which meter
templates appear in this list.
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Property ‘ Description
Click & to view or edit the meter template.

Controller The name of the controller to which this meter is attached.
If already selected, the meter template determines which controllers
appear in this list.

Associated Defines scope of responsibility (SOR) access to the meter. If left blank,

Asset the meter will have the same SOR as its associated controller.
Click I to display the Asset Browser so that you can choose an
associated asset.

Meter The physical location of this meter.

Location

Item Type The type of item specified when this meter was created. For example,
EFM Meter.

Last The date and time the meter properties were last modified.

Modified

Last The date and time the meter was last downloaded to the server.

Downloaded

Collection and export properties for an EFM meter

The Collection and Export tab defines the collection logs, export logs,
and schedules for a meter.

Property ‘ Description

Collect
data

The types of logs to collect for this meter. The available choices are
defined on the meter template.

» Configuration (this log is always collected)
« Configuration Record Log

« Interval Log

« Daily Log

« Alarm and Event Log

« Alarm Log

« Event Log

o Audit Log
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Property ‘ Description

« Ultrasonic Log

« Composition Log
« Gas Quality Log

« Liquid Batch Log

ATTENTION: When collecting data from a Spirit IT Flow-X meter,
only records from the last 31 days are collected. Records older
than 31 days are not collected.

Export The types of file export formats. Each meter template associated with
Formats this meter can define up to three export formats.

Collection | The full collection and export schedule assigned to this meter.
and
Export
Schedule

A full collection and export schedule is mandatory.

Select Create new Schedule from the Schedule Type list to create a new
schedule.

Enter the time of day in the At box you want the full collection and export
to run.

ATTENTION: A maximum of 60 EFM log collections per channel
per minute can be supported for each meter, so it is
recommended that you spread collection time over an
appropriate period.

If your system needs to account for Daylight Savings Time (DST),
you might need to adjust the time of the Daily Log schedule by one
hour for affected meters during DST. This is because some meters
do not support DST and they will collect the Daily Log one hour
earlier or later than required.

During a system time change when clocks are put back, you might
be required to disable EFM collection for that period for some
EFM interfaces (for example, Spirit IT Flow-X).

Additional | The additional collection schedule assigned to this meter.

Interval
Collection An interval collection is optional. Use it to help distribute the load of

Schedule | collection, such that the load on the Collection and Export Schedule is
reduced.
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Property | Description

Select Create new Schedule from the list to create a new schedule.

Enter the time of day in the At box you want the interval collection to run.

Managing EFM meter templates

You can choose to build a new meter template or import and modify
the sample EFM meter templates that ship with Experion. The sample
EFM meter templates support the following meter types:

ControlWave Flow Computer

Bristol Babcock DPC 3330 Flow Computer

NuFlo Cameron Scanner 2000, with and without expansion boards
Spirit IT Flow-X Flow Computer

Fisher ROC Flow Computer

ABB TotalFlow Flow Computer

ControlEdge RTU Flow Computer

Omni Enhanced Flow Computer

To import sample EFM meter templates

1.

In Quick Builder, click File>Import.
The Select file to import dialog box appears.

Navigate to <data folder>\Honeywell\Experion
PKS\client\user\efm.Where <data folder> is the location where
Experion data is stored.

For default installations, <data folder> is C: \ProgramData. The
C:\ProgramData folder is a system folder, which means that it is
only visible if you select the Show hidden files, folders, and drives
option button in the Folder Options dialog box. To change this
setting in Windows Explorer, click Organize > Folder and search
options, and then click the View tab.

Select the appropriate EFM template for the interface you want
(for example, Sample_EFM_Items.efmdb.xml for the Enron Modbus
template), and then click OK.
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Quick Builder imports the selected sample meter templates,
including schedules, into the project.

The two sample EFM meter templates are titled Sample Cam Scan
and Sample Cam Scan Expansion Board. The difference between the
two templates is that the Rollover value in the Interval Log contains
different values for scanners with and without expansion boards.

The schedules appear in the following table.

Sample Schedules

Interval between

Schedule name Period Retries :
retries

Daily, 1 retry 1 Day 1 30 minutes
Daily, 3 retries 1 Day 3 30 minutes
Daily, 5 retries 1 Day 5 30 minutes
Every 2 hours, 2 2 Hours | 2 20 minutes
retries

Hourly, 1 retry 1 Hour |1 10 minutes
Hourly, 2 retries 1 Hour |2 10 minutes
Twice Daily, 3 retries | 12 3 30 minutes

Hours

ATTENTION: The same schedules are created for all meter
templates.

4. Click OK to dismiss the Results dialog box.
5. Edit the sample meter templates and schedules as necessary.

To build a new EFM meter template, do one of the

following:
Result
From the EFM The new meter template appears in the List View, and the
Meter Template properties tabs enable you to complete the configuration of the
section within new meter template.

the Library, drag
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Option ‘ Result

and drop the

meter template

item into the List

View.

Click E The Add Item(s) dialog box appears.

1. In the Number of items to Add text box, type the number of
meter templates you want to add.

2. From the Item Family list, select EFM Meter Template.

From the Item Type list, select EFM Meter Template.

4, In the Name text box, type in the name for this meter
template, or you can accept the default provided. If you have
chosen to create multiple meter templates, the Multi - Items
section is enabled, and you can provide a prefix for all the
meter templates, or you can accept the default provided.
You can also indicate whether to use a sequential number
or letter to differentiate between the meter templates.

5. Click OK to add the meter template(s) to the list.

Use the properties tabs to configure each meter template by first
highlighting it in the List View.
To edit an EFM meter template, do one of the
following:

Option ‘ Result

Select EFM Meter
Template from the
Navigation pane.

A list of meter templates appears in the List View, with the
first meter template selected.

1. Select the meter template you want to edit. The
meter template appears in the List View, and the
properties tabs enable you to edit the configuration
of the meter template.

From the Main tab of an
EFM meter, click L next

to the Meter Template list
box.

The Edit EFM Meter Template dialog box appears.

1 Edit the configuration properties on each of the
tabs.
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‘ Result

2. Click Apply to save the changes.

If the meter template you are changing is used by
other meters, a message appears to that effect. Click
Continue to save the changes, or click Cancel to cancel
your changes.

3. Click Close to close the Edit EFM Meter Template
dialog box.

Main properties for an EFM meter template

The Main tab defines the basic properties for an EFM meter template,
including the enabling of meter logs.

Property ‘ Description

Name The unique name of the meter template. A maximum of 40
alphanumeric characters (no spaces or double quotes).

Once downloaded to the server, the meter template name cannot be
changed.

Meter Family | The type of device that meters using this template will connect with.

Protocol The Protocol box is read-only and updates depending on your
selection in the Meter Family list.

If the you change the selection in the Meter Family list, any address
configurations that might exist on the Configuration Log tab might
become invalid.

Flow The type of flow computer to which the flow meter is connected.
Computer

Run Number | If the flow computer supports multiple runs, the run number to
which the meter is connected. Each run number must have its own
meter template.

Run number is also known as tube number.

For ABB TotalFlow meters, Run Number is a mandatory field and must
contain a non-negative integer. The default value is O.

For all other meter types, it is acceptable to leave this box blank.
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Property ‘ Description

Gas or Liquid | Indicates the domain in which the meter will be used. Depending on
your selection, the available logs and data export options will vary.
The default value is Gas.

Meter Type The type of meter the that template is for. Select or type a meter type
in the box.

Other The description of the meter template. Maximum of 250 characters.

Descriptions

Meter Date Omni Enhanced controllers only

Format i )
Specifies the date format for the meter. Values can be either
DDMMYY or MMDDYY. The default value is MMDDYY.

Enable Select the check box to enable configuration record log collection.

Configuration | When selected, the Configuration Record Log tab appears.

Record Log . )
See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.
The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Enable Select the check box to enable interval log collection. When selected,

Interval Log the Interval Log tab appears.
See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.
The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Enable Daily | Select the check box to enable daily log collection. When selected,

Log the Daily Log tab appears.

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
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Property ‘ Description

list.

Enable Audit | Omni Enhanced controllers only.

Lo
9 Select the check box to enable audit logging. When selected, the

Audit Log tab appears.

See the controller's interface reference guide for the Register and
Pointer values specific to that controller and flow computer.

Enable Alarm | Not applicable for Fisher ROC controllers.
and Event

Log Select the check box to enable alarm and event logging. When

selected, the Alarm and Event Log tab appears.

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Enable Alarm | Fisher ROC controllers only.

Lo
9 Select the check box to enable alarm and event logging.

The Rollover option appears for a Fisher ROC meter.

Enable Event | Fisher ROC controllers only.

Lo
9 Select the check box to enable alarm and event logging.
The Rollover option appears for a Fisher ROC meter.
Enable Select the check box to enable ultrasonic logging. When selected, the
Ultrasonic Ultrasonic Log tab appears.
Log

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.
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Property

Enable
Composition
Log

‘ Description

Select the check box to enable composition logging. When selected,
the Composition Log tab appears.

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Enable Gas
Quality Log

Select the check box to enable gas quality logging. When selected,
the Gas Quality Log tab appears.

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Enable Liquid
Batch Log

Select the check box to enable liquid batch logging. When selected,
the Liquid Batch Log tab appears.

See the controller's interface reference guide for the Archive, Type,
Number, Register, Pointer, and Rollover values specific to that controller
and flow computer.

The Archive, Type, Number, Register, Pointer, and Rollover options
appear depending on the type of device selected in the Meter Family
list.

Item Type

The type of library item specified when this item was created.

Last Modified

Shows the date of the most recent modification to this meter
template.

Last

Downloaded

The date on which the item was last downloaded to the server.
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Configuration Log properties for an EFM meter
template

ATTENTION: EFM configuration log collection requires
dynamic scanning to be enabled on the meter’s controller. If
dynamic scanning is not enabled, an alarm will be raised when
Experion attempts to collect EFM configuration logs.

It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

The Configuration Log tab defines the configuration properties for an
EFM meter template.

You create the configuration log by adding log entries to the list. Click
Add and Remove to add or remove log entries.

Property ‘ Description

Property Lists the name of the property being collected.

Name
Select the property name from the list or type in the name. Because the
name becomes a parameter on the meter point, the name must adhere
to naming conventions. See the topic titled "Naming rules for points" in
the Server and Client Configuration Guide.

Source States from where the property value is sourced.

o Constant = The property is a statically defined value
o Controller = The property is collected from the controller
o Parameter = The property is collected from a point parameter

Data Type | Applicable only when the Source value is Constant or Controller.

o UINTZ2 = 16-bit unsigned integer.

o UINT4 = 32-bit unsigned integer

o UINTS8 = 64-bit unsigned integer.

o INT2 = 16-bit signed integer

o INT4 = 32-bit signed integer

o INT8 = 64-bit signed integer.

o REAL = 32-bit floating point

o DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
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Property ‘ Description

Type Length field appears for you to specify the string length. This
must be a positive integer.

Expression

The calculated expression of the chosen property if Data Type = CALC.

Value or
Reference

When the Source value is:

« Constant, the static constant value.

o Controller, three text boxes appear. The first box defines the controller
address location (using the syntax specific to the controller type), the
second box defines the 0% range value, and the third box defines the
100% range value.

o Parameter, the point parameter reference. The format for entry is
<point>.<parameter>, where <parameter> can be a standard
parameter, a multi-part parameter, or an array parameter.

Unit

The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments

Optional free text field.

CFXv5
Gas

This column appears only when FLOWCAL CFX v5 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration Log
can only map to CFX data points that can be included in the Meter
Configuration section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv7
Gas

This column appears only when FLOWCAL CFX v7 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration Log
can only map to CFX data points that can be included in either the
Meter Configuration section, or the User Defined Attributes section, or
the User Defined Characteristics section of the CFX file. Select <No
Mapping> if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
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Property ‘ Description

more information, see "Defining enumeration mappings for CFX" on

page 286.
CEXv7 This column appears only when FLOWCAL CFX v7 Liquid is defined as
Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration Log
can only map to CFX data points that can be included in the Periodic
Flow Data History section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration Log
can only map to CFX data points that can be included in either the
Meter Configuration section, or the User Defined Attributes section, or
the User Defined Characteristics section of the CFX file. Select <No
Mapping> if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Liquid is defined as
Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration Log
can only map to CFX data points that can be included in either the
Meter Configuration section, or the User Defined Attributes section, or
the User Defined Characteristics section, or the Liquid Product section
of the CFX file. Select <No Mapping> if the log entry does not map to a
CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView | This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
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Property ‘ Description

export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Interval Log properties for an EFM meter template

The Interval Log tab defines the interval log properties for an EFM
meter template.

You create the interval log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field Lists the name of the field being collected. The field can appear only

Name once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields. Note that after
entering a name, you need to press the Esc key to avoid the name being
overwritten by auto-select behavior.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be assumed
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Property ‘ Description

as the collection time for that log. This may introduce an offset between
the Configuration Log and other log timestamps if the controller and
server are in different time zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be assumed
as the collection time for that log. This may introduce an offset between
the Configuration Log and other log timestamps if the controller and
server are in different time zones.

Data Type « BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields.

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ = 16-bit unsigned integer.
o UINT4 = 32-bit unsigned integer
o UINTS8 = 64-bit unsigned integer.
o INT2 = 16-bit signed integer
o INT4 = 32-bit signed integer
o INT8 = 64-bit signed integer.
o REAL = 32-bit floating point
o DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)
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Expression

The calculated expression of the chosen property if Data Type = CALC.

Unit

The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments

Optional free text field.

CFXv5
Gas

This column appears only when FLOWCAL CFX v5 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Interval Log can
only map to CFX data points that can be included in the History section
of the CFX file. Select <No Mapping> if the log entry does not map to a
CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv7
Gas

This column appears only when FLOWCAL CFX v7 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Interval Log can
only map to CFX data points that can be included in the Periodic Flow
Data History section of the CFX file. Select <No Mapping> if the log entry
does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv7
Liquid

This column appears only when FLOWCAL CFX v7 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Interval Log can
only map to CFX data points that can be included in the Periodic Flow
Data History section of the CFX file. Select <No Mapping> if the log entry
does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFX v8

This column appears only when FLOWCAL CFX v8 Gas is defined as an
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Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Interval Log can
only map to CFX data points that can be included in the Periodic Flow
Data History section of the CFX file. Select <No Mapping> if the log entry
does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Liquid is defined as
Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Interval Log can
only map to CFX data points that can be included in either the Periodic
Flow Data History section, the Liquid Volume Percent section or the
Liquid Mass Percent section of the CFX file. Select <No Mapping> if the
log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView | This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Daily Log properties for an EFM meter template

The Daily Log tab defines the daily log properties for an EFM meter
template.

You create the daily log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.
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Click Add and Remove to add or remove log entries.

The order in which the log fields are defined must match the order
defined in the physical flow computer. Click the Up and Down arrows
to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

Property ‘ Description

Offset

Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field
Name

Lists the name of the field being collected. The field can appear only
once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be assumed
as the collection time for that log. This may introduce an offset between
the Configuration Log and other log timestamps if the controller and
server are in different time zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be assumed
as the collection time for that log. This may introduce an offset between
the Configuration Log and other log timestamps if the controller and
server are in different time zones.

Data Type

o BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
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logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ = 16-bit unsigned integer.
o UINT4 = 32-bit unsigned integer
o UINTS8 = 64-bit unsigned integer.
o INTZ = 16-bit signed integer
o INT4 = 32-bit signed integer
o INT8 = 64-bit signed integer.
e« REAL = 32-bit floating point
« DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Expression | The calculated expression of the chosen property if Data Type = CALC.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFX V5 This column appears only when FLOWCAL CFX v5 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Daily Log can only
map to CFX data points that can be included in the History section of
the CFX file. However, if data is being output from the Interval Log, then
Daily Log data is not output. Select <No Mapping> if the log entry does
not map to a CFX data point.
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Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFX VT
Gas

This column appears only when FLOWCAL CFX v7 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. If Interval Log is not in
use, the Daily Log can map to CFX data points in the Periodic Flow Data
History section, otherwise can map to data points in the Alternate
Periodic Flow Data History section of the CFX file. Select <No Mapping>
if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CEXv7
Liquid

This column appears only when FLOWCAL CFX v7 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. If Interval Log is not in
use, the Daily Log can map to CFX data points in the Periodic Flow Data
History section, otherwise can map to data points in the Alternate
Periodic Flow Data History section of the CFX file. Select <No Mapping>
if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Gas

This column appears only when FLOWCAL CFX v8 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. If Interval Log is not in
use, the Daily Log can map to CFX data points in the Periodic Flow Data
History section, otherwise can map to data points in the Alternate
Periodic Flow Data History section of the CFX file. Select <No Mapping>
if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Liquid

This column appears only when FLOWCAL CFX v8 Liquid is defined as
an export format on the meter template’s Data Export tab.
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The CFX data point to which this log entry maps. If Interval Log is not in
use, the Daily Log can map to CFX data points in the Periodic Flow Data
History section, the Liquid Volume Percent section or the Liquid Mass
Percent section of the CFX file; otherwise it can map to data points in
the Alternate Periodic Flow Data History section, the Liquid Volume
Percent section, or the Liquid Mass Percent section of the CFX file.
Select <No Mapping> if the log entry does not map to a CFX data point.

ATTENTION: The values in the Liquid Volume Percent section and
the Liquid Mass Percent section are appended to the end of the
Periodic Flow Data History section or the Alternate Periodic Flow
Data History section.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView | This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

J

Alarm and Event properties for an EFM meter template

The Alarm and Event tab defines the alarm and event properties for an
EFM meter template.

You create the Alarm and Event log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.
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Offset

Not applicable for Bristol Babcock OpenBSl controllers and Spirit IT
Flow Computers.

Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field
Name

Lists the name of the field being collected. The field can appear only
once in the log.

When you configure an Address field, a Date field, and a Time field, then
any change events with an Address/Location that appears in the
configuration log will trigger Experion to raise an event in the Experion
Event Summary display.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.

ATTENTION: For Configuration Logs, the Date must be specified
to collect the current time from the controller, or else the server
time will be assumed as the collection time for that log. This may
introduce an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Data Type

o BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields.

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
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logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ = 16-bit unsigned integer.
o UINT4 = 32-bit unsigned integer
o UINTS8 = 64-bit unsigned integer.
o INTZ = 16-bit signed integer
o INT4 = 32-bit signed integer
o INT8 = 64-bit signed integer.
e« REAL = 32-bit floating point
« DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFX V5 This column appears only when FLOWCAL CFX v5 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. Select <No Mapping> if
the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CEXv7 This column appears only when FLOWCAL CFX v7 Gas is defined as an
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Gas

export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. Select <No Mapping> if
the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv7
Liquid

This column appears only when FLOWCAL CFX v7 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. Select <No Mapping> if
the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Gas

This column appears only when FLOWCAL CFX v8 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. Select <No Mapping> if
the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Liquid

This column appears only when FLOWCAL CFX v8 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. Select <No Mapping> if
the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView

This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
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exported for each record of the Daily Log.

Configuration Record Log properties for an EFM meter
template

The Configuration Record Log tab defines the configuration record log
properties for an EFM meter template.

You create the Configuration Record log by adding log entries to the
list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

ATTENTION: It is assumed that there is a single Configuration
Record Log record for each Configuration Log record. The
collection schedule for the Configuration Record Log must be
at the same period as the Configuration Log. For example, if the
Configuration Log collects data in daily periods as defined in
the full collection schedule, the Configuration Record Log must
also collect data in daily periods on the flow computer.

Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field Lists the name of the field being collected. The field can appear only
Name once in the log.

You can enter a field name if it does not appear in the list. However, this
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will affect mapping to FLOWCAL CFX data export fields.

ATTENTION: For Configuration Logs, the Date must be specified
to collect the current time from the controller, or else the server
time will be assumed as the collection time for that log. This may
introduce an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Data Type

BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.

CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

UINTZ = 16-bit unsigned integer.
UINT4 = 32-bit unsigned integer
UINTS8 = 64-bit unsigned integer.
INT2 = 16-bit signed integer
INT4 = 32-bit signed integer
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o INT8 = 64-bit signed integer.
o« REAL = 32-bit floating point
o DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Expression | The calculated expression of the chosen property if Data Type = CALC.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFX V5 This column appears only when FLOWCAL CFX v5 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration
Record Log can only map to CFX data points that can be included in the
Meter Configuration section of the CFX file. Select <No Mapping> if the
log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFX VT This column appears only when FLOWCAL CFX v7 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration
Record Log can only map to CFX data points that can be included in
either the Meter Configuration section, or the User Defined Attributes
section, or the User Defined Characteristics section of the CFX file.
Select <No Mapping> if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CEXv7 This column appears only when FLOWCAL CFX v7 Liquid is defined as
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Liquid

an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration
Record Log can only map to CFX data points that can be included in
either the Meter Configuration section, or the User Defined Attributes
section, or the User Defined Characteristics section of the CFX file.
Select <No Mapping> if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFX v8
Gas

This column appears only when FLOWCAL CFX v8 Gas is defined as an
export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration
Record Log can only map to CFX data points that can be included in
either the Meter Configuration section, the User Defined Attributes
section, or the User Defined Characteristics section of the CFX file.
Select <No Mapping> if the log entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Liquid

This column appears only when FLOWCAL CFX v8 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Configuration
Record Log can only map to CFX data points that can be included in
either the Meter Configuration section, the User Defined Attributes
section, the User Defined Characteristics section, or the Liquid Product
section of the CFX file. Select <No Mapping> if the log entry does not
map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView

This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView

271




Chapter 9 - Building Electronic Flow Measurement (EFM)

Property Description

export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Ultrasonic Log properties for an EFM meter template

The Ultrasonic Log tab defines the ultrasonic properties for an EFM
meter template.

You create the Ultrasonic log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field Lists the name of the field being collected. The field can appear only
Name once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.

ATTENTION: For Configuration Logs, the Date must be specified
to collect the current time from the controller, or else the server
time will be assumed as the collection time for that log. This may
introduce an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
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current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Data Type

BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.

CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

UINTZ2 = 16-bit unsigned integer.
UINT4 = 32-bit unsigned integer
UINT8 = 64-bit unsigned integer.
INTZ2 = 16-bit signed integer
INT4 = 32-bit signed integer
INT8 = 64-bit signed integer.
REAL = 32-bit floating point
DBL E= 64-bit floating point

TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)
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Expression | The calculated expression of the chosen property if Data Type = CALC.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFXv5 Not supported by this file format.

Gas

CFEX VT This column appears only when FLOWCAL CFX v7 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Ultrasonic Log can
only map to CFX data points that can be included in the Ultrasonic
Diagnostic History section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFEX VT This column appears only when FLOWCAL CFX v7 Liquid is defined as
Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Ultrasonic Log can
only map to CFX data points that can be included in the Ultrasonic
Diagnostic History section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Ultrasonic Log can
only map to CFX data points that can be included in the Ultrasonic
Diagnostic History section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
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more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8
Liquid

This column appears only when FLOWCAL CFX v8 Liquid is defined as
an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Ultrasonic Log can
only map to CFX data points that can be included in the Ultrasonic
Diagnostic History section of the CFX file. Select <No Mapping> if the log
entry does not map to a CFX data point.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView

This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Composition Log properties for an EFM meter
template

The Composition Log tab defines the Composition properties for an
EFM meter template.

You create the Composition log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.
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Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field Lists the name of the field being collected. The field can appear only
Name once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.

ATTENTION: For Configuration Logs, the Date must be specified
to collect the current time from the controller, or else the server
time will be assumed as the collection time for that log. This may
introduce an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Data Type | « BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
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Property ‘ Description

type.
See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ2 = 16-bit unsigned integer.
o UINT4 = 32-bit unsigned integer
o UINT8 = 64-bit unsigned integer.
o INTZ = 16-bit signed integer
o INT4 = 32-bit signed integer
« INT8 = 64-bit signed integer.
o« REAL = 32-bit floating point
« DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Expression | The calculated expression of the chosen property if Data Type = CALC.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFX V5 Not supported by this file format.

Gas

CFEX VT This column appears only when FLOWCAL CFX v7 Gas is defined as an

Gas export format on the meter template’s Data Export tab.
The CFX data point to which this log entry maps. The Composition Log
can only map to CFX data points that can be included in the GQ Source
output file.
Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

CFXv8 This column appears only when FLOWCAL CFX v8 Gas is defined as an

Gas export format on the meter template’s Data Export tab.
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Property ‘ Description

The CFX data point to which this log entry maps. The Composition Log
can only map to CFX data points that can be included in the GQ Source
output file.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView | This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

J

Gas Quality Log properties for an EFM meter template

The Gas Quality Log tab defines the Gas Quality properties for an EFM
meter template.

You create the Gas Quality log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.
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Property ‘ Description

Field
Name

Lists the name of the field being collected. The field can appear only
once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.

ATTENTION:

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Data Type

« BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.
See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ = 16-bit unsigned integer.

o UINT4 = 32-bit unsigned integer
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Property ‘ Description

o UINTS8 = 64-bit unsigned integer.
o INT2 = 16-bit signed integer
o INT4 = 32-bit signed integer
o INT8 = 64-bit signed integer.
o REAL = 32-bit floating point
o DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data
Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Expression | The calculated expression of the chosen property if Data Type = CALC.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CEX V5 Not supported by this file format.

Gas

CFXv7 This column appears only when FLOWCAL CFX v7 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Gas Quality Log
can only map to CFX data points that can be included in the GQ Source
output file, which is an auxiliary file to the CFX file.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Gas is defined as an
Gas export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Gas Quality Log
can only map to CFX data points that can be included in the GQ Source
output file, which is an auxiliary file to the CFX file.

Some data points require you to define enumeration mappings. For
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Property ‘ Description

more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView

This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Liquid Batch Log properties for an EFM meter
template

The Liquid Batch Log tab defines the Liquid Batch properties for an
EFM meter template.

You create the Liquid Batch log by adding log entries to the list.

TIP: It is also recommended that you refer to the appropriate
Interface Reference guide for your controller for any specific
restrictions or guidelines for the log configuration.

Click Add and Remove to add or remove log entries.
Click the Up and Down arrows to move selected rows in the list.

Click Move to to move a selected row to the line number specified in
the text box next to the button.

Property ‘ Description

Offset Calculates the Bytes Offset the field is at using the data width of
previous fields. This facilitates cross checking with the meter device
user manual.

Note that for a data type of VARTEXT, the Offset value cannot be
calculated so may not be accurate.

Field Lists the name of the field being collected. The field can appear only

Name once in the log.

You can enter a field name if it does not appear in the list. However, this
will affect mapping to FLOWCAL CFX data export fields.
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Property ‘ Description

ATTENTION:

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

For Configuration Logs, the Date must be specified to collect the
current time from the controller, or else the server time will be
assumed as the collection time for that log. This may introduce
an offset between the Configuration Log and other log
timestamps if the controller and server are in different time
zones.

Source Fisher ROC only
Can be either:

« Log, indicating that the sourced fields are the same as other logs in
that they’re collected from the latest batch information and stored as
part of its history record; or,

« Controller, indicating that the sourced fields are read from a register
address or T:L:P location for each log record that is collected. The
register address used may be indexed by a field value in the log
record that was collected.

For example, to collect the product name for the product identified in
the log record, you may configure a Controller field with field name
Product Name and reference the address as 201:X:0 AC20 STRINGZ20.

The X indicates that the Logical point number will be indexed by the
Product Index field defined in the log record configuration.

Refer to the sample meter template for additional examples.

Data Type | « BYTE = configurable length byte array data format. Can be used for
4-byte and 5-byte Bristol Babcock specific Julian timestamps, and
for single BYTE fields. When selected, a Data Type Length field
appears for you to specify the string length. This must be a positive
integer.
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Property ‘ Description

o CALC = calculated log field expression to reference other log field
property names, delimited by curly braces "{name}." The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic. The
references are restricted to properties only in the same log definition.
You can also use CALC to include constant values in the exported
logs. The result of the calculation is always stored as a Double
Precision floating point, which can be converted to single precision
in exports if required.

All log types, except the Configuration Log, support the CALC data
type.

See the topics titled "Configuring CALC data types" and "PV Algo 20:
Advanced Arithmetic" for more information.

o UINTZ = 16-bit unsigned integer.

o UINT4 = 32-bit unsigned integer

o UINTS8 = 64-bit unsigned integer.

o INT2 = 16-bit signed integer

o INT4 = 32-bit signed integer

o INT8 = 64-bit signed integer.

o REAL = 32-bit floating point

« DBLE= 64-bit floating point

o TEXT = fixed-length ASCII character string. When selected, a Data

Type Length field appears for you to specify the string length. This
must be a positive integer

o VARTEXT = variable length, null terminated, ASCII character string in
the log record. (Flow-X only)

Expression | The calculated expression of the chosen property if Data Type = CALC.

Definition | Valid when Source is Controller.

Contains address details for the controller. For more information, see
the Fisher ROC Interface Reference.

Unit The units of the chosen property. For example, when the property is a
temperature, only temperature-related units appear in the list (for
example, degF).

Comments | Optional free text field.

CFEXv7 This column appears only when FLOWCAL CFX v7 Liquid is defined as
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Property ‘ Description

Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Liquid Batch Log
can only map to CFX data points that can be included in the Batch
Report section or the Custom Batch Data section of the CFX file.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on

page 286.
CFXv8 This column appears only when FLOWCAL CFX v8 Liquid is defined as
Liquid an export format on the meter template’s Data Export tab.

The CFX data point to which this log entry maps. The Liquid Batch Log
can only map to CFX data points that can be included in the Liquid
Batch Report section, the Liquid Custom Batch Data section, the Liquid
Volume Percent section, or the Liquid Mass Percent section of the CFX
file.

Some data points require you to define enumeration mappings. For
more information, see "Defining enumeration mappings for CFX" on
page 286.

ProdView | This column appears only when ProdView Export Format is defined as an
export format on the meter template’s Data Export tab. The ProdView
export format is compatible with the Peloton ProdView software.

The ProdView field to which this log entry maps. Select a ProdView
mapping or <No Mapping> for each property collected. The ProdView
export files are collated on a daily basis, so there will be one entry
exported for each record of the Daily Log.

Data Export properties for an EFM meter template

The Data Export tab defines the export file format(s) for an EFM meter
template.

To add a new data export format:

1. Click[+]to display the popup menu, and then select an existing
data export format or select Create new CSV Export Format to create
a new data export format. You can add up to three data export
formats, after which time this button disappears.
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In the Name text box, type the name for this EFM CSV export
format.

Select the Include Field names in header check box to include a
header row in the CSV file.

In the Description text box, type in a description for this EFM CSV
export format.

Click ¥ next to Configuration to expand the list, and then select the
check boxes next to the items you want to include in the CSV file.

Use the following tools to help you search and organize items in
the list.

. = Searches for items that match the text you enter in the text
box.

« [®] Moves the selected row(s) to the top of the list.
« [#] Moves the selected row(s) to up one row in the list.
« [2] Moves the selected row(s) to the end of the list.

Repeat step 5 for the Interval Log, Daily Log, Alarm and Event Log,
Ultrasonic Log, Composition Log, Gas Quality Log, Configuration
Record Log, Audit Log and Liquid Batch Log lists.

Click Create to add the EFM CSV export format to the list.

To remove a data export format

Click X next to the data export format to remove it.

To edit a CSV data export format

1.

If the data export format can be edited, click [B] to edit it.

The Edit EFM CSV Export Format dialog appears.

In the Name text box, type in the name for this EFM CSV export
format.

Select the Include Field names in header check box to include a
header row in the CSV file.

In the Description text box, type in a description for this EFM CSV
export format.

Click ¥ next to Configuration to expand the list, and then select the
check boxes next to the items you want to include in the CSV file.

Use the following tools to help you search and organize items in
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the list.

. = Searches for items that match the text you enter in the text
box.
o [#] Moves the selected row(s) to the top of the list.
« [#]Moves the selected row(s) to up one row in the list.
« [2] Moves the selected row(s) to the end of the list.
7. Repeat step 5 for the Interval Log, Daily Log, Alarm and Event Log,

Ultrasonic Log, Composition Log, Gas Quality Log, Configuration
Record Log, Audit Log, and Liquid Batch Log lists.

8. Click Apply to update the EFM CSV export format.
9. Click Close to close the Edit EFM CSV Export Format dialog.

Defining enumeration mappings for CFX

Some CFX data points are enumerated types. If the enumerations
used by the flow computer differ from those used by CFX format, you
need to define enumeration mappings. For example, Meter Tap Type is
expressed as one ASCII character with the following enumeration

defined:
m F =Flange
m P =Pipe

However, these values might be enumerated differently by the flow
computer. For example, NuFlo Cameron Scanner 2000 MicroEFM
Flow Computer controllers use the following enumeration for Meter
Tap Type:

m O=Flange
m 1=Corner
m 2=DandD/2

In this situation, you need to define enumeration mappings so that
CFX can interpret these data points correctly. When enumeration
mapping is required for a data point, .l appears in the CFX 5, CFX 7,
and/or CFX 8 columns on the Configuration Log tab, the Interval Log
tab, the Daily Log tab, and the Alarm and Event Log tab.
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Prerequisites

m FLOWCAL CFX v5 Gas, FLOWCAL CFX v7 Gas, and/or FLOWCAL CFX v8
Gas is defined as an export format on the meter template’s Data

Export tab.

To define an enumeration mapping for CFX

1. Click =, which is located in the CFX 5, CFX 7, and/or CFX 8 columns
for the row of the applicable data point.

The Device Definitions for <Data Point> dialog appears for the

applicable data point. The fields on this dialog change according
to the data point being defined. The following example shows the
dialog for the Meter Tap Type data point.

&% Device Definitions for Meter Tap Type x|

Fange (F)

Pipa (P)

Define the values used by the device to represent each Meter
Tap Type. If more than one value can be used to represent a
Meter Tap Type, specify values separated by semicolons (;).
Use double quotes (" <value> ") where leading or trailing
white-space is important.

OK Cancel |

2. Enter the appropriate values in each field, and then click OK.

;_'-E, Device Definitions for Meter Tap Type 5'
Flange (F) "0"
Pipe (P) nqn. mgn

Define the values used by the device to represent each Meter
Tap Type. If more than one value can be used to represent a
Meter Tap Type, specify values separated by semicolons (7).
Use double quotes (" <value> ") where leading or trailing
white-space is important.

OK Cancel

3. Repeat as necessary for other data points.
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CFX enumeration mappings

This topic lists CFX data points that, if you are collecting them, might
require you to map enumerations. See the topic titled "Defining
enumeration mappings for CFX" for more information.

CFX 5 data points

Data point

BTU Base

Calculation Method

Chart or EFM Indicator

Data Resolution

Extensions Used

Factor FWS

Factors — FA
Factors — FB
Factors — FG

Factors — FPV

Factors — FR
Factors — FT
Factors — FWV
Factors - Y
Fitting Type

Flowing Pressure Correction Enabled

FPV Method

Has Default Temperature

Has RTD

288



Chapter 9 - Building Electronic Flow Measurement (EFM)

Data point

Hourly Record Span

Live Input — Analyses

Live Input — Energy/heating Value

Live Input — Gravity

Live Input — Temperature

Meter Factor/K Factor Curve Type

Meter Tap Type

Meter Type

Pipe Material

Plate Material

Power Source

Pressure Compensated

Sample Type

Static Pressure Tap Location

Static Pressure Type

Temperature Compensated

Unit for Atmospheric Pressure

Unit for Corrected Volume

Unit for Differential Pressure

Unit for Energy

Unit for Extension

Unit for Heating Value

Unit for Liquid Mass
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Data point

Unit for Mass Heating Value

Unit for Mass K Factor

Unit for Orifice/Cone Diameter

Unit for Orifice/Cone Ref Temperature

Unit for Pipe Diameter

Unit for Pipe Length

Unit for Pipe Ref Temperature

Unit for Pressure Base

Unit for Raw Volume

Unit for Static Pressure

Unit for Temperature

Unit for Temperature Base

Unit for Uncorrected Volume

Unit for Viscosity

Unit for Volume K Factor

Use RTD

CFX 7 data points

Data point

Alternate Data Span

Calculation Method

Chart or EFM Indicator

Data Resolution
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Data point

Data Span

EFM Heating Value Saturation Condition

Expansion Factor Method

Extension Definition

Factor FWS in use

Factor FWV in use

Factors — FA
Factors - FB
Factors - FG

Factors - FPV

Factors — FR
Factors — FT
Factors - Y
Fitting Type

Flowing Pressure Correction Enabled

FPV Method

Has Default Temperature

Has RTD

Live Input — Analysis

Live Input — Energy/Heating Value

Live Input — Gravity

Live input — Temperature

Meter Factor Usage
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Data point

Meter Factor/K Factor Curve Type

Meter Tap Type

Meter Type

Pipe Material

Plate/Cone Material

Power Source

Pressure Compensated

Sample Type

Static Pressure Average

Static Pressure Measurement

Static Pressure Tap Location

Temperature Compensated

Unit for Atmospheric Pressure

Unit for Corrected Volume

Unit for Differential Pressure

Unit for Energy

Unit for Gas Equivalent Energy

Unit for Gas Equivalent Volume

Unit for Gross Standard Volume

Unit for Gross Volume

Unit for Heating Value

Unit for Indicated Volume

Unit for Mass
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Data point

Unit for Mass Heating Value

Unit for Mass K Factor

Unit for Measured Volume

Unit for Net Standard Volume

Unit for Observed Density

Unit for Orifice/Cone Diameter

Unit for Orifice/Cone Ref Temperature

Unit for Pipe Diameter

Unit for Pipe Length

Unit for Pipe Ref Temperature

Unit for Pressure Base

Unit for Raw Volume

Unit for Static Pressure

Unit for Temperature

Unit for Temperature Base

Unit for Uncorrected Volume

Unit for Viscosity

Unit for Volume K Factor

Use RTD

CFX 8 data points

Data point

Alternate Data Span

Calculation Method
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Data point

Chart or EFM Indicator

Data Resolution

Data Span

EFM Heating Value Saturation Condition

EFM Relative Density Saturation Condition

Extension Definition

Factor FWS in use

Factor FWV in use

Factors — FA
Factors — FB
Factors - FG

Factors — FPV

Factors — FR
Factors — FT
Factors - Y
Fitting Type

Flowing Pressure Correction Enabled

Has Default Temperature

Has RTD

Live Input — Analysis

Live Input — Energy/Heating Value

Live Input — Gravity

Live input — Temperature
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Data point

Meter Factor Usage

Meter Factor/K Factor Curve Type

Meter Tap Type

Meter Type

Pipe Material

Plate/Cone Material

Power Source

Pressure Compensated

Sample Type

Static Pressure Average

Static Pressure Measurement

Static Pressure Tap Location

Temperature Compensated

Unit for Actual Volume

Unit for Atmospheric Pressure

Unit for Corrected Volume

Unit for Differential Pressure

Unit for Energy

Unit for Gas Equivalent Energy

Unit for Gas Equivalent Volume

Unit for Gross Standard Volume

Unit for Gross Volume

Unit for Heating Value
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Data point

Unit for Indicated Volume

Unit for Mass

Unit for Mass Heating Value

Unit for Mass K Factor

Unit for Measured Volume

Unit for Net Standard Volume

Unit for Observed Density

Unit for Orifice/Cone Diameter

Unit for Orifice/Cone Ref Temperature

Unit for Pipe Diameter

Unit for Pipe Length

Unit for Pipe Ref Temperature

Unit for Pressure Base

Unit for Raw Volume

Unit for Standard Volume

Unit for Static Pressure

Unit for Temperature

Unit for Temperature Base

Unit for Uncorrected Volume

Unit for Viscosity

Unit for Volume K Factor

Use RTD

Z Method
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Configuring CALC data types

The Calculated Value Expression Editor is where you create arithmetic
calculated field values of multiple input log properties. The calculation
is similar to that as in PV Algo 20: Advanced Arithmetic.

You can perform calculations on all meter template logs except for
the Configuration Log.

Figure 9-1: Calculated Value Expression Editor

¢o Cakulated Value Expression Editor

=gl x|
Expression:

Specify anthmetic exprassions like:
( ({Feld1} - 1)~3 + 3.6%{Field2} ) [ sqrt( {Field3} )

Standard order of operation rules apply unless overridden by
brackets

Supported Operators:
Operator Description

+ Add
Subtract
% Multiply
! Divide
% Power

sqri() Square root

Enclose log field names in curly braces, for example:
{A Log Field Name}

ok | cancal |

A

The calculated log field expression can reference other log field
names, delimited by curly braces { }. The referenced log field
expression can also include other CALC log field names, provided they
appear higher in the list. However, you can reference only those
properties in the same log. For example, if you are creating a
calculation in the Daily log, you can create an expression with field
names in the Daily log; you cannot reference a field name in the Gas
Quality log.

To configure a CALC data type

1. Inthe row of an applicable field name in a meter template log,
select CALC as the Data Type.
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An ellipses tl appears in the Expression column to the right of
CALC.

2. Click the ellipses -l
The Calculated Value Expression Editor appears.

3. Type a calculation expression in the Expression box.
Enclose field names with curly braces ({}). For example:
({Field1} - 1)*3 + 3.6*{Field2} ) / sqrt( {Field3}
where Fieldl, Field2, and Field3 are field names.
Maximum 1,000 characters.

Arithmetic Operators are:

o + (Plus sign) Add

e - (Minus sign) Subtract

o * (Asterisk) Multiply

o / (Slash mark) Divide

o *(Caret) Power

o sqrtQ) Square root
4. Click OK to close the Calculated Value Expression Editor.
The result of the calculation is stored in the field.

If you export CALC data to CSV files, see the topic titled "About
exporting results of Floating Point data to CSV files" for more
information.

Defining EFM CSV data export formats

EFM CSV data export formats are associated with EFM meter
templates, which in turn are associated with EFM meters. They
contain configuration settings for exporting EFM data from Experion
to third-party billing systems for processing.

To define a new EFM CSV data export format, do one
of the following:

Result

From the EFM Data | The new EFM data export format appears in the List View. Use
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Option

Export Format
section within the
Library, drag and
drop a data export
format item into
the List View.

‘ Result

the Main tab to complete the configuration of the new EFM
data export format.

Click E}

The Add Item(s) dialog box appears.

1.

In the Number of items to Add text box, type the number of
meters you want to add.

From the Item Family list, select EFM Data Export Format.

From the Item Type list, select EFM data export format you
want to add.

In the Name text box, type in the name for this EFM data
export format, or you can accept the default provided. If
you have chosen to create multiple EFM data export
formats, the Multi - Items section is enabled, and you can
provide a prefix for all the EFM data export formats, or
you can accept the default provided. You can also indicate
whether to use a sequential number or letter to
differentiate between the EFM data export formats.

Click OK to add the EFM data export format(s) to the list.

Use the Main tab to complete the configuration of the
new EFM data export format(s).

From the Data
Export tab of meter
template in Quick
Builder, click [+] to
display the popup
menu, and then
select Create new
CSV Export Format.

The Create EFM CSV Export Format dialog appears.

1.

In the Name text box, type in the name for this EFM CSV
export format.

Select the Include Field names in header check box to
include a header row in the CSV file.

If required, select the Use tab delimiter (*.tsv) check box to
create a TSV file instead of a CSV file.

In the Description text box, type in a description for this
EFM CSV export format.

Click ¥ next to Configuration to expand the list, and then
select the check boxes next to the items you want to
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‘ Result

include in the CSV file.
Use the following tools to help you search and organize
items in the list.
. 4 Searches for items that match the text you enter in
the text box.
. [#F] Moves the selected row(s) to the top of the list.
. [*] Moves the selected row(s) to up one row in the list.

. [ Moves the selected row(s) to down one row in the
list.

. [ Moves the selected row(s) to the end of the list.

6. Repeat step 5 for the Interval Log, Daily Log, Alarm and
Event Log, Configuration Record Log, Ultrasonic Log,
Composition Log, and Gas Quality Log lists.

7. Click Create to add the EFM CSV export format to the list.

Use the properties tab to configure each EFM data export format by
first highlighting it in the List View.

To edit an EFM data export format, do one of the

following:

Option ‘ Result

Select EFM Data Export Formats A list of data export formats appears in the List

from the Navigation pane. View, with the first data export format selected.

1. Select the data export format you want to

edit. The schedule appears in the List View,
and the Main tab enables you to edit the
configuration of the data export format.

From the Data Export tab of an The Edit EFM CSV Export Format dialog box

EFM meter template, click [ next | appears.

to the CSV data export format you

want to change. 1. Edit the configuration properties on the
dialog box.
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Result

2. Click Apply to save the changes.

3. Click Close to close the Edit EFM CSV Export
Format dialog box.

Defining the monthly export format

The monthly export format is associated with EFM monthly exports. It
contains configuration settings for exporting cumulative EFM data in
CSV files once a month from Experion to a specified location.

If the monthly export format is not defined and the Enable Monthly
export check box is selected in Station, Experion will export Monthly
Exports for the parameters Flow Time and Flow Volume if they exist on
each meter.

Prerequisite

You have started Quick Builder. For more information, see "Starting
Quick Builder" on page 15.

To define the monthly export format:

1. From the EFM Data Export Format section within the Library, drag a
EFM CSV Export Format item into the List View.

2. From the List View, select the added EFM CSV Export Format item.

3. In the Main tab, select the Monthly export format check box.

The name Monthly Export Format is added in the Name box. The
description for the monthly export format is also added in the
Description box.

4. Click ¥ next to Daily Log to expand the list, and then select the
check boxes next to the items you want to include in the monthly
export.

Use the following options to help you search and organize items.

Option | Description

Q, Searches for items that match the text you enter in the
text box.
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Option | Description

= Moves the selected row(s) to the top of the list.

[+ Moves the selected row(s) to up one row in the list.
= Moves the selected row(s) to down one row in the list.
3 Moves the selected row(s) to the end of the list.

Click Create to add the monthly export format to the list.

To edit the monthly export format:

1.
2.
3.

From the Navigation pane, select EFM Data Export Formats.
From the List View, select Monthly Export Format.

From the Main tab, edit the configuration of the monthly export
format.

Managing EFM schedules

ATTENTION: If your system needs to account for Daylight
Savings Time (DST), you might need to adjust the time of the
Daily Log schedule by one hour for affected meters during DST.
This is because some meters do not support DST and they will
collect the Daily Log one hour earlier or later than required.
During a system time change when clocks are put back, you
might be required to disable EFM collection for that period for
some EFM interfaces (for example, Spirit IT Flow-X).

To build a new EFM schedule

1.

Use one of the following options, and then use the Properties tab to
configure each meter template.

Result

From the EFM
Schedule section
within the Library,
drag and drop the

The new EFM schedule appears in the List View, and the
properties tab enables you to complete the configuration of the
new EFM schedule.
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Option ‘ Result

EFM schedule item
into the List View.

Click = The Add Item(s) dialog box appears.

1. In the Number of items to Add text box, type the number of
meters you want to add.

2. From the Item Family list, select EFM schedule.

From the Item Type list, select EFM schedule.

4. In the Name text box, type in the name for this EFM
schedule, or you can accept the default provided. If you have
chosen to create multiple EFM schedules, the Multi - Items
section is enabled, and you can provide a prefix for all the
EFM schedules, or you can accept the default provided. You
can also indicate whether to use a sequential number or
letter to differentiate between the EFM schedules.

5. Click OK to add the EFM schedule(s) to the list.

w

From the The Create EFM Schedule dialog appears.
Collection and

Export tab of an 1. In the Name text box, type in the name for this EFM

individual meter in schedule.
Quick Builder, 2. From the Every list, select the period at which the schedule
runs.

select (Create new
Schedule) from the | 3. Inthe with a maximum of retries text box, type number of

Schedule Type lists. times the schedule till try to collect and export data before
abandoning the task.

4. From the Apart list, time to wait between retries.
5. Click OK to add the EFM schedule to the list.

To edit an EFM schedule

1. Use one of the following options to edit an EFM schedule.

Result
From the Navigation pane, select A list of EFM schedules appears in the List View,
EFM Schedules. with the first schedule selected.

Select the schedule you want to edit. The
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‘ Result

schedule appears in the List View, and the Main
tab enables you to edit the configuration of the
schedule.

From the Collection and Export tab | The Edit EFM Schedule dialog appears.

of an individual meter in Quick
Builder, click =Inext to the Schedule
Type list.

1. Edit the configuration details on the Main
tab.

2. Click Apply to save the changes.
3. Click Close to close the dialog box.

Managing meters and meter templates

Deleting EFM components

Because of the associations between EFM components, keep in mind
the following points when deleting meter templates, schedules, and
data export formats:

m Meters have direct associations and/or dependencies on meter
templates and schedules.

m You cannot delete meter templates and schedules if there are any
meters associated with it.

m Meter templates have direct associations and/or dependencies on
data export formats. Therefore, meters have indirect associations
with data export formats.

m You cannot delete data export formats if there are any meter
templates associated with it.

See the topic titled "Deleting and restoring deleted items" for
procedures to delete and restore EFM components.

Enabling and disabling meters

You enable or disable an EFM meter using Station. See the topic titled
"Disabling or enabling a point or EFM meter" in the Operator's Guide

for more information.
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Uploading EFM configurations from the server

If you need to make changes to Electronic Flow Measurement
configurations that have already been downloaded to the server
database, you can upload their definitions from the server into the
current Quick Builder project. You can then make the necessary
changes to the items and download the updated definitions to the
server.

1. Click & |
The Upload dialog box opens.

2. Check that Server Details are correct. If they aren't, close the dialog
box and change them on the Server Details tab for the server.

3. Select the appropriate Scope option.

The following options are available for uploading data from a
specified server to Quick Builder

Option ‘ Description

Allitems | Uploads all items from the server, including
in Project | hardware and point configuration data, as well as
the history collection rates and offsets.

Selected | Uploads only the history collection rates and offsets

ltems configured on the server. This upload populates the
Only History Options tab on the Servers properties page.
All Uploads only hardware configuration data. This
Hardware | option includes EFM configurations.

on Server

All Points | Uploads only point configuration data.
on Server

4. (Optional) If you want to use any specialized bckbld or hdwbckbld
command line parameters, click Show Options and type them in
Other Flags. (For details about the parameters, see the topics on
hdwbld and hdwbckbld in the Hardware and Point Build
Reference.)

5. Check your selections in the Summary list, and then click OK.

If another user is modifying, uploading, or downloading any items
you are attempting to upload, a message appears and the upload
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only succeeds for any items not currently being worked on by the
other user.

You can terminate the upload by pressing the ESC key

Exporting and importing EFM configurations

You can export and import EFM-related configurations, such as
meter templates, data export formats, and schedules, to and from
XML files.

When you export data, the EFM Export Format for these files is
.efmdb.xml. To export EFM configurations, see the topic titled
"Exporting project data."

When you import data, you can choose to import either a file
previously exported from Quick Builder (.efmdb.xml) or file previously
downloaded or uploaded to or from the server (.efmsvr.xml). To import
EFM configurations, see the topic titled "Importing items from a
definition file or another project.”

File location for EFM meter templates

EFM meter templates are located at:

<data folder>\Honeywell\Experion PKS\client\user\efm

Where <data folder> is the location where Experion data is stored. For
default installations, <data folder> is C: \ProgramData. The
C:\ProgramData folder is a system folder, which means that it is
only visible if you select the Show hidden files, folders, and drives option
button in the Folder Options dialog box. To change this setting in
Windows Explorer, click Organize > Folder and search options, and then
click the View tab.

Sample templates contain sample EFM meter templates, and for the
Enron Modbus sample template, seven schedules. See the topic titled
"Managing EFM meter templates" for more information.

Collecting and exporting EFM data

Collection behavior

EFM requests (an EFM request is a single log type from a single
meter) are queued to the scanning subsystem every 60 seconds.
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Requests are queued according to the configured EFM schedules for
Interval and Full collection. If a collection fails, and retries are
configured, the retries are added to the queue in the next scanning
period.

An EFM request is not queued if there is already another request for
the same log type for the same meter. For example, a manual scan at
the same time as a scheduled scan would result in one request, not
two separate requests issued at the same time.

Experion throttles the rate at which EFM requests are issued
maintaining a count of the currently outstanding requests on each
channel. Only enough requests will be issued to reach a maximum of
60 outstanding requests on each channel. The scanning subsystem
then takes only one EFM request per channel per second off the
queued requests and sends this for processing to the channel.

Each EFM request includes a hard-coded range that specifies the
maximum number of records within that log that will be collected for
a single request. This is set for each log type as described in “Table 10:
Maximum number of records for each log type”. Therefore, a two-
hourly collection of Composition log records laid down every four
minutes would expect 30 records per collection (120 minutes divided
by 4 minutes = 30), which would be processed through a single EFM
request.

Maximum number of records for each log type

Log type ‘ Maximum number of records
Alarm and Event (Audit) 100

Alarm Log 100

Event Log 100

Audit log (Omni Enhanced only) 100

Composition log 50

Configuration Record log 5

Daily log 5

Gas Quality log 50

Liquid Batch log 50
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Maximum number of records

Interval log

50

Ultrasonic log

50

Each controller will then limit the number of records returned in
response to a single request. The response to the request includes
how many additional records remain to be collected, so EFM would
queue another request on the next 60 second boundary if more
records are still to be collected in the meter, for example, when
communications had interrupted and some collections had been
missed.

EFM data collection is an additional load on top of regular channel
traffic. During commissioning, and after significant communications
disruptions, the data collection operation will collect all records not
yet obtained. Sometimes, this load can be substantial. To avoid
overloading the channels:

m Experion will throttle EFM loads on a channel-by-channel basis

m During commissioning when there may be a large number of logs
to collect, avoid too many simultaneous EFM collections by
staggering the enabling of meters.

= Only one EFM request per meter and log type (Interval logs, Daily
logs, Ultrasonic logs, Composition logs, Gas Quality logs, Alarm
and Event logs, Audit logs, Liquid Batch logs, Alarm Logs, Events
Logs, Configuration logs, and Configuration Record logs) will be
serviced at a time. This can include manual scans, periodic interval
scans, and periodic full scans. Each additional scan will only be
completed after the current outstanding scan is complete, one at a
time

ATTENTION: If your system needs to account for Daylight
Savings Time (DST), you might need to adjust the time of the
Daily Log schedule by one hour for affected meters during DST.
This is because some meters do not support DST and they will
collect the Daily Log one hour earlier or later than required.
During a system time change when clocks are put back, you
might be required to disable EFM collection for that period for
some EFM interfaces (for example, Spirit IT Flow-X).
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Export behavior

EFM data exported from Experion can be stored on the local
server or on another node.

When an export is triggered for a meter (either scheduled or
requested manually), Experion will attempt to export all data on
the meter that was not previously exported successfully. This
means that if an export fails, the next time an export occurs for the
meter, the old data (unsuccessfully exported) as well as the new
data (not yet exported) will be exported.

Once Experion has successfully exported EFM data, some cleanup
and maintenance tasks are performed.

If the Delete after option on the EFM configuration settings
display is selected, Experion will delete exported CFX or CSV files
(including TSV files, where applicable) that are older than the value
specified in the Days box. If the Delete after option on the EFM
configuration settings display is not selected, Experion will never
automatically delete exported CFX or CSV files (including TSV
files). Files in these locations must be deleted manually.

Experion will export EFM data from a meter within 30 seconds of
the following events:

o A successful data collection.

o An Export latest collected data or an Export all collected data
starting from task request.

If the location specified for the exported data falls below a set
amount of disk space, an alarm is raised.

About tamper detection of EFM data

When EFM data is exported, Experion monitors the data for evidence
of tampering. If any evidence is found:

An urgent alarm is raised.
Suspect data is not exported.

The affected meter will continue to collect data. The meter will
continue to export non-suspect data, provided the data to export
does not contain any suspect records.

You can choose to delete tampered data. However, this operation can
cause the permanent loss of EFM data. Contact your Honeywell
Technical Assistance Center for further support.

When you delete tampered EFM data, Experion deletes the suspect
data from the server. In addition, this operation:
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m Creates an archive of the tampered data to a file to allow for
forensic analysis by your Honeywell Technical Assistance Center.

m At the meter’s next collection schedule, Experion will attempt to
recover the data. Note that the following historic data cannot be
recovered:

« Historic configuration data. If configuration data needs to be
collected, it can only collect the latest snapshot.

¢ Historic alarm and event data.
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CHAPTER

O ALGORITHMS

This section describes the algorithms you can attach to a point. An
algorithm is a set of rules that enhances a point's functionality. The
algorithm accomplishes this by processing the point data either

before or after normal point processing. There are two types of
algorithms:

m Action Algorithms—the algorithm is only used when the parameter
value changes.

m PV Algorithms—the algorithm is used every time the point
parameter is scanned.

In this section:

Configuring PV algorithms in Quick Builder ............................ 313
Configuring action algorithms in Quick Builder ....................... 326
Creating a composite alarm hierarchy ..., 337
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Configuring PV algorithms in Quick Builder

The following PV algorithms are available in Quick Builder.

PV Algo 4: General Arithmetic

Description

Performs an arithmetic calculation using seven input point
parameters and six constants. The result of the calculation is stored in
the PV of the point to which this algorithm is attached. This algorithm
is used to perform derived calculations based on analog or status
points.

The calculation is as follows:

(F1+F2+F3+F4)
Result = xF7
(F5 + F6)

Where:

Frn= Constani_h */P_Poigt 7D R Param_n

Remarks

m |f IP_Point_ID_n is not specified (left blank), then Fn = Constant_n.

m |f F5 + F6 = zero, then the divisor is automatically set to 0.000001
to avoid a divide by zero.

m |f no division is required, then Constant_5 should be set to 0.0, and
Constant_6 should be set to 1.0. IP_Point_ID_5 and IP_Point_ID_6
should not be defined.

m The PVSOURCE entry for a point to which this algorithm is attached
must have Address Type set to Controller. Specify only the controller
name; Location should be left blank.

m Constant_7 is not user-definable and is always equal to 1.

Property Description

Block No. The algorithm block used by this algorithm for this point. Each

313



Chapter 10 - Algorithms

Property ‘ Description

algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Constant Specify up to six constants. The minimum is one Constant/Input Point
(F1-F6) pair and a denominator constant (to prevent a divide by zero).

Input Point | Select points and parameters from the list of points that have already

(F1-F7) been defined. These point parameters are used to multiply the constant.
Param
(F1-F7)

PV Algo 5: Production

Description

This algorithm stores the shift, daily, or monthly total of an
accumulator point PV to the nominated parameter of the destination
point. After the total is stored, the accumulator point PV can
optionally be reset to zero.

Remarks

Property ‘ Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Destination | The point and parameter ID that is used to store the value at the end of
the storage period. This must be an analog parameter.

Storage The time interval between stores to the destination point parameter.

Period
If you specify either Day or Month, the storage will happen at the

commencement of the first shift of that day or month (not at midnight).

314



Chapter 10 - Algorithms

315

Property De

Reset PV Re
att

Pa

scription

sets the PV value of the accumulator point to which this algorithm is
ached after the run hours are stored to the destination point
rameter.

Property

Block No.

PV Algo 7: Run Hours

For an analog point with no PV source address defined, this algorithm
accumulates run hours according to a given run indicator status point
used as a gate. When the gating point parameter enters the specified
state, (say the end of a shift), the run hours are accumulated and sent
to the PV parameter of the analog point.

Additionally, shift hours can be totaled and stored as well as the PV of
an associated point. This information can be readily accessed by the
Free Format report.

To use this algorithm, an analog point must have a scan period no
greater than 60 seconds.

‘ Description

The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned
a unique block number. Use the alglst utility to find a free
block.

See the topic titled "Algorithm blocks" in the Server and
Client Configuration Guide for more information.

Gating Source

The point, parameter, and state of that parameter that
causes run hours to be accumulated. Run hours
accumulate if the gating source is in this state.

Gate state

Gate start and stop states. Valid values are single-, dual-, or
triple-bit.

Shift Hours Destination | The accumulator point and parameter used to store the

accumulated run hours for the shift.

This point parameter must be defined with a zero drift
deadband to ensure point processing on each scan.

Store Shift Total
instead of Total
Hours

Stores a shift total instead of total run hours indicated by
Run the PV. The incremental run hours since the last shift
boundary are stored.
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Property ‘ Description

Store Reset Timestamp | Writes the timestamp of the reset into the descriptor of the
in Descriptor destination point.

Reset on run state Reset the run hours when the gating source changes from
change its current gating state.
Associated Point The point for which the accumulated PV parameter value,

since the last run hours reset, is stored with the run hours
(for example, production tonnage).

The run hours can be reset at any time from the Algorithm
Detail display. For details, see the Server and Client
Configuration Guide.

PV Algo 10: General Logic

Description

Performs logical combination of up to five single-bit inputs through
four logic gates. The single-bit output can be sent either to the output
destination of the point for which the algorithm is being defined, or to
the PV source address of a database point.

A delay can be applied to the output after a transition to the target
delay state. The specified delay can be relative to the current time or it
can be absolute compared to the system time (in seconds after
midnight).

ATTENTION: The point to which this algorithm is attached must

be a single-bit status point with only a controller number
defined in the PV source address entry for the point.

Remarks

Property Description

Block No. The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned a
unique block number. Use the alglst utility to find a free
block.
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Property

‘ Description

See the topic titled "Algorithm blocks" in the Server and
Client Configuration Guide for more information.

Input Points (A to E)

Param

Select the point/parameters, from the list of points that have
already been defined, that are to be used as the inputs. You
must specify at least one point.

F1,F2,F3 and F4

Select the logic function that is perform on the specified
inputs. The default is OR.

Enable Delay

Select to enable a transition from non-target state to target
state to cause the time delay function to be initiated. If the
target state is held until the delay time has expired, then the
delay output becomes the target state. Note that transition
to a non-target state has no effect.

Delay Type The type of delay, which can be RELATIVE to the current time
or ABSOLUTE (seconds after midnight).

Delay Time The delay period, in seconds, based on the selected Delay
Type.

Target State The target state for the delay function, which can be either 1

(default) or O.

Output to OP

Send the result of the logic to the OP destination of the
point for which the algorithm is defined.

Output to Database

Sends the result of the logic to a database point parameter
address. If you select this, you must specify the Database
Point.

Database Point

Destination Parameter

The database point/parameter where the logic result is sent.

PV Algo 12: Composite Alarm Processing

ATTENTION: Composite alarming is only supported for legacy
systems. Newer systems should use Alarm Groups instead.

The alarm icon does not support composite alarming.

Composite alarming does not work over DSA or on Console
Stations.
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Consolidates the alarm conditions of up to 18 'subordinate’ points to
create a composite alarm for the 'master’ point that represents the
combined state of its subordinate points. (You attach this algorithm to
the master point and attach Action Algo 11: Composite Alarm to each
subordinate point.)

For example, if one subordinate point is unacknowledged (no longer
in alarm) and another is in alarm but acknowledged, the master point
will show the combined state, namely: unacknowledged + alarm (even
though this state does not exist for any of the subordinate points).

The severity states of composite alarms are (from highest to lowest):

m Alarm and unacknowledged
m Alarm and acknowledged

m Normal and unacknowledged
= Normal

Note the following points:

m The triggering alarm must be higher than journal priority;
however, composite alarming makes no further differentiation
between urgent, high, and low alarm priorities.

m The master point must be a dual-bit status point, and you must
configure it as follows:

o PV Source Address - only specify the name of the controller (not
a full hardware source address)

o PV Scan Period is set to 0 (no scanning)
« Alarming is inhibited

m A subordinate point can be of any type, and you must configure it
as follows:

« Attach action algorithm 11, and use the same block number as
used by the master point

o Enable alarming and define appropriate alarm states

m |f you want to consolidate the alarm conditions of up to more than
18 points, you need to create a composite alarm hierarchy.

Property Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
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Property

‘ Description

block number. Use the alglst utility to find a free block.See the
topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

The same block must be used by both the master point and all
of its subordinate points.

Master point

The master point.

Subordinate Points | The subordinate points.
(Point 1 to Point 18)
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PV Algo 15: Integration

Used for integration of rates to obtain both totals and the calculation
of predicted totals. The calculations are performed as follows:

NewRunningTotal = PointParameterValue x (ScaleFactor)
X (TimeBetweenScans) + 0ldTotal

PredictedTtotal = NewTotal + (Value x (ScaleFactor)
x TimeRemaining)

Period totals can be configured to reset at the end of the period and
be output to the defined destinations.

One of the period totals can be optionally stored in the PV of the point
for which this algorithm is being defined.

The shift, day, and month totals can be downloaded to other point
parameters and can be reset.

Predicted totals are stored in the following algorithm blocks:
Algo 15 - predicted shift

Algo 17 - predicted day

Algo 19 - predicted month

Note the following points:

m The point for which this algorithm is being defined must be an
analog point without a database or controller source address and
have a scan period no greater than 60 seconds.

m A point parameter that is to contain the result of the time
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Block No.
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accumulation must be built with a zero drift deadband to ensure
point processing at each scan.

‘ Description

The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned a
unique block number. Use the alglst utility to find a free
block.

See the topic titled "Algorithm blocks" in the Server and
Client Configuration Guide for more information.

Period of total to be The period total to be stored in the PV of the point for which

stored in PV

this algorithm is being defined:

NOT_STORED = nothing is stored in the PV (default)
SHIFT = new running total for shift is stored in PV
DAY = new running total for day is stored in PV

MONTH = new running total for month is stored in PV

Point to be Integrated | The point/parameter value to be integrated.

Scale Factor

The scale factor used to convert rate to units.

Destinations for totals | The points/parameters where the totals for the shift, day, and

month are stored.

Reset Shift Select if you want the shift total to be reset at the end of a
shift.
Reset Day Select if you want the day total to be reset at the end of a day.

Reset Month

Select if you want the month total to be reset at the end of
the month.

PV Algo 16: Cyclic Task Request

Activates a task (typically a user-written application) on a regular basis
while a status or analog point is being scanned.

For example, if you want an application to run automatically while the
server is running, attaching this algorithm to a status or analog point
causes the server to activate the application as long as the point is
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Property

being scanned. You can stop the task by disabling scanning for the
point.

For details about writing applications, see the Application
Development Guide.

ATTENTION: This algorithm can be specified for either a status
or analog point that has no database or controller address
defined.

Block No.

‘ Description

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Task LRN

The Logical Resource Number of the task that is requested when
the point is scanning.

Task Request Rate | The task request rate in seconds. This value must be a multiple

of the point scan rate.

Parameter Block | The numerical parameter(s) passed to the task. Note that if

Word 1 is set to O, the parameter block is not read and all other
parameter values are ignored.

The format Z xxxx' is used to represent hexadecimal values.

PV Algo 20: Advanced Arithmetic

Description

Performs arithmetic calculation of multiple input point parameters
and constants. The result of the calculation is stored in the PV of the
point for which this algorithm is being defined.

Remarks

Property | Description

Equation | The arithmetic expression used by this algorithm for this point.
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Property ‘ Description

Enclose the expression with quotation marks (*). For example:

"((a+1)*b+c)*d+e"
where a, b, ¢, d, and e are point parameters or numeric constants.
Maximum 1,000 characters.

Arithmetic Operators are:

. + (Plus sign) Add

. - (Minus sign) Subtract
e  *(Asterisk) Multiply

. / (Slash mark) Divide

. A (Caret) Power

. sqrt() Square root

. ~ (Tilde) Not

. < Less Than

. > Greater Than

. = Equal

For instances where operator characters are part of a point name, use a
backslash to escape the character. For example, "fic-123.pv" can be used if
entered as "fic\-123.pv".

PV Algo 21: Advanced Logic

Description

Performs logical combination of multiple single-bit inputs. The result
of the calculation is stored in the PV of the point for which this
algorithm is being defined. If the result is more than 3 bits, then
attach the algorithm to an Analog point.
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Remarks

Property ‘ Description

Equation | The logic expression used by this algorithm for this point.
Enclose the expression with quotation marks (*). For example:
"(a&b)|(c&d)+e"

where a, b, ¢, d, and e are point parameters or numeric constants, where
floating point values will be truncated to integers.

Maximum 1,000 characters.

Logic Operators are:

. + (Plus sign) Concatenation (shift left)
. & (Ampersand) And

. | (Pipe) Or

« A~ (Caret) Exclusive or (Xor)

. ~ (Tilde) Not

. < Less Than

. > Greater Than

. = Equal

For instances where operator characters are part of a point name, use a
backslash to escape the character. For example, "di-123.pv" can be used if
entered as "di\-123.pv".

PV Algo 22: Piecewise Linearization

Linearizes the PV and SP of the point for which the algorithm is being
defined using the piecewise linearization of up to six segments in
order to produce, for example, true temperature for thermocouple
readings. The segments are defined by assigning breakpoints.

The raw value (passed from the point being linearized) is converted to
temperature by the use of linear interpolation between (up to) seven
coordinates.

Up to five breakpoints along the graph can be defined. If less than five
breakpoints are required, the coordinates of the unused breakpoints
retain the default values 0, O.
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The SP is also linearized, both on input (source) and output
(destination).

ATTENTION: The point for which this algorithm is defined must
be an analog point with either a controller or database source
address.

Property‘ Description

Block The algorithm block used by this algorithm for this point. Each algorithm
No. attached to each point should be assigned a unique block number. Use
the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

% Percentage of range to be reached for the breakpoint to take effect. Must
be in the range of 0% to 100%. A percentage of 0% indicates the end of
breakpoint data.

(EW) Coordinate value for the breakpoint percentage. This value must be in the
range of the point and, if temperature, can be either Celsius or Fahrenheit
by choice of data values.

You can obtain a negative gradient by defining appropriate values for the
EU coordinate. In such a case, EU values decrease as the percentage
values increase. Note that to ensure meaningful results, the graph must
have either a positive gradient or a negative gradient, not a combination of
both.

PV Algo 64: Maximum/Minimum

For an analog point, the maximum and minimum values of the PV
and the times at which they occurred are recorded over a period of a
shift or a day. These values are stored at the nominated destinations
and reset at the beginning of the selected period.

At the beginning of each period, the maximum and minimum values
of the previous period are downloaded to the defined destination
points.

Property Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
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Property ‘ Description
block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Shift Min/Max and | You separately specify the requirements for the two periods:
Day Min/Max shift and day.

Enable Collection Select to collect the minimum and maximum values for the
associated period.

Current Maximum Use this to pre-set a current PV maximum value for the point
to which this algorithm is attached. This value is compared with
the recorded maximum value and a new maximum is set. Pre-
setting is useful when uploading the database.

Current Minimum Use this to pre-set a current PV minimum value for the point to
which this algorithm is attached. This value is compared with
the recorded minimum value and a new minimum is set. Pre-
setting is useful when uploading the database.

Select Reset After Select to reset minimum and maximum point values at the
Each Shift/Day start of the associated period.

Destination for Max | The point/parameter in which maximum value for the
associated period is stored. The point you select must be

Parameter capable of storing the value, and of being historized.

You can use a destination point of the same type as that using
the algorithm.

Destination for Min | The point/parameter in which minimum value is stored for the
associated period. The point you select must be capable of

Parameter storing the value, and of being historized.

You can use a destination point of the same type as that using
the algorithm.

PV Algo 68: Value Transportation

Used to move a value from the PV of the point, to which the algorithm
is attached, to the hardware address defined by the:

m OP destination (for a status point)

m SP destination (for an analog point)
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You can attach this algorithm to either an analog or status point. The
PV of the point to which you attach the algorithm is sent as follows:

m For a status point, to the OP destination defined for the point

m For an analog point, to the SP destination defined for the point

ATTENTION: Do not use this algorithm to transfer safety or
mission critical information between controllers. To transfer
this type of information use a peer to peer method to transfer
information directly between controllers.

Note the following points:

m |f the algorithm is attached to a status point, the number of input
states must match the number of output states. If this isn't the
case, the algorithm won't be able to transfer data correctly and the
following error will occur: 'Data not convertible'.

m Use the algorithm with care—assigning it to many points may
result in a significant load on the server. (As an alternative, you
should consider the equivalent Action Algo 68: Value
Transportation.)

m Set the drift deadband to a reasonable value so that the algorithm
does not execute for inconsequential changes.

m Using this as a PV algorithm degrades system performance. Using
OP/SP source for confirmation in conjunction with using this as a
PV algorithm severely degrades system performance and is not
recommended.

m Do not use control timeouts in conjunction with this algorithm.

Configuring action algorithms in Quick Builder

The following action algorithms are available in Quick Builder.
Action Algo 11: Composite Alarm

ATTENTION: Composite alarming is only supported for legacy
systems. Newer systems should use Alarm Groups instead.

The alarm icon does not support composite alarming.

Composite alarming does not work over DSA or on Console
Stations.
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Property

Block No.

Used only in conjunction with PV Algo 12: Composite Alarm
Processing to consolidate alarms from a number of points.

Action Algo 11: Composite Alarm is assigned to all of the 'subordinate’
points, and PV Algo 12: Composite Alarm Processing is assigned to the
'master’ point.

‘ Description

The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned a
unique block number. Use the alglst utility to find a free
block.See the topic titled "Algorithm blocks" in the Server
and Client Configuration Guide for more information.

The same block must be used by both the master point and
all of its subordinate points.

Master Point

The master point for this subordinate point.

Points at Current Level | Lists the current point and all the other subordinate points.
(Point 1 to Point 18)
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Action Algo 68: Value Transportation

Used to move a value from the PV of the point, to which the algorithm
is attached, to the hardware address defined by the:

m OP destination (for a status point)
m SP destination (for an analog point)

You can attach this algorithm to either an analog or status point. The
PV of the point to which you attach the algorithm is sent as follows:

m For a status point, to the OP destination defined for the point

m For an analog point, to the SP destination defined for the point
ATTENTION: Do not use this algorithm to transfer safety or
mission critical information between controllers. To transfer

this type of information use a method to transfer information
directly between controllers.

Note the following points:

m Set the drift deadband to a reasonable value so that the algorithm
does not execute for inconsequential changes.
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m Using this as a PV algorithm degrades system performance. Using
OP/SP source for confirmation in conjunction with using this as a
PV algorithm severely degrades system performance and is not
recommended.

m Do not use control timeouts in conjunction with this algorithm.

Action Algo 69: Status Change Task Request
Activates a task each time a status point makes a transition from a

non-nominated state to the specified state.

Property ‘ Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

LRN of Task to The Logical Resource Number of the task that is requested
Request when the point changes to the specified state.

You can specify a system task or a custom task. (See the
Application Development Guide for details about writing custom
tasks.)

Task Request State | Select the state (0 to 7) that requests the task, or select ALL for
all state transitions.

Parameter Block The numerical parameter(s) passed to the task. Note that Word 1,
Word 2, or Word 3 must be a non-zero number, otherwise the
parameter block is not read and all other parameter values are
ignored.

Notes

m The algorithm block can also be configured from the Status
Change Task Request Algorithm display. Using the Point Detail
display, double-click the Action algorithm number to display the
Algorithm configuration.

m This algorithm must be attached to a Status point.

m This algorithm does not queue requests to the task.
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The task must call GETREQ to obtain the following information in
the parameter block:

Words 1-10

Action Algo 70: Status Change Report Request

Requests the specified report to be produced when the status point
changes to the report request state. A single report request is made
each time the status point makes the transition from any non-
specified state to the specified state.

In order for the report to print, the requested report needs to have a
report printer defined as its destination.

To limit the assets from which data is reported, you need to specify
the ID of an operator who is assigned to the assets you want to
include.

Property ‘ Description

Block No. The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned a
unique block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Report to Request The number of the report to request when the specified state
is entered by the PV value. To find the number assigned, see
the Reports display, which shows the number assigned to each
report.

Report Request State | The state (0 to 7) the PV value must enter to trigger the report
request.

Action Algo 71: Queued Task Request

This algorithm is deprecated, and is replaced by Action Algo 92:
Queued Task Request.

Action Algo 72: Status Value Transportation with
Mapping

When attached to a status point, this algorithm transports up to four
values to up to four separate points when the status point reaches a
specified state.
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This is accomplished by masking each state with a bit pattern. Each of
the four masks must contain the state (0 to 7) to be reached, the value
to be transported, a target point, and the target point's target
parameter.

ATTENTION: Do not use this algorithm to transfer safety or
mission critical information between controllers. To transfer
this type of information use a method to transfer information
directly between controllers.

Note the following points:

m The PV parameter can only be used to enable and disable
scanning of a point. In this case the required value should be
either:

e 1(On Line/In Service)
o 2 (Off Line/Out of Service)

m Some controller types can also accept a value of O (Reset). See the
associated Controller Reference.

Property ‘ Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Transport Select the check box that represents the status point state that
(states) 7 to O | triggers the transportation of a value when the status point changes
to this state.

Value The numeric value you want to send to the destination point
parameter when the status point reaches the specified state.

Destination The point to which the value is transported when the PV of the status
point, to which the algorithm is attached, changes. The target point
can be a status, analog, or accumulator point.

Param The point parameter of the destination point that receives the
transported value when the status point PV changes.
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Action Algo 74 Status Change USKB LED Request

ATTENTION: This algorithm is primarily available to support
existing keyboards. If you are configuring a new keyboard, see
the Server and Client Configuration Guide.

For the defined assignable asset or Station, a change in point status
causes the associated LED with a nominated key on a Universal
Station keyboard (USKB) to be controlled with the characteristics
specified.

For each of the states (O through 7) of the status point for which this
algorithm is defined, you can select an action for a particular LED.

ATTENTION: If the nominated LED is not located on the
Universal Station keyboard, the control is ignored.

Every assignable asset has a corresponding number. When you
configure this algorithm, you need to know the number of the
assignable asset.

To obtain the number for the assignable asset, in the Station
Command Zone, type sys137.dsp and press ENTER. Then locate the
required assignable asset in the list and note its corresponding
number.

Property ‘ Description

Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

LED Action | The action the LED performs when the PV changes to the associated
state. Select NO ACTION if you do not want the LED to do anything.

LED No. The LED that is controlled when the PV changes to the associated state.
Must be a number from O to 99.

LED The Station or asset that receives LED control.

Destination o )

Select the type of destination from LED Destination, either STATION or

Area or AREA, and then type the specific Station/asset number in Area or Station

Station No. | No.




Property

Block No.
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Action Algo 75: Status Point Notification

Only used with a status point. Providing the gating pointis in its
permit state, the algorithm sends a message to a user-written
application when the status of the point changes to a specified state.

The message contains the point number, the old and new PV values,
the date and time of the change, and can also include optional
parameters.

For information about writing applications, see the Application
Development Guide. A sample application,
\server\user\examples\src\test9.c, shows how to use this algorithm.

‘ Description

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Gate Point

Notification
Permit Gate
State

The status point, and associated state, that control message
generation. Messages are only generated if the pointis in the
specified state.

LRN
Number to
be Notified

The Logical Resource Number of the custom task that is notified
when the point changes to the specified state(s).

Notify

Specified
LRN upon
Reaching

Select the states for which you want message to be generated.

Optional
Algo Data

Optional parameters that are included in the message.

Action Algo 76: Analog Point Notification

Only used with an analog point. Providing the gating pointis in its
permit state, the algorithm sends a message to a user-written
application when:
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m The value changes by a specified percentage from the last
reported value

m The maximum time between notifications is exceeded

The message contains the point number, the old and new PV values,
the date and time of the change, and can also include optional
parameters.

For details about writing applications, see the Application
Development Guide. A sample application,
\server\user\examples\src\test9.c, shows how to use this algorithm.

Property ‘ Description

Block No.

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Gate Point | The status point, and associated state, that control message generation.
o Messages are only generated if the pointis in the specified state.
Notification
Permit
Gate State
LRN The Logical Resource Number of the custom task that is notified when
Number to | the point changes as specified.
be Notified
Significant | The percentage change from the last reported value that generates a
Change message.
Maximum The maximum time, in seconds, between messages.
Period
If you only want to generate messages when the value changes by the
specified value (that is, disable this option), set the value to 0.
Optional Optional parameters that are included in the message.
Algo Data

Action Algo 77: Status Change Display Request

For a status point, causes a display to appear either on a specified
Station or all Stations assigned to a specified assignable asset when
the status point changes to a specified state. A maximum of six display
request states can be nominated.



Property

Block No.
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It is recommended that for a particular state and Station, only one
display is requested.

Every assignable asset has a corresponding number. When you
configure this algorithm you need to know the number of the
required assignable asset.

To obtain the number for the assignable asset, in the Station
Command Zone, type sys137.dsp and press ENTER, locate the required
assignable asset in the list, and note its corresponding number.

‘ Description

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Target State

The state that triggers the display request.

Display Number

The page number of the requested display.

Note that you cannot specify named displays.

Display Destination | The Station or asset where the display appears.

Area or Station No. | Select the type of destination from Display Destination, either

STATION or AREA, and then type the specific Station/asset
number in Area or Station No.

Property

Action Algo 78: Group Control of Points

Controls a group of status or analog points through a group control
point. It sends the PV of the point for which the algorithm is defined
to the nominated point/parameters in the control list.

You can optionally define a gating point (status) that prevents the PV
being sent to the control points if it is in the specified state.

Use this algorithm with care; assigning it to many points may result in
a significant load on the server.

Description

Block No.

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique block
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Property ‘ Description

number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Gate Point The status point and PV state (0 to 7) that prevents the value being
o sent to the point/parameters in the Group Control List.
Inhibit State
Group Control | The points/parameters to which the value is sent.
List
Command The command and residual priorities used by the server when
priority changing the point parameters in the Group Control List.
Residual (The controller only executes a command if it's command priority
priority that is greater than or equal to the residual priority of the previous
command.)
Action Algo 79: Status Change Alarm Group Inhibit
For a status point, alarm reporting is inhibited for the nominated
group of points when the status point PV is in an alarm inhibit state.
An example of a use for this algorithm is to inhibit alarm reporting on
sensor points if the unit has been shut down.
Property ‘ Description
Block No. The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
block number. Use the alglst utility to find a free block.
See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.
Group Points Either select the point name from the list of points already

added to the project, or, to select a server database point
defined outside of this project, type in the name, to specify a
point to be included in the group list. You can specify up to 19
points.

Alarm Inhibit States | The alarm inhibit states for the status point PV. You can specify
up to eight states.
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Action Algo 80: Status Change Alarm Area Inhibit

For a status point, alarm reporting is inhibited for the nominated
group of assignable assets when the status point PV is in an alarm
inhibit state. For example, use this algorithm to inhibit alarm
reporting on sensor points if the unit has been shut down.

‘ Description

The algorithm block used by this algorithm for this point. Each
algorithm attached to each point should be assigned a unique
block number. Use the alglst utility to find a free block.

See the topic titled "Algorithm blocks" in the Server and Client
Configuration Guide for more information.

Area Codes

The tag name of the asset for which alarming is inhibited.

Alarm Inhibit States | The state(s) that the PV value must enter to inhibit alarming for

the point.

Action Algo 92: Queued Task Request

Queues a request to a task when a status point changes to a specified
state(s). The point item number, the change in state and up to seven
optional parameters are passed to the task.

The algorithm makes a single task request each time the status
changes to a specified state. Because requests are queued, the risk of
losing a request is reduced.

The requested task uses GETPRM to process the request block. The
task request uses a 10-word parameter block defined in the algorithm
block, but words 3, 4, and 5 are reserved for use by the algorithm.

Note the following points:

m This algorithm cannot be used in conjunction with Action Algo 69:
Status Change Task Request to request the same task.

m To request multiple tasks on the same state change(s), configure
multiple points on the same controller address. The algorithm can
then be configured for each task using the different points that
access the same information.
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Property

Block No.

‘ Description

The algorithm block used by this algorithm for this point.
Each algorithm attached to each point should be assigned a
unique block number. Use the alglst utility to find a free
block.

See the topic titled "Algorithm blocks" in the Server and
Client Configuration Guide for more information.

LRN of Task to
Request

The Logical Resource Number of the task that is requested
when the point status changes to the specified state(s).

You can specify a system task, such as the Server Display
program, or a custom task. (See the Application
Development Guide for details about writing custom tasks.)

States to Request Task

States (or condition settings) that trigger the task request.

Parameter Block

The numerical parameter(s) passed to the task.

Words 3, 4, 5, and 13 are used by the algorithm to pass the
following values:

Word 3=0

Word 4 = Point item number of the status point to which
algorithm is attached

Word 5 = State of the status point to which the algorithm is
attached

Creating a composite alarm hierarchy

The following figure shows how create a composite alarm hierarchy
for a large number of points using PV Algo 12: Composite Alarm
Processing and Action Algo 11: Composite Alarm.

You attach Algo 11 the subordinate (field) points, whose alarms you
want to consolidate. You attach both algos 11 and 12 to the
intermediate master points, and attach only algo 12 to the top-level
master point.

The letters (x, y and z) show how you assign block numbers.
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NOTICES

Trademarks

Experion®, PlantScape®, SafeBrowse®, TotalPlant®, and TDC 3000° are
registered trademarks of Honeywell International, Inc.

ControlEdge™ is a trademark of Honeywell International, Inc.
OneWireless™ is a trademark of Honeywell International, Inc.

Matrikon® and MatrikonOPC™ are trademarks of Matrikon
International. Matrikon International is a business unit of Honeywell
International, Inc.

Movilizer® is a registered trademark of Movilizer GmbH. Movilizer
GmbH is a business unit of Honeywell International, Inc.

Other trademarks

Microsoft and SQL Server are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or
other countries.

Trademarks that appear in this document are used only to the benefit
of the trademark owner, with no intention of trademark infringement.

Third-party licenses

This product may contain or be derived from materials, including
software, of third parties. The third party materials may be subject to
licenses, notices, restrictions and obligations imposed by the licensor.
The licenses, notices, restrictions and obligations, if any, may be found
in the materials accompanying the product, in the documents or files
accompanying such third party materials, in a file named third_party_
licenses on the media containing the product, or at
https:.//www.honeywell.com/en-us/privacy-statement..

Documentation feedback

You can find the most up-to-date documents on the Honeywell
Process Solutions Support website at:
http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions
documentation, send your feedback to: hpsdocs@honeywell.com



https://www.honeywell.com/en-us/privacy-statement
http://www.honeywellprocess.com/support
mailto:hpsdocs@honeywell.com

Notices

Use this email address to provide feedback, or to report errors and
omissions in the documentation. For immediate help with a technical
problem, contact HPS Technical Support through your local
Customer Contact Center, or by raising a support request on the
Honeywell Process Solutions Support website.

How to report a security vulnerability

For the purpose of submission, a security vulnerability is defined as a
software defect or weakness that can be exploited to reduce the
operational or security capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting
Honeywell products and services.

To report a potential security vulnerability against any Honeywell
product, please follow the instructions at:

https://www.honeywell.com/en-us/product-security.

Support

For support, contact your local Honeywell Process Solutions
Customer Contact Center (CCC). To find your local CCC visit the
website, https://www.honeywellprocess.com/en-US/contact-
us/customer-support-contacts/Pages/default.aspx.

Training classes

Honeywell holds technical training classes that are taught by process
control systems experts. For more information about these classes,
contact your Honeywell representative, or see
http://www.automationcollege.com.
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